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This document contains proprietary information 
that is protected by copyright. All rights are 
reserved. No part of this document may 
be photocopied, reproduced, or translated to 
another language without the prior written 
consent of HP Development Company.

Warranty

The information contained in this document is 
subject to change without notice.

HP makes no warranty of any kind with regard 
to this material, including, but not limited to, 
the implied warranties of merchantability and 
fitness for a particular purpose.

HP shall not be liable for errors contained herein 
or for incidental or consequential damages in 
connection with the furnishing, performance, or 
use of this material.





Safety

The procedures described in this manual are to 
be performed by HP-qualified service personnel 
only.

Electrical Shock Hazard

Serious shock hazard leading to death or injury 
may result if you do not take the following 
precautions:

• Disconnect the printer from the power source 
prior to performing any maintenance.

• Prevent water or any other liquids from 
running onto electrical components or circuits, 
or through openings in the enclosure.

Electrostatic Discharge

See the beginning of Chapter 5's Introduction on 
page 294 of this manual, for precautions you 
should take to prevent damage to the printer 
circuits from electrostatic discharge.

Safety Symbols

General definitions of safety symbols are given 
immediately after the table of contents.

WARNING

The Warning symbol calls attention to a 
procedure, practice, or the like, which, if not 
correctly performed or adhered to, could result 
in personal injury. Do not proceed beyond a 
Warning symbol until the indicated conditions 
are fully understood and met.

CAUTION

The Caution symbol calls attention to an 
operating procedure, practice, or the like, which, 
if not correctly performed or adhered to, could 
result in damage to or destruction of part or all 
of the printer. Do not proceed beyond a Caution 
symbol until the indicated conditions are fully 
understood and met.

Readership

The primary readers of this service manual 
are HP service engineers, although secondary 
readership may include resellers.



Using this manual

This service manual contains information necessary to test, maintain, and service the following:

HP DesignJet T210 24-in Printer 8AG32A

HP DesignJet T230 24-in Printer 5HB07A

HP DesignJet T250 24-in Printer 5HB06A

HP DesignJet T630 24-in Printer 5HB09A

HP DesignJet T650 24-in Printer 5HB08A

HP DesignJet T650 GSA 24-in Printer 5HB08G

HP DesignJet T630 36-in Printer 5HB11A

HP DesignJet T650 36-in Printer 5HB10A

HP DesignJet Studio 24-in Printer 5HB12A

HP DesignJet Studio 36-in Printer 5HB14A

HP DesignJet Studio Steel 24-in Printer 5HB12C

HP DesignJet Studio Steel 36-in Printer 5HB14C

For information about using these printers, see the user's guide.

Readership

The procedures described in this service manual are to be performed by HP Certified service personnel only.

Part numbers

Part numbers for printer service parts are located in Parts and diagrams on page 260.
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Printer fundamentals1

This chapter introduces the printer system.

Overview
A summary of the various relevant system and software specifications.

Feature T210 T230 T250 T630 T650 Studio More 
information

Paper 
source

Roll. Multi-sheet tray + ARSS as an 
accessory

Roll and multi-sheet tray + ARSS See the 
user's guide

Hardware 
differences

Stand and roll cover as an accessory Stand and roll cover in box Stand and roll cover in box

Connectivity Wi-Fi, Fast Ethernet LAN, USB Important! 
LAN and Wi-
Fi are not 
compatible

Web 
Services

Automatic firmware upgrade

Remote printing (through HP Smart App)

ePrint (Print by email)

The printer 
needs to be 
Internet-
connected.

Manual 
firmware 
upgrade is 
also 
available

Speed 45 s per 
page on 
A1/D

35 s per 
page on 
A1/D

30 s per 
page on 
A1/D

30/30* s per 
page on A1/
D

* 36in/24in

24/36* s per page on A1/D

* 36in/24in

Resolution Up to 1200 × 2400 dpi

Memory and 
languages

512 MB, PCL3/JPEG 1 GB, HP-GL/2/PCL3/JPEG

Supplies HP 712 29 ml Cyan, Magenta, Yellow

HP 712 38 ml and 80 ml Black

Ink 
cartridges 
and 
printhead 
can be 
replaced by 
the 
customer

One on-axis printhead for all colors

Front panel
Located on the front left of the printer there is a touch-sensitive screen with a graphical user interface. From it, 
you can print, view information, change settings, and perform calibrations and tests, etc.
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The front panel also displays alerts (warning and error messages) when needed.

The front panel has a large central area to display dynamic information and icons. At the top of the central area 
there is a dashboard that displays the home screen icons. To interact with these icons swipe down the dashboard 
status to access the dashboard. On the lower side of the screen you can see up to 3 fixed icons at different times. 
Normally they are not all displayed at the same time.

Fixed icons

● Tap  to return to the home screen.

● Tap  to view help about the current screen.

● Tap  to go back to the previous screen without discarding changes.

Home screen dynamic icons

The following items are displayed when you tap :

● Tap  to load, unload, and change options for roll paper.

● Tap  to change options for the multi-sheet tray, or to activate it.

● Tap  to load, unload, and change options for single sheets.

NOTE: The active paper source is indicated by a slightly larger icon, with a white tick in a green circle:  .

A drop down menu is displayed when you touch .

Dashboard icons

The dashboard icons are located at the top of the central area:

● Tap  to change printer settings.

● Tap  to view ink information.

● Tap  to view printhead information.
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● Tap  to view connectivity status information and to perform network configuration. If a network cable is 
connected,  is displayed instead.

NOTE: It is not possible to use wireless and wired network connections simultaneously.

● Tap  to view information about Wi-Fi Direct.

● Tap  to view information and configure ePrint to print from a computer or mobile device, sending an email 
to the printer.

If the printer is left idle for some time, it goes into sleep mode and switches off the front-panel display. To change 
the time that elapses before sleep mode, tap , then Power Management > Sleep Mode. You can set a time 
between 5 minutes and the maximum time allowed by the current energy savings regulations.

The printer wakes from sleep mode and switches on the front-panel display whenever there is some external 
interaction with it.

Information about specific uses of the front panel can be found throughout this guide.

Support/Service Menu Overview
There are two types of support menu available for T200, T600, and Studio Printers.

NOTE: The active paper source is indicated by a slightly larger icon, with a white tick in a green 

circle: .

If the printer is left idle for some time, it goes into sleep mode and switches off the front-panel display. To change 
the time that elapses before sleep mode, press , then Printer preferences > Sleep. You can set a time between 
5 and 240 minutes.

The printer wakes from sleep mode and switches on the front-panel display whenever there is some external 
interaction with it.

The following table shows an overview of the support menus available, for more details see Entering the support 
menus on page 123.

NOTE: The icons mentioned in this table will not be visible in the front panel: you must press the front panel in 
the places where they normally appear, as shown in the front panel illustration at the start of this section.

Label Description

Support menu: This can be used by customers under the guidance 
of phone call agents assisting remotely. Using this menu, customers 
can perform troubleshooting tasks and access printer information.

From the Home screen, press the following icons one after the 
other: , , , .

If there is a system error, you may not be able to reach the home 
screen. In this case, press the Home button and hold it down for 15 
seconds.

Service Menu: Service engineers only From the Home screen, press the following icons one after the 
other: , , , . In the menu that appears, select "Service 
Menu". Alternatively, you can press and hold the Home button for 15 
seconds to directly enter the Service Menu.

The Service Menu is sometimes also accessible from other screens 
(for example, from a System Error screen). This menu may not 
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Label Description

be accessible from inside certain workflows (for example, while 
cleaning a paper jam) or when the printer is hang-up.

Start-up sequence
There are three states between power-on and the Home screen:

1. Electronics initialization

2. Firmware initialization

3. Mechanical initialization

State 1: Electronics initialization
This state precedes Firmware and Mechanical initialization in the startup sequence.

1. The front panel turns white and flashes.

2. The printer reads the firmware.

NOTE: At this stage, if something is broken, it will not be possible to enter the Support menu. To diagnose 
what is happening, go to the troubleshooting guide Troubleshooting tree for boot up failure on page 42. 
Subsequently, you can enter the Support menu to troubleshoot if necessary.

State 2: Firmware initialization
This state occurs between Electronics initialization and Mechanical initialization in the startup sequence.

1. The HP logo appears with a static bar.

2. Bundle board and ASICs are initialized. 
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3. The HP logo changes.

State 3: Mechanical initialization
This state follows Electronics and Firmware initialization in the startup sequence.

1. A basic check of servos.

2. A check that the Scan Axis and Paper Axis are unobstructed by scraps of paper or other items.

3. Paper and print system initialization.

Initialization flow summary
Activation of the printer follows this sequence of events.

Time (sec) Printer state Visual and acoustic information

0 Power on Using the Power button

10 Electronics initialization
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Time (sec) Printer state Visual and acoustic information

27 Mechanical initialization

1. Basic check of servos Sound of the printer's motors

2. Scan Axis, Paper Axis check Carriage movement

3. Paper and print system initialization Paper movement

45 Ready state

NOTE: Initialization lasts around 45 seconds if there was a clean power-off (using the Power button). If there 
was a dirty power-off, the printer will require more time to inititialize (to ensure that the printhead is in a good 
state). If we come from a cold reset (user function) it could require a few minutes more to power on.

Subsystems

Covers

Functionality
These parts cover the printing mechanism and act as protection from potential knocks or dust. They also prevent 
the customer from coming into contact with unsafe parts during the operation of the printer. Finally, the covers 
complement the style and aesthetics of the printer.

The Industrial design parts cover the printing mechanism and act as a protection from potential knocks or dust.

Usability: They also prevent the customer to reach unsafe areas during the operation of the printer and help it to 
reach parts as ink supplies, cutter, printheads,... that need a maintaince.
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Aesthetics: Industrial Design covers are a key factor of the product to fulfill the value propositon. This is why they 
have a variety of textures, finishes & materials.

Figure 1-1 T210, T230, T250

Figure 1-2 T630, T650
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Figure 1-3 Studio

Components
There is one sensor related to Covers subsystem. It is designed to detect the status of the covers: status opened 
or status closed.

● Front window sensor. It senses whether the Front window is opened or closed. The sensor is hosted in the 
printer chassis.

Figure 1-4 Left Arch

Removal and installation
In order to proceed with the removal and installation of the covers, it is important to bear in mind their cosmetic 
aspects and how accessible different parts of the printer are.

Some surfaces of the covers have a glossy finish, which requires maximum attention as they are very delicate 
and susceptible to scratches and finger marks. It is recommended that you use gloves for any service operation 
involving the covers.

Due to the layout of the covers, it is important to bear in mind that some parts require removal before you can 
remove a specific cover.
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● Right Cover requires Front Cover and Top Trim removal.

● Left Cover requires Front Cover, Top Trim, Front Panel Bezel, and Cutter Door removal.

● Front window requires Top trim removal.

● Studio Roll Cover SKU requires Left and right covers removal.

● T630/T650 Roll Cover SKU does not require any cover removal.

Related tests
Sensor tests for the Front window.

See Service Test on page 200.

Electronics
Apart from Front window sensor , there are no electronics related to this subsystem.

Printhead health systems: Service Station, Primer system, and Left Spittoon

Functionality
The service station is responsible for printhead maintenance. It takes action to clean ink residues and service ink 
nozzles, and prevents ink from drying in critical zones by capping the printhead once printing has finished.

The Primer system provides the necessary air pressure to the printhead to perform initialization. This system 
also provides pressure to the necessary printhead service operations (by boosting air which pushes ink out 
through the printhead nozzles, cleaning residues of dried ink and other particles).

The Left spittoon is a small container located to the left of the print-zone area, this is the area used by the 
printhead to “spit” a small amount of ink at the end/beginning of the printing swath in order to ensure correct 
nozzle heath for left-to-right printing.

Components
A break down of the parts of the printhead.

Item Function

Off-axis coupling assembly This is a rubber spring link located on the side plate of the scan 
axis (area where the Carriage moves). It links the primer system 
with the Carriage when the Carriage is located in its maximum left 
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Item Function

position. This system ensures the pressure from the primer reaches 
the printhead for nozzle servicing.

Prime Pump This is an air pump which provides the necessary pressure 
for printhead servicing and nozzle repair. The Prime Pump is 
suspended on a rubber holder to minimize the noise that the Prime 
Pump makes while in operation.

Primer Tubes The tubes take the air from the Prime Pump to the off-axis 
coupling. There is a T link feature connected to a tube that goes 
inside the service station; the purpose of this tube is to release the 
air pressure from the system. The tube is pinched by the shuttle 
of the service station when reaching a certain position; this action 
closes the circuit and allows the system to be pressurized. With the 
movement of the service station the tube is released, allowing the 
pressure from the system to escape.

Notes and considerations
Any leakage in the primer system will generate poor or no priming, this will affect nozzle heath (or even cause 
the printhead startup to fail). Bear in mind that the system is not just for the Prime Pump and tubes, the prime 
pressure is transmitted via the off-axis coupling to the Carriage and from there to the printhead assembly and 
from there to the cartridges.

NOTE: There is no pressure sensor in the system. The Prime Pump operates at a certain time to reach a 
specific pressure level, the system is depressurized by releasing the pinching of the release tube in the Service 
Station (by moving the service station).

NOTE: It is important to ensure the Carriage reaches the maximum left position; if not, the off-axis coupling 
will not connect the Prime Pump with the Carriage. Also, the coupling is made of a rubbery material, 
degradation of the material will affect Primer performance due to air leaks.

Electronics
The control driver of the Prime Pump is located on the remote controller board located on the right-hand side of 
the printer. There is no encoder for the Prime Pump. This pump is managed only by a DC motor activated for a 
certain period of time to create the required priming pressure.

Service Station system

Functionality
A break down of the parts of the service station.
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Item Function

Printhead Wipers These are rubber paddles that are passed through the nozzle plate 
of the printhead with the Service Station movement. They clean the 
excess ink from the nozzle plate with a rubbing action.

Printhead Cap This caps and protects the nozzles from drying when they are not 
printing.

Service Station Motor system This moves the shuttle with the wiper and the cap so that these 
two items can perform their functions. The system is composed of 
a DC motor and an encoder disk with an encoder sensor to read the 
motor position.

Bottom Spittoon This part acts as an ink reservoir when spitting and nozzle health 
operations are performed. It contains diapers that prevent the ink 
becoming liquid.

Top Spittoon This seals the reservoir and completes the main body of the service 
station.

Absorber Base This is made of foam and is located under the service station on top 
of the printer structure. It works as an additional diaper in case ink 
spills out of the Service Station.

Wiper Shuttle This mobile part is propelled by the motor that contains the Wiper 
and Cap. Depending on the position, spitting, wiping, capping, or 
priming can take place:

Spitting: The printhead “spits” a little ink into the spittoon to get the 
nozzles conditioned and ready for the next swath of printing.

Wiping: A physical action to pass the rubber wipers through the 
printhead nozzles.

Capping: Parking the printhead to maintain nozzle heath during 
printer inactivity, with a surrounding seal.

Priming: Squirts ink through the nozzles to clean and unblock them.
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Notes and considerations
The service station is offered as a complete service part for full replacement. The failures from this subsystem 
are usually related to the mobile parts: motor or encoder failures that prevent the shuttle from reaching the 
positions for capping or uncapping.

With the life primer system, tube pinching can present an issue (although it is designed to function for the life of 
the printer).

When the Service Station is replaced, it is mandatory to reset the Preventive Maintenance Kit for the Service 
Station, this will trigger a simple calibration that is done with the Service Station on the next printer startup. The 
calibration measures the length of the Service Station (shuttle front bump to shuttle rear bump), which ensures a 
correct capping position.

Electronics
All the controlled movements for the Service Station are done from the remote-controlled board located on the 
right-hand side of the printer. Issues with the Service Station can also be related to this control board.

Paper path

Functionality
The paper path comprises all the elements of the printer in contact with the paper, designed to hold, move, and 
manage it in a controlled manner in order to print.

Paper can be loaded using a roll, which is mounted on the rear spindle, or single sheets loaded from the 
Multi-Sheet Tray, or single sheets loaded singly.

The paper passes from its source (Roll, Single Tray, or Multi-Sheet Tray) until it touches the Out-Of-Paper Sensor, 
when the printer detects the presence of the paper and proceeds to load it.

To perform the paper feed, the printer catches the paper in between the Drive Roller and the Pinch Rollers (Pinch 
Rollers are spring-loaded pushing the paper down on top of the Drive Roller), then the paper is pushed forwards 
on top of the Print Platen in the print zone, which is where the printing operation is performed. The paper 
advance is provided by a motor that moves the Drive Roller. The exact position of the Drive Roller and hence the 
paper is controlled by an Encoder Disk located on the roller axis.

The printed paper then passes between the Output Shaft and the Starwheels (which keep the paper tension as 
flat as possible for printing) to exit on the Output Platen, where it is held in case of cut sheet or is cut to fall on the 
output basket in the case of roll paper.

The Output Shaft is designed to over-advance the Drive Roller movement slightly, and hence create the 
necessary paper tension to keep the paper as flat as possible. The Starwheels are spring-loaded and are 
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designed to create force on top of the paper, this is done so as to leave the paper unmarked and at the same time 
allow the Output Shaft force to be appropriately transmitted.

In the Roll configuration, the rewinder module generates back force while printing to facilitate paper control.

A key electrical element of the paper path is the Paper Sensor (also known as the Out-Of-Paper Sensor or OOPS). 
This sensor is located at the beginning of the Print Platen; it detects paper insertion for roll load and single-sheet 
load.

Electronics
In the paper-path driving system, the only electrically active element is the Drive Roller.

The Drive Roller is impelled by the drive roller motor and it contains an Encoder Disk on the axis to determine 
its position. The Encoder Disk is read by two sensors. One, the “encoder sensor”, designed to read the 
encoder, counts the Encoder Disk (the Encoder Disk outer marks) and another one, the “encoder index sensor”, 
determines the start position (the 0 position) of the Drive Roller by reading the inner thicker lines of the Encoder 
Disk.

NOTE: Every time the printer starts up, it searches for the 0 position of the Drive Roller. If this search fails 
(which means that the index sensor is faulty), the printer will give a system error and will be unable to initialize.

The roll paper input system

Functionality
This system keeps the roll in place and ensures controlled rotation.

It contains the rewinder, which rewinds the paper for paper ejection, and provides an opposite tension to the 
paper advance for better paper control.

● The Left Support encloses the Rewinder Motor and Encoder, containing a set of gears that transmit the 
Rewinder motion to the spindle. There is a V-shaped spring to load and fix the spindle in position.

● The Right Support holds the spindle in position to rotate over passive rollers.

● The spindle is designed to hold the paper rolls, and receive the motion from the rewinder gear in the Left 
Support. It consists of a central bar and two hubs; the right hub is fixed to determine the right-side loading 
position of the paper, and the moveable left hub adjusts to the width of the paper.

● The Roll Cover (CQ890, CQ893, 5ZY60B, 5ZY62B only) shields the roll from dust.

NOTE: The Roll Cover is a passive part, with no sensor: the printer does not know its status.
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Electronics
The Rewinder Motor and Encoder system are directly controlled by the Main PCA.

The paper output system

Functionality
This system ensures that the printed paper follows a controlled path and acquires a certain shape in order to be 
delivered properly to the user. It also has a cosmetic function.

The system includes a set of three telescopic trays, which are extended to collect the cut-sheet paper printed 
from the Multi-Sheet Tray.

There are two roll-paper control tabs that are deployed automatically when the telescopic trays of the Output 
Tray are in the closed position. This is a purely mechanical action as the tabs are pushed up by the output trays 
when closed. The purpose of those tabs is to control the shape of the roll paper when coming out of the paper 
path.

The Front Cover is located underneath the Output Platen.

Electronics
The only electronic component related to the Output Platen is the Output Tray Sensor located underneath the 
output trays. The sensor is activated when the three output trays are fully closed. The sensor cable is routed via 
the front of the machine and is directly connected to the main PCA.
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Basket (Studio)
A flexible and adjustable basket for collecting material output from the printer.

Functionality
This section provides functional and structural information relating to the basket.

Expected maximum capacity:

● A0: 3 or 4 plots (depends on media).

● A1: 10 plots.

What to capture:

● Basket can store either roll or cutsheet jobs (cutsheet without stacking in order).

● 36in max format is A0 / 24in max format is A1.

Figure 1-5 Architecture status

Figure 1-6 General View
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Figure 1-7 Telescopic Subsystem

Table 1-1 Parts functionality

Description Function

Main tube Structural / geometrical purpose

Hinges (28°) Articulated tubes join. The aim is to provide a compatible geometry 
with printer’s media output

Hinge pin Used to articulate hinges

Small tube Articulated prolongation of main tube

Stopper Used to define the stopping point of the basket when in out position

Ball bearing Provide rolling contact to basket’s tube. Avoids friction between 
tubes and telescopic support

Bearing pin Pins the bearing into the correct position

Telescopic support Contains the bearings in a strategic distribution and it interfaces 
with the printer

ID cover Protects the whole basket system

Fabric Mechanism Winding mechanism to store the basket’s fabric once used

Left mechanism support Joins the mechanism to the printer

Right mechanism support Joins the mechanism to the printer

Basket Fabric Provide a geometry that helps storing the printed plots without 
being damaged
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Table 1-1 Parts functionality (continued)

Description Function

Handles Interaction element to pull out the basket

Figure 1-8 Fabric Mechanism Subsystem

Figure 1-9 Winding Mechanism

Figure 1-10 Bumperfoot
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Figure 1-11 Side wall interface

Figure 1-12 Basket ID interface

Figure 1-13 Stopper detal
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Figure 1-14 Hinge detail

Figure 1-15 Spring locker added

The Cutter system
The Cutter cuts the paper after the print has completed.

It comprises 1) a cutter module that cuts the paper with two rotary blades, 2) a Cutter Bridge attached to the 
Carriage that catches and releases the Cutter to perform the cutting operation and then to leave it in capping 
position, 3) a Cutter Guide that holds the movement of the Cutter along the printer width.

In order to operate the Cutter, it needs to be in the parked position. If not, the Cutter will not be engaged by the 
Cutter Bridge and the printer will not perform the cutting action.
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Whenever the printer initializes, it performs a parking movement with the Carriage to ensure that the Cutter is 
left in the appropriate position.

The printer does not have any feedback about the cutter engagement action. Hence, if for any reason the 
engagement is not performed correctly, the printer will continue operating as if the engagement has occurred.

How activation works
This process describes the activation behavior of the cutter.

1. Pre-activation phase: The Cutter Engagement Feature of the Bridge gets into the funnel of the Cutter 
Module grooving the Cutter to ensure the correct position for activation.

2. Hook catching: The cutter bridge continues moving to the left pushing down the cutter hook (in orange), 
after the left side of the cutter bridge passes the Carriage stops and the cutter hook returns to its position 
due to its spring motion.
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3. Cutter action: The left feature of the cutter bridge pushes the cutter to the left, performing the cutting 
operation.

How deactivation works
This process describes the deactivation behavior of the cutter.

1. Disengagement: Hook Bridge changes direction moving now from right to the left, so that Cutter Hook 
slides out of the Cutter Catch Feature.
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2. Move-away action: the Cutter Hook deactivates from the bridge by passing in front of it.

Accessory Tray and Bridge Platen

Functionality
The accessory tray holds and loads the cut-sheet paper for the printer. The accessory tray itself is a completely 
mechanical system with no electronics or motors. All the motion drives for both picking and paper drive are or 
created or transmitted by the Bridge Platen module located on the right-hand side of the printer, behind the 
Service Station.

The ARSS accessory loads the Roll for the printer. It consists of 3 sets of swing pick tires which rise to drive the 
Roll and descend for handoff. All the motion drives are also transmitted by the Bridge Platen.
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The Bridge Platen module has two main functions: to drive the Accessory Tray and the ARSS.

Bridge Platen module functionality

The Bridge Platen module has two gear trains.

● The 1st gear train consists of motor, gears, and the switching mechanism:
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By default, the motor engages with the gear to drive the picking roll of the Multi-Sheet Tray.

When the Service Station's Sled moves to rear home, the switching mechanism forces the motor to engage 
with the gear to drive the ARSS.
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● The 2nd gear train is to link the Drive Roller with the Intermediate Shaft in the Multi-Sheet Tray:

A swing arm engages the gear train when the Drive Roller is driven backwards (as shown in the picture), 
driving the intermediate shaft forwards. When the Drive Roller is driven forwards, the swing arm disengages 
from the gear train and the intermediate shaft is not driven. This action is to prevent reverse paper 
movement being transmitted to the Multi-Sheet Tray.

Multi-Sheet Tray functionality

The function of the Multi-Sheet Tray is to pick and feed the cut-sheet paper until the paper is grabbed by the 
drive roller (drive roller and pinch system).

The actions performed for those operations are (1) sheet pick and (2) sheet input.

1. Sheet pick

This movement is transmitted through a lateral gear chain in the Multi-Sheet Tray towards the swing arm, which 
is pushed towards the paper, and the picking mechanism located at the bottom of the Multi-Sheet Tray, which 
separates the top sheet from the stack of pages.

Standby:

● Swing Arm moves to left

Multi-Sheet Tray functionality 25



● Hard Stop lifts up

Picking:

● Swing Arm moves to right

● Hard Stop lifts down

2. Sheet input

Once the paper is in the intermediate shaft area, the printer attempts to load it via the following process.

NOTE: The printer considers the load successful if, after the picking and sheet input procedures, the sheet is 
detected by the printer's Paper Sensor. Hence, a correct function of the Paper Sensor is required also for the 
accessory tray loading action.

NOTE: It is possible to reproduce the picking and loading motions by extracting the Multi-Sheet Tray and 
rotating the gears with the hand, to validate module performance and troubleshoot any possible mechanical 
issues.

NOTE: Different elements of the Multi-Sheet Tray are not serviceable, the whole module requires replacement 
in case of failure.

Functionality

The function of the ARSS is to pick and feed the Roll until the paper is grabbed by the drive roller.
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Figure 1-16 ARSS

Figure 1-17 ARSS components

Figure 1-18 Picking: Swing-Arms and tires lift up
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Figure 1-19 Handoff: Swing-Arms and tires lift down

Cycle to switch printing on Roll to Sheet to Roll

Roll standby on print zone

Roll rewind and top form move back to parking position

Multi-Sheet Tray pick and load Sheet to print zone for printing

ARSS load Roll from parking position to print zone for printing

Electronics

Both the encoder and motor-drive system are managed by the Bundle PCA located on the right-hand side of the 
printer.

Scan Axis system: Carriage and Carriage impelling
This system moves the Carriage from left to right and right to left over the paper in a controlled manner to 
perform printing, cutting, paper detection, and any other Carriage movements for servicing and the final capping 
process.
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The system comprises the Carriage sliding on the scan axis rod, on which rotates and whose position is 
determined by a cam mounted on the Carriage, which slides touching the bottom surface of the anti-rotation rail.

There are two trailing cables mounted one on top of the other, which connect the Carriage with the main 
electronics control board. A scan-axis encoder strip is needed for the Carriage to determine its position, and a 
Carriage Motor which impels the Carriage via a belt.

The trailing cable is held in position by a plastic holder, which clips onto the scan axis structure. A spring-loaded 
loop ensures follow-up action of the cables with the Carriage movement. Two plastic cable sliders are also placed 
to ensure minimum contact of the trailing cables with the scan axis structure. The plastic sliders are greased to 
prevent ink spray (aerosol) deposits from accumulating on them, generating a sticky surface which could retain 
the cables and then be damaged by Carriage movement.

The Encoder Strip Sensor is located inside the Carriage, once the Carriage is assembled the Encoder Strip crosses 
the Carriage, passing by the detection area of the sensor inside the Carriage.

The main function of the Carriage is to hold the printhead in position, to enable cartridge insertion, and to move 
the printhead in a controlled manner in order to print.

The Carriage holds all the necessary interface electronics for the main board to interact with the printhead via the 
trailing cables. A set of spring-loaded connectors are the main interface Carriage-printhead.

NOTE: It is very important that the contacts are clean, free of dust/ink to ensure a correct connection between 
printhead and Carriage, as high-speed data are transmitted through this connection, and dust could cause 
sporadic system errors. This is particularly important when replacing the printhead, as the removal of the old 
printhead (extraction with a rotary movement) can cause the nozzle plate to touch those contacts and create 
contamination that could cause problems with the new printhead. However, manual cleaning of the contacts is 
not recommended.

The Carriage also has additional functionality:
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1. Transmits the pressure from the Prime Pump via off-axis coupling to each of the four cartridges

● Off-axis coupling connects with the Carriage via the side connection bay:

● An internal passage of the Carriage transmits the air pressure towards the printhead.

● The rear hole of the printhead receives the air pressure which is distributed towards the four air ports 
inside the printhead.

● Each of the air ports transmits the air pressure to the cartridges, and the air pushes the inner 
chambers, expelling the ink during the priming operation.

● Host ink cartridges are supplied with the printer. The ink cartridges appear in the delivery box secured 
with a plastic ribbon (not in a plastic bag).
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Remember that the printhead is already installed in the printer.

2. Holds the cutter bridge

The cutter bridge impels the Cutter for cutter operations (see additional information in the cutter section).

3. Holds the Carriage Line Sensor

The Carriage Line Sensor (also known as the ZIM Sensor) is located on the right of the printer and is used 
to detect the edges of the paper to determine the paper dimensions and start position. This sensor is also 
the tool used to detect the position of printed lines to perform calibrations (Paper Advance calibration and 
printhead alignment).

The Line Sensor is a reflective tool that generates a beam of LED light, whose reflection is detected by 
a luminance sensor. The signal from this sensor is used to determine the position of lines or paper edge 
according to the position of the Carriage.

NOTE: Both LED emitter and receiver sensor inside the line sensor are protected by a transparent plastic 
cover. If this cover becomes dirty, the signal to detect edges or lines will be affected, which could cause 
intermittent issues during the paper load.
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It can also detect printed lines from short signals when the sensor crosses the lines:

Carriage CAM and Auto PPS adjustment
At the back of the Carriage there is a sliding cam that determines the PRS (Print to platen Rib Space) of the 
Carriage.

In manufacturing, the anti-rotation rail (area in which the PRS cam slides) is adjusted to calibrate the nozzle 
plate position of the printhead, at around 1.6 mm all along the scan axis width. This calibration is not service­
adjustable and should remain constant throughout the printer's life.

As there are different paper thicknesses, the printer is able to rotate this sliding cam automatically to three 
different positions, changing the PRS distance to accommodate it to the appropriate printing distance.

This rotation is performed by taking the Carriage to a feature on the left-hand side of the scan axis, different side 
movements of the Carriage at different speeds allow this feature to grab and rotate the cam accordingly. The 
Cam has three different areas for three different PRS adjustments.

Auto-PRS feature located on the left-hand side of the scan axis.
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Back part of the Carriage with auto-PPS cam, after being activated in position 1.

Carriage impelling system
This describes the actions and identifies the parts of the carriage impelling system.

Carriage encoder system
The encoder strip tension is also fixed by a tensioning spring. However, there is a mechanism to hold it in position 
after the spring places the strip at one specific tension. This is to prevent the spring from continually applying 
force over the encoder strip; which, over time and temperature changes, could make it creep.
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NOTE: When assembling the encoder strip, ensure that it is placed in the right orientation using the smiling 
symbol located on the sides of the encoder strip.

NOTE: Due to the proximity of the encoder strip to the greased sliding rod, grease can easily transfer to the 
strip when performing any repair operation in the area. Please clean any grease from the encoder strip if 
necessary. A dry cloth can be used for this purpose, to prevent any deformation or strain on the encoder strip 
while performing the cleaning.

Printer electronics, power supply, and cables
The printer contains several electronics boards and electrical and electronic components in different locations.

● There are two main active boards (Main PCA and Bundle PCA).

● One WiFi Module, which provides the WiFi functionality to the printer.

● One interface board (Carriage PCA), which provides and converts the appropriate signals for the Carriage 
(printhead interface and line sensor signaling) .

● Two on/off sensor PCAs (Front Door Sensor, Out Of Paper Sensor or OOPS), which indicate the open/closed 
status of the different elements.

● One NVM Back up memory PCA for storing all factory calibration values.

● One encoder sensor and a feed index sensor (other than the encoder sensors located inside the Rewinder, 
the Right Gear Module, and the Service Station).

● One Power Button. Located at rear of MPCA. It is used to power the printer on and off.

● One Power Supply (PSU), which converts the AC power line (110–240 V AC) into the DC power needed by the 
printer (32 V and 12 V).
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The standard wiring used in the printer is Flat Flexible Cables (FFCs), to interconnect all boards (including sensors 
and encoders) and distributed cables for power signals to the motors.

NOTE: It is important to bear in mind that FFCs are relatively delicate, so please ensure cable connectors are 
not touched or dirtied during manipulation for assembly and disassembly operations.

NOTE: Ensure that you are properly grounded for any electronics or wiring manipulation.

The Main PCA
The Main PCA is located on the left-hand side of the printer. This board is the “brain” of the printer: where all the 
processing and printer management occurs; control of the overall machine (digital and mechatronics) with the 
battery for the Real-Time Clock.

There are nine different versions depending on memory size and printer version: 3 Basic (512 MB) for the T210, 
T230, and T250, and 7 Pro (1 GB) for the T630, T650, T650 GSA, Studio 24-in, T630, T650, and Studio 36-in.

The Main PCA also contains other elements with the following functions:

● Battery: To maintain the internal clock up and running. The internal clock is used to remember the actual 
date, used for cartridge life counting and warranty accounting.

● WiFi module: Attached to the top of the board with some plastic locators, provides WiFi functionality to the 
printer.

● eMMC module: Where the firmware of the printer is stored.

● Buzzer: To provide acoustic signals to the user.
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The Bundle Board
The Bundle Board is located on the right-hand side of the printer, this board includes a driver ASIC to control and 
manage the motor, encoder, and sensors located on the right-hand side of the printer.

IMPORTANT: The pick encoder and Service Station cables are not poka-yoke cables: it is possible to connect 
them incorrectly, in which case a system error will result.

Electrical system
The relationship between the components and electronic boards of the printer are detailed here.

The following diagram describes the connections between components and electronic boards, the voltage, and 
the type of data line.

The Bundle Board 37
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● The printer contains a total of 15 printed circuit boards (PCA).

● The Pick Encoder, Service Station Encoder, and Rewind Encoder are exactly the same board.

● The WiFi PCA, although included in the Main PCA Service Kit, is a different board used in other products.

Part Brief technical function

Main PCA (PRO/BASIC) Two versions depending on memory size and printer version.

Bundle Board Mechatronics driver for the right part of the machine motors and 
encoder

Front Panel and Rear Power Button Tactile color visual screen with buzzer for machine power up and 
down, control, and user interface

Carriage PCA => Part of Carriage assembly Carriage control and feed for printhead spitting

OOPS Paper presence detection

Front door sensor Front door state control (open or closed)

Feed index Encoder to detect the paper placement (absolute)

Feed encoder Encoder to control the exact advance of the paper (relative)

Wifi PCA Radio module (including antenna) to give wireless capabilities 
(802.11 a/b/g/n + Bluetooth)

eMMC Module Store the firmware

NVM Backup PCA Store the backup memory for all factory calibration values

Locations of the PCAs
This topic provides a full set of reference information for this subject.
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Troubleshooting2

This chapter provides a comprehensive breakdown of problematic situations, their causes, and recommended 
actions for the user to take when confronted with them.

Printer troubleshooting flowchart
Use the following as a guide to troubleshooting issues with the printer:
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Unplug and plug in 
the power cable.

FP is ON?

Printer is Ready?

Can load paper?

Can print internal 
plots?

Can print from 
computer or mobile 

devices?

Is the IQ OK?

Printer OK

Check “Troubleshooting tree for boot up failure” section

Check “Paper troubleshooting” section

Check “Ink-supplies troubleshooting” section

Check “Communication troubleshooting” section

Check “Print-quality troubleshooting” section

Check “Assert Screen during initialization” sectionAssert Screen is 
showing in FP?

System error in FP? Check “System error codes” section

YES

NO

NO

NO

YES

YES

YES

YES

YES

YES

NO

NO

NO

NO

YES

NO Check “Troubleshooting tree for boot up failure” section

Troubleshooting tree for boot up failure
Follow this troubleshooting tree when the printer doesn't boot up without showing a system error.
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TIP: All these steps can be checked with customers over the phone. Follow the steps to identify what 
component is failing before going onsite.

3 beeps? YES

Touch screen 
respond?

1. Check flat cable from Front Panel to Main PCA.
2. Front Panel Is failing.

1. Check flat cable from Front Panel to Main PCA.
2. Front Panel is failing.
3. Main PCA is failing.

Front Panel shows 
only white or black  

or corrupted 
screen?

YES

NO

YES

Printer OK

Is FP on for some 
seconds?

Plug in the power 
cable.

1. Power is not coming to PSU.
2. PSU is failing.

Orange LED in the 
power button is On 
While pressing the 

power button?

NO

YES

Press power button 
to start printer
(Do not keep it 

pressed)

White LED in the 
power button is on?

YES

Green LED on the Main PCA (heartbeat 
LED) is on (not blinking nor off)?

YES

1. Main PCA is failingNO

YES

1. Main PCA is failing.NO

NO

NO
1. Power is not coming to PSU.
2. PSU is failing.
3. Main PCA is failing.

YES

Freeze at any of these 
screens?

System error in FP? YES

NO

1. Main PCA is failing.

Carriage moves? YES

NO

1 beep?

NO

1. Check if window is closed completely.
2. Window sensor is failing.YES

NO

1. Main PCA is failing.YES

CheckSystem error codes” section.
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Basic printer troubleshooting
This section presents fundamental troubleshooting situations and responses.

The printer does not print
If all is in order (paper loaded, all ink components installed, and no file errors), there are still reasons why a file 
you have sent from your computer may not start printing when expected:

1. You may have an electrical power problem. If there is no activity at all from the printer, and the front panel 
does not respond, check that the power cord is connected correctly and that there is power available at the 
socket.

2. You may be experiencing unusual electromagnetic phenomena, such as strong electromagnetic fields or 
severe electrical disturbances, which can cause the printer to behave strangely or even stop working. In this 
case, turn off the printer using the power key on the front panel and unplug the power cord, wait until the 
electromagnetic environment has returned to normal, then turn it on again. If you still experience problems, 
please contact your customer service representative.

3. You may not have installed in your computer the correct driver for your printer.

4. If you are printing on a sheet, you must specify Automatic, Sheet or Tray as the paper source in your printer 
driver. This printer has auto roll switching support.

No power comes to the printer
Perform the following steps if experiencing this issue.

1. Check that the power socket is working by connecting another device to it and checking if the device 
functions correctly.

2. Check that the customer is not using a power transformer which might cause an issue. Check the printer 
without the transformer connected.

3. Ensure the cable is inserted correctly at both ends; proceed with a reinsertion to ensure correct connection 
especially on the printer side, where sometimes the full insertion requires a bit of force. Ensure the 
customer is using the correct power cord for the printer. In some regions, more than 1 power cord is 
supplied in the printer box.

Front Panel is frozen
If the Front Panel display is blocked, and clearly shows that it has frozen while performing a process, follow these 
steps.

1. Remove all jobs from the computer’s spooler.

2. Reboot the printer through the power cord.

3. Perform Setup > Restore > Cold Reset from the front panel.

4. Manually upgrade the printer to the latest firmware using the HP Printer Utility (Windows)/HP Utility (Mac).

5. If the issue remains, arrange a service engineer visit to replace the Main PCA.

Basic printer troubleshooting
If you see the assert screen during initialization, try the following options before replacing the Main PCA.

44 Chapter 2  Troubleshooting



Phone
Follow this procedure for dealing with the Assert Screen issue by phone.

1. Record or take the photo of the front panel screen.

2. Remove the ethernet and USB cables. If Wi-Fi is used, disconnect it from the access point if possible.

3. Perform “FULL RESET” from low-level menu:

a. Unplug the power cable.

b. Press and hold the power button while plugging in the power cable until the Home and back buttons 
light up. 

c. Press Home > Back > Home > Home.

d. The printer will boot to a blue screen menu.

e. Press MENU.

f. At the NORMAL OFF W IO ONCE screen, press NEXT.

g. At the PARTIAL RESET screen, press NEXT.

h. At the SEMI RESET screen, press NEXT.

i. At the FULL RESET screen, press OK to perform a Full Reset.

j. After pressing OK, the printer will reboot. If the Full Reset has been successful, the printer will boot 
successfully and run through the entire OOBE configuration.
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Onsite
Follow this procedure for dealing with the Assert Screen issue when onsite.

1. Reseat all the cables to the Main PCA and reseat all the cables to the Bundle PC.

2. Reseat the NVM PCA.

3. Reseat the Main PCA.

Where to find the LEDs
The following images demonstrate the locations of the LEDs associated with the Power Button, the Main PCA, 
and the Network Port.

Power Button LEDs
There are two LEDs associated with the Power Button.

Figure 2-1 LED 1 - Orange
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Figure 2-2 LED 2 - White

Main PCA LED ("Heartbeat LED")
There is one LED associated with the Main PCA. The customer and the engineer will pay different attention to it.

For the customer
The customer should observe the Main PCA/Heartbeat LED at the following location.
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NOTE: The customer will notice the reflection of the Heartbeat LED and half of the real LED.

For the onsite service engineer
The Main PCA/Heartbeat LED can be observed at the following location with the Cutter Door removed.
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▲ Remove the Cutter door.

Network Port LEDs
There are two LEDs associated with the Network Port.

Network Port LEDs 49



System error codes

Understanding system error codes
Error messages are generally used to report internal system errors. The following pages contain a list of system 
error codes and their respective descriptions and recommended corrective actions. Try only one recommended 
action at a time, in the order that they appear, and check whether the error code has disappeared.

Text messages and numerical error codes
Occasionally you may see one of the following messages appear on the front-panel display. If so, follow the 
advice in the Recommendation column.

If you see an error message that does not appear here, and you feel in doubt about the correct response, or if the 
recommended action does not seem to solve the problem, contact HP Support.

Table 2-1 Text messages

Message Recommendation

[Color] cartridge has expired Replace the cartridge. See Replace an ink cartridge on page 94
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Table 2-1 Text messages (continued)

Message Recommendation

The indicated cartridges are low. You do not have to replace the 
cartridge(s) now

HP recommends you have a replacement available for when the 
cartridge is depleted and will need to be replaced.

[Color] cartridge is very low on ink Ensure that you have a new cartridge of the same color ready.

Depleted cartridges must be replaced to resume printing Replace the cartridges as needed. See Replace an ink cartridge on 
page 94

Maintenance kit 1 required Contact HP Support.

Maintenance kit 2 required Contact HP Support.

Cartridge Problem (animation) Insert cartridges of the correct color as needed. See Replace an ink 
cartridge on page 94

Paper jam animation + Open the print zone access window and clear 
any paper jam or obstruction

See Roll has jammed on page 70 or Multi-sheet tray has jammed 
on page 72.

The width of the paper is smaller than the minimum size supported 
by the selected media source. Loading cancelled.

Remove the paper and load paper of the correct size.

Loaded paper is too wide. Manual unload required. Remove the paper manually and load paper of the correct size.

The paper is too far from the lateral load line. Try loading the paper 
again.

Remove and reload the paper.

Please manually unload roll paper and try again. Rewind the roll manually.

The currently loaded paper has too much skew and cannot be 
corrected automatically. Touch "Remove" , and then load the paper 
again.

Remove and reload the paper.

The roll is out of paper, and the current job has been cancelled. Load 
another roll, and then send the job again.

Load a new roll.

You are printing a multipage job. Load another sheet to continue 
printing or cancel the job.

Load another single sheet.

Multi-sheet tray is out of paper. Load paper in multi-sheet tray and 
press OK to continue printing or cancel the job.

Actual message specifies media source, for example: "Universal 
Heavyweight Coated Paper, A4 (210x297mm)"

Load paper into the multi-sheet tray.

End of roll has been reached. It is not possible to load the roll. Load a new roll.

Missing or failed printhead. Remove and reinsert the same printhead, or try cleaning the 
electrical connections. If necessary, insert a new printhead. See the 
chapter "Replace the printhead" in the User Guide.

NOTE: The error message does not permit returning to the home 
screen to start the printhead replacement. Instead, press Show 
more.

Refilled or depleted cartridge detected Check the cartridge.

Used cartridges might not have enough ink to complete start-up. 
Open ink door to replace the cartridges.

A new printhead has been inserted without a new set of ink 
cartridges. Replace the cartridges not marked as new. See Replace 
an ink cartridge on page 94.

Wrong file format. The file format is incorrect or not supported. The printer cannot 
process the job, which will be discarded.
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Table 2-2 Numerical error codes

Error code Recommendation

0001-0082 The battery of the real-time clock has expired; contact HP Support.

0021-0017 Service station error. There may be a paper or carriage jam. Check and clear the paper path if necessary 
and restart the printer.

0041-0017, 0042-0117 There may be a paper or carriage jam. Check and clear the paper path if necessary.

0085-XXXX Feeding paper problem. Restart the printer.

0086-0008 There may be a paper or carriage jam. Check and clear the paper path if necessary. Also clean the 
carriage encoder strip.

Severe error codes
Severe error messages inform you of a device failure. Some of these messages can be cleared by pressing the 
power button to turn off the printer, and then pressing it again to turn the printer back on. If a severe error 
persists, service is required.

System Error Code 
(DAXX-YYZZ)

Service Part (XX.YY) Error Cause (ZZ)

0001-0082 01.00. Main PCA 82. Battery or Real time clock ran down

0004-0001 04.00. Print bundle PCA 01. MALFUNCTION_ERROR_STATUS_OR_STATE

0021-0017 21.00. Service station assy 17. MOVEMENT_BLOCKED

0041-0017 41.00. Paper motor 17. MOVEMENT_BLOCKED

0042-0117 42.01. Carriage motor 17. MOVEMENT_BLOCKED

0043-0017 43.00. Pick motor 17. MOVEMENT_BLOCKED

0045-0017 45.00. Rewinder motor 17. MOVEMENT_BLOCKED

0059-0190 59.01. Main PCA NVM or NVM Backup PCA 90. NVM_CONFLICT_MAIN_VS_BACKUP

0059-0191 59.01. Main PCA NVM or NVM Backup PCA 91. NVM_DEFAULT_IN_BOTH_MAIN_AND_BACKUP

0059-0289 59.02. NVM Backup PCA 89. BACKUP_NVM_MISSING

0085-0101 85.01. Feed index PCA 01. MALFUNCTION_ERROR_STATUS_OR_STATE

0085-0201 85.02. Feed encoder PCA 01. MALFUNCTION_ERROR_STATUS_OR_STATE

0087-0001 87.00. Encoder strip 01. MALFUNCTION_ERROR_STATUS_OR_STATE

0153-0302 53.03. Multisheet tray sensor 02. CHECK_FAILURE_PRESENCE_INITIALIZATION_ERROR

0721-0078 21.00. Service station assy 78. UPDATE_OR_MAINTENANCE_NEEDED

0942-0188 42.01. Carriage motor 88. Carriage homing problem

0955-0050 55.00. Carriage Zim sensor SV 50. UNABLE_TO_READ_GET_VALUE

Silent error codes
Silent error codes help with specific troubleshooting. They are accessible only through the error log and don't 
appear in the front panel.
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System Error Code 
(DAXX-YYZZ)

Service Part (XX.YY) Error Cause (ZZ)

0000-0059 00.00. Unknown Service Part 59. MOTOR_SERVO_SHUTDOWN

0027-0001 27.00. Printhead "Generic PHA error"

0027-0002 27.00. Printhead "PHA error: not responding at all"

0027-0004 27.00. Printhead "PHA error: Watchdog fault"

0027-0020 27.00. Printhead "PHA error: VPP short"

0027-0021 27.00. Printhead "PHA error: VPP short"

0027-0022 27.00. Printhead "PHA error: VPP short"

0027-0023 27.00. Printhead "PHA error: VPP short"

0027-0024 27.00. Printhead "PHA error: VPP short test"

0027-0025 27.00. Printhead "PHA error: VPP short"

0027-0033 27.00. Printhead "PHA error: VPP bleed failed"

0027-0046 27.00. Printhead "PHA error: VPP on"

0027-0049 27.00. Printhead "PHA error: VPP bleed failed"

0027-0050 27.00. Printhead "PHA error: VPP bleed failed"

0027-0051 27.00. Printhead "PHA error: VPP bleed failed"

0027-0053 27.00. Printhead "PHA error: VPP bleed failed"

0027-0054 27.00. Printhead "PHA error: VPP bleed failed"

0027-0055 27.00. Printhead "PHA error: VPP bleed failed"

0027-0056 27.00. Printhead "PHA error: VPP expected on"

0027-0059 27.00. Printhead "PHA error: missing"

0027-0060 27.00. Printhead "PHA error: wrong part"

0027-0061 27.00. Printhead "Power on with Filled PHA Change"

0027-0062 27.00. Printhead "Power on with Empty PHA Change"

0027-0063 27.00. Printhead "PHA change with Filled PHA"

0027-0064 27.00. Printhead "PHA change with Empty PHA"

0027-0065 27.00. Printhead "Out of cap with Filled PHA Change"

0027-0066 27.00. Printhead "Out of cap with Empty PHA Change"

0027-0067 27.00. Printhead "Fake PHA Change"

0043-0059 43.00. Pick motor 59. MOTOR_SERVO_SHUTDOWN

0045-0059 45.00. Rewinder motor 59. MOTOR_SERVO_SHUTDOWN

How to interpret severe error codes
Error codes use the “two groups” error code format DAXX-YYZZ. The fields are briefly described in the table 
below:
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Field Description

D Device Type: 1-digit number from 0 to 9.

A Action: 1-digit number from 0 to 9.

XX Module: 2-digit number from 00 to 99.

YY Service Part: 2-digit number from 00 to 99.

ZZ Error Cause: 2-digit numbers from 00 to 99.

See below example as reference:

Key Example: 0041-0017

D: Device Type 0: Printer

A: Actions 0: Replace

XX-YY: Module – Service Part 41-00: Paper motor

ZZ: Error Causes 17: Movement blocked

Specific error codes for startup and opto trip failures
Here is provided a table referencing the service part and error cause for specific error codes.

System Error Code (DAXX-YYZZ) Service Part (XX.YY) Error Cause (YY)

0024-1000 24. IDS startup Out of ink ,faulty or missing cartridge

0024-1100 24. IDS startup Out of ink detected in altered supplies

How to interpret error codes for startup and opto trip failures
Error codes use the “two groups” error code format DAXX-YYZZ., but with slightly different coding to include the 
information of the color that is failing. The fields are briefly described in the table below:

Field Description

D Device Type: 1-digit number from 0 to 9.

A Action: 1-digit number from 0 to 9.

XX Printer function that is failing: 24 (startup) /26 (opto trip failure).

YY Error Cause: 2-digit numbers from 00 to 99.

See below example as reference:

Key Example: 0041-0017

D: Device Type 0: Printer

A: Actions 0: Replace
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Key Example: 0041-0017

XX-YY: Module – Service Part 41-00: Paper motor

ZZ: Error Causes 17: Movement blocked

System error code troubleshooting
This section describes each of the severe errors that may be encountered while using the printer, and provides 
the diagnostic method and the actions required to solve the problem detected.

In general, each error is explained for two different situations:

1. For a call agent to solve remotely with the customer

2. If necessary, for an on-site service engineer to solve

NOTE: When more than one component could be affected by the system error, replace one component at a 
time and check whether the error has gone before replacing another component. Do not replace two electronic 
parts at same time! Using this procedure you will be able to determine exactly which component failed.

System error: 0001-0082

Problem description: Real Time Clock (RTC) Battery ran down.

Other potential parts associated: None

How to solve. How to solve. Remote troubleshooting (call agent)

1. The call agent asks the customer to go to the Support Menu by pressing the Power key 
continuously for 15 seconds.

2. Go to the Diagnostics Menu and select RTC Battery Status to check whether the RTC Battery has 
actually expired, see ARSS Test on page 171.

3. If yes, the call agent should arrange a service engineer visit to replace the RTC battery by 
replacing the Main PCA, see Main PCA (5HB06-67018 & 5HB08-67008) on page 329.

● Main PCA

Onsite troubleshooting and solution (service engineer)

1. Replace the Main PCA, see Main PCA (5HB06-67018 & 5HB08-67008) on page 329.

2. Switch on the printer and go to Extended Support Menu o Extended Support Menu. Select 
RTCBattery Expired option from the Reset Menu in order to reset the RTC battery expired flag.

3. Go back and select Set Date and Time from the Service Menu Set the correct date and time.

System error: 0004-0001

Problem description: Printer Bundle Board communication failure or malfunction

Other potential parts associated: Bundle FFC, Main PCA

How to solve. How to solve. Remote troubleshooting (call agent)

1. Switch the power off and disconnect the power cord. Reconnect the power cord and power on the 
printer.

2. The call agent should arrange a service engineer visit to change the Bundle PCA and follow steps 
below on Onsite Troubleshooting:
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● Printer Bundle Board

3. If a different system error is displayed then the call agent should perform the applicable 
troubleshooting procedure.

Onsite troubleshooting and solution (service engineer)

1. Remove covers and check that all the cables in the Bundle PCA and associated parts are correctly 
connected, and that none of them is damaged. If any cable is disconnected then reconnect it, and 
power on the printer again to check whether the system error has disappeared. Important note: If 
any cable is damaged then order a Cable Service Kit:

● Cables Sk

2. Replace the Bundle PCA, see Removal on page 340.

● Printer Bundle Board

3. Replace the Bundle FFC cable, see Assy PBB to MPCA FFC 36in (5HB10-60066) / Assy PBB to 
MPCA FFC 24in (5HB06-60099) on page 403.

4. Replace the Main PCA (MPCA See Main PCA (5HB06-67018 & 5HB08-67008) on page 329)

● Main PCA

System error: 0021-0017

Problem description: Service station is not able to move all the way

Other potential parts associated: Print Bundle PCA

Corrective action: How to solve. Remote troubleshooting (call agent)

1. Switch the power off and disconnect the power cord.

2. Open the PHA door and look for paper remains that could be blocking the SVS movement.

3. Reconnect the power cord and power on the printer.

4. The call agent should arrange a service engineer visit to change the Service Station, and follow 
the Onsite troubleshooting below:

● Service station assembly

5. If a different system error is displayed then the call agent should perform the applicable 
troubleshooting procedure.

Onsite troubleshooting and solution (service engineer)

1. Remove covers and check that the cables from the Service Station to the Bundle PCA are correctly 
connected and not damaged. Important note: If any cable is disconnected then reconnect it, and 
power on the printer again to check whether the system error has disappeared. If any cable is 
damaged then order a Cable Service Kit.

● Cables Sk – CQ890-67021

2. Make sure that the Service Station path is clear. Remove any visible obstacles (screws, plastic 
parts, etc.) restricting the movement of the Service Station.

3. Go to Support Menu, see Entering the support menus on page 123 and run the Service Station 
diagnostic test, see Test Service Station on page 137 to check whether the system error has 
disappeared.

4. Replace the Service Station, see Service Station Assembly (CQ890-67045) on page 342.

● Service station assembly
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5. Replace the Bundle Board, see Removal on page 340.

● Bundle board

System error: 0024-1000

Problem description: Out of ink, faulty or missing cartridge during the PHA startup process

Other potential parts associated: Supplies

Corrective action: How to solve. Remote troubleshooting (call agent)

1. This error appears when, during the PHA startup process, the printer detects that one of the 
cartridges is out of ink. First, reboot the printer and check if the PHA process is able to finish 
without further intervention.

2. Open the front window and verify that all the cartridges are properly installed. A leakage due to an 
improperly inserted cartridge could cause this issue.

3. If all the supplies were well inserted, ask the customer to try the process again with a new supply. 
It is not required to replace the PHA as the same one can be used to retry the process.

4. If the supply was prematurely detected as OOI, the call agent will arrange a shipment for the 
faulty HP supply replacement.

System error: 0024-1100

Problem description: Out of ink detected in altered supplies during the startup process

Other potential parts associated: PHA

Corrective action: How to solve. Remote troubleshooting (call agent)

▲ Ask the customer to try the process again with a new unused HP supply. It is not required to 
replace the PHA as the same one can be used to retry the process.

System error: 0027-00XX

Problem description: PHA problem

Other potential parts associated: Carriage PCA, Trailing Cable, Main PCA

Corrective action: How to solve. Remote troubleshooting (call agent)

1. Remove, clean and reseat PHA kit. Also, check if ink tubes latch and PHA latch are properly closed 
(Green Lock).

2. The last 2 ciphers of the error code indicate the specific PHA failure. The call agent will note the 
complete system error. for later failure analysis.

3. If the PHA is still in warranty, the call agent will arrange a shipment with a PHA replacement.

System error: 0041-0017

Problem description: Unable to move Paper Servo or no feedback received.

Other potential parts associated: Feed Encoder Sensor PCA, Feed Index Sensor PCA, Feed Encoder Disk

Corrective action: How to solve. Remote troubleshooting (call agent)
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1. Switch the power off and disconnect the power cord. Reconnect the power cord and power on the 
printer.

2. The call agent asks the customer to go to Support Menu by pressing the Power key continuously 
for 15 seconds.

3. Go to Diagnostic Menu, see Entering the support menus on page 123 and run Paper Servo 
diagnostic, see Paper Servo on page 164.

4. After running the diagnostic the printer will show one of these system errors:

● 0081-0008 arrange a service engineer to replace Paper/Feed motor and follow the Onsite 
Troubleshooting explained below, see Paper Motor (CQ890-67036) on page 366.

– Paper Motor

● 0085-0101 need to replace Feed encoder sensor PCA and follow the Onsite troubleshooting 
and solution (service engineer) explained for error 0085-0201.

● 0085-0201 need to replace Feed encoder sensor PCA and follow the Onsite troubleshooting 
and solution (service engineer) explained for error 0085-0201.

5. The call agent should arrange a service engineer visit to replace the right part depending on the 
system error.

Onsite troubleshooting and solution (service engineer)

1. Remove covers and check that all the cables are well connected to the Main PCA, specially the 
paper motor cable, and none of them are damaged. If any of the cables is not connected, then 
reconnect it, and power on the printer again to check whether the system error has disappeared. 
Check that there are no debris, media or foreign objects preventing drive shaft movement.

IMPORTANT: If any cable is damaged then order a Cable Service Kit:

● Cables Sk

2. Run Paper Servo diagnostic, see Paper Servo on page 164. After running the diagnostic check for 
the following system errors:

After running the diagnostic the printer will show one of these system errors:

● 0081-0008 arrange a service engineer to replace Paper/Feed motor and follow the Onsite 
Troubleshooting explained below, see Paper Motor (CQ890-67036) on page 366.

– Paper Motor

● 0085-0101 need to replace Feed encoder sensor PCA and follow the Onsite troubleshooting 
and solution (service engineer) explained for error 0085-0201.

● 0085-0201 need to replace Feed encoder sensor PCA and follow the Onsite troubleshooting 
and solution (service engineer) explained for error 0085-0201.

3. If the 0041-0017 error continues then the Paper/Feed motor should be replaced. See Paper 
Motor (CQ890-67036) on page 366.

● Paper Motor

4. Replace the Main PCA, see Main PCA (5HB06-67018 & 5HB08-67008) on page 329.

● Main PCA

System error: 0042-0117

Problem description: Unable to move Carriage Servo or no feedback received.

Other potential parts associated: Trailing Cables, Carriage Board, Carriage Motor, Carriage Belt, Encoder Strip
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Corrective action: How to solve. Remote troubleshooting (call agent)

1. Switch the power off and disconnect the power cord. Reconnect the power cord and power on the 
printer.

2. The call agent asks the customer to go to Support Menu by pressing the Power key continuously 
for 15 seconds.

3. Go to Diagnostic Menu, see Entering the support menus on page 123 and run Carriage Servo 
diagnostic, see Test Carriage on page 136.

4. If the carriage it is not held by the service station, move the carriage and check if there is to much 
friction.

CAUTION: Do not damage the encoder strip.

5. The call agent should arrange a service engineer visit to change the carriage motor.

Onsite troubleshooting and solution (service engineer)

1. Check that the Carriage Motor belt is not broken or out of place, and the pulley on the SVS side 
turns freely and horizontal.

2. If the belt and pulley are OK, then the Carriage Motor should be replaced, see Carriage Motor 
(5HB06-67003) on page 391.

● Carriage Motor

3. If the belt or pulley were damaged, they should be changed. Order the belt service kit, see 
Removal on page 374.

● Belt (36)

System error: 0043-0017

Problem description: Unable to move Pick Servo or no feedback received.

Other potential parts associated: None

Corrective action: How to solve. Onsite troubleshooting and solution (service engineer)

1. Remove the covers and check that all the cables are well connected to the Printer Bundle Board 
(right side of the unit), especially the pick motor cable, and none of them are damaged. If any 
cable is not connected, then reconnect it, and power on the printer again to check whether the 
system error has disappeared.

Check right hand gear train for blockage or damage.

IMPORTANT: If any cable is damaged, then order a Cable Service Kit:

● Cables Sk

2. Replace the Right Gear Train module.

System error: 0045-0017

Problem description: Unable to move Rewind Servo or no feedback received.

Other potential parts associated: Main PCA

Corrective action: How to solve. Remote troubleshooting (call agent)

1. Switch the power off and disconnect the power cord. Reconnect the power cord and power on the 
printer.
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2. Remove the spindle, check the spindle gear and gear cap position. Check rewinder gears for 
damage. Finally, boot the unit without the spindle.

3. The call agent should arrange a service engineer visit to change the Rewinder module, and follow 
the Onsite troubleshooting below:

● Left Roll Support

4. If a different system error is displayed then the call agent should perform the applicable 
troubleshooting procedure.

Onsite troubleshooting and solution (service engineer)

1. Remove the covers and check that the cables of the rewinder module are correctly connected to 
the Main PCA, and that none of them are damaged. If any cable is disconnected then reconnect it, 
and power on the printer again to check whether the system error has disappeared.

IMPORTANT: If any cable is damaged then order a Cable Service Kit:

● Cables Sk

2. Replace the Left Roll Support. See Left Roll Support with Rewinder and Cover (5HB08-67004 & 
5HB12-67016) on page 313.

● Left Roll Support

3. Replace the Main PCA, see Main PCA (5HB06-67018 & 5HB08-67008) on page 329.

● Main PCA

System error: 0059-0190

Problem description: Conflict found between NVM main and backup

Other potential parts associated: None

Corrective action: How to solve. Onsite troubleshooting and solution (service engineer)

1. The error appears if during a service operation, the Main PCA or the NVM backup PCA are replaced 
by a reused part (not a new spare part).

2. To recover, repair using HP genuine new spare parts.

System error: 0059-0191

Problem description: Default data found in both NVM main and backup

Other potential parts associated: None

Corrective action: How to solve. Onsite troubleshooting and solution (service engineer)

1. The error appears if during a service operation, the Main PCA and the NVM backup PCA are 
replaced at the same time.

2. To recover, repair by changing first one component (use the old component for this printer), then 
power the printer off and on, and change the other.

System error: 0059-0289

Problem description: NVM backup is missing or does not work correctly (NVM location).

Other potential parts associated: Main PCA
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Corrective action: How to solve. Remote troubleshooting (call agent)

▲ Restart the unit. If the problem persists, then:

Onsite troubleshooting and solution (service engineer)

1. Remove left cover, and ensure NVM backup cable is properly connected to it and to the Main PCA.

2. Replace the NVM backup.

3. If the issue persists, replace the Main PCA.

System error: 0085-0101

Problem description: Feed index encoder sensor does not work properly

Other potential parts associated: Feed Encoder Disk, Main PCA

Corrective action: How to solve. Remote troubleshooting (call agent)

1. Switch off the printer, and disconnect the power cord. Reconnect the power cord and power on the 
printer.

2. The call agent should arrange a service engineer visit to change the Feed Index PCA and follow 
onsite troubleshooting below.

● Feed Index encoder sensor PCA

3. If a different system error is displayed then the call agent should perform the applicable 
troubleshooting procedure.

Onsite troubleshooting and solution (service engineer)

1. Remove the covers and check that all the cables are well connected to the Main PCA, and none 
of them are damaged. If any cable is not connected then reconnect it, and power on the printer 
again to check whether the system error has disappeared.

IMPORTANT: If any cable is damaged then order a Cable Service Kit:

● Cables Sk

2. Replace the Feed Index Encoder Sensor PCA, see Encoder PCA (CQ890-60204) and Index 
(CM751-60021) on page 396

● Feed Index encoder sensor PCA

3. Check that the Encoder Disk is not dirty or damaged. If the Encoder Disk is damaged, it should be 
replaced, see Encoder Disk (CQ890-67033) on page 337.

● Encoder Disk

System error: 0085-0201

Problem description: Feed encoder sensor does not work properly

Other potential parts associated: Feed encoder Disk, Main PCA

Corrective action: How to solve. Remote troubleshooting (call agent)

1. Switch off the printer, and disconnect the power cord. Reconnect the power cord and power on the 
printer.

2. The call agent should arrange a service engineer visit to change the Feed encoder sensor PCA.

● Feed Encoder Sensor PCA
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3. If a different system error is displayed then the call agent should perform the applicable 
troubleshooting procedure.

Onsite troubleshooting and solution (service engineer)

1. Remove the covers and check that all the cables are well connected to the Main PCA, and none 
of them are damaged. If any cable is not connected then reconnect it, and power on the printer 
again to check whether the system error has disappeared.

IMPORTANT: If any cable is damaged then order a Cable Service Kit:

● Cables Sk

2. Replace the Feed Encoder Sensor PCA, see Encoder PCA (CQ890-60204) and Index 
(CM751-60021) on page 396.

● Feed Encoder Sensor PCA

3. Check that the Encoder Disk is not dirty or damaged. If the Encoder Disk is damaged it should be 
replaced, see Encoder Disk (CQ890-67033) on page 337.

● Encoder Disk

System error: 0087-0001

Problem description: Encoder Strip failure

Other potential parts associated: Carriage (encoder sensor)

Corrective action: How to solve. Remote troubleshooting (call agent)

1. Switch off the printer, and disconnect the power cord. Reconnect the power cord and power on the 
printer.

2. The call agent should arrange a service engineer visit to change the Encoder Strip and follow 
onsite troubleshooting below.

● Encoder Strip (36)

3. If a different system error is displayed then the call agent should perform the applicable 
troubleshooting procedure.

Onsite troubleshooting and solution (service engineer)

1. Remove the covers and check that Encoder Strip is not broken or dirty.

● Cables Sk

2. If the Encoder Strip is dirty, follow the procedure in this manual to clean it, see Clean the Encoder 
Strip on page 440.

3. If the Encoder strip is damaged or does not work, it should be replaced, see Encoder Strip 
(CQ890-67096 & CQ893-67029) on page 376.

4. If this fails to solve the issue, the problem might be due to the encoder sensor within the 
carriage. In that case, replace the carriage, see Carriage Assembly with Belt and Trailing Cable 
(5HB06-67001 & 5HB10-67001) on page 380.

System error: 0153-0302

Problem description: Multi-Sheet Tray presence not detected

Other potential parts associated: MPCA

Corrective action: How to solve. Remote troubleshooting (call agent)
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▲ Ensure that the Multi-Sheet Tray is properly placed and the latch is closed.

Onsite troubleshooting and solution (service engineer)

▲ Ensure that the Multi-Sheet Tray sensor cable is correclty connected to the MPCA, checking the 
J27 connector in the MPCA.

System error: 0942-0188

Problem description: Carriage homing problem

Other potential parts associated: None

Corrective action: How to solve. Remote troubleshooting (call agent)

1. Reboot the unit. If the problem persists, clean the encoder strip, see Clean the Encoder Strip on 
page 440.

2. If the issue is not solved, open the PHA door and check if there’s any paper strips blocking either 
the carriage or the SVS.

3. Go to Diagnostic Menu, see Entering the support menus on page 123 and run Carriage Servo 
diagnostic, see Test Carriage on page 136.

Onsite troubleshooting and solution (service engineer)

1. Check encoder strip, scan axis and service station parts.

2. Depending on the failing subsystem, any one of them may need replacing.

System error: 0955-0050

Problem description: Line sensor failure

Other potential parts associated: Carriage PCA, Trailing Cable, Main PCA

Corrective action: How to solve. Remote troubleshooting (call agent)

1. Switch off the printer, and disconnect the power cord. Reconnect the power cord and power on the 
printer.

2. The call agent asks the customer to go to Support Menu by pressing the Power key continuously 
for 15 seconds.

3. Go to Diagnostic Menu and run the Line Sensor diagnostic, see Line Sensor (Zim/Spot) on page 
166.

4. The call agent should arrange a service engineer visit to change the Line Sensor assembly; follow 
the onsite troubleshooting below.

● Line Sensor

5. If a different system error is displayed then the call agent should perform the applicable 
troubleshooting procedure.

Onsite troubleshooting and solution (service engineer)

1. Go to Support Menu (see Entering the support menus on page 123) and run the Line Sensor 
diagnostic, see Line Sensor (Zim/Spot) on page 166.
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2. Remove the covers and check that the cable of the line sensor is connected to the Carriage PCA 
and it is not damaged. If the cable is not connected then reconnect it, and power on the printer 
again to check whether the error has disappeared.

IMPORTANT: If the cable is damaged then replace the Line Sensor, see Carriage Line Sensor (ZIM 
sensor) (CQ890-67001) on page 387.

● Line Sensor

3. Clean the Line Sensor and try again, see Clean the Carriage Line Sensor on page 439.

4. Replace the Carriage Assembly, see Carriage Assembly with Belt and Trailing Cable 
(5HB06-67001 & 5HB10-67001) on page 380.

● Carriage assembly w/belt (36)

5. Replace the Main PCA, see Main PCA (5HB06-67018 & 5HB08-67008) on page 329

● Main PCA

Other possible errors
Although infrequent, there are errors and asserts that can be displayed in the Front Panel in a different format. 
Usually these errors are solved by turning the printer off and on.

Examples of these errors are shown here:
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Assert codes
In certain circumstances, an assert error code can be displayed on the Front Panel. Assert error codes are 
displayed in unexpected and uncontrollable FW conditions (equivalent to a blue screen in Windows).

Assert codes have 3 equivalent codifications: 0xAAAABBBB, 1800-AAAA-BBBB, or AAAABBBB. For example, 
assert code 1800-6101-1bf0 is equivalent to assert 0x61011bf0 and to assert code 61011bf0. The code will be 
shown in one format or the other depending on the place where it is shown (Front Panel, error log, etc.).

Assert codes can be displayed in the Front Panel in several ways: blue screens with a code, white screens with a 
code, normal screens with the error code, etc.
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It is the assert code that the printer will display when an unknown exception occurs that cannot be pointed to by 
any specific subsystem of the printer. Since the trigger is an unknown exception, the number of possible causes 
behind it is large. The majority can be grouped, however, into the following groups.

● Job-related

● Data-related

● User-interaction related

● Hardware-related

● Network-related

● Random

Assert error codes are rarely related to hardware issues with a printer component. Replacing PCAs or other 
components of the printer due to assert error codes is discouraged, unless this is part of the troubleshooting 
defined for an specific assert code.

When encountering an assert error code that appears consistently, check if there is a specific troubleshooting in 
the following table of "known assert error codes and solutions".

For assert error codes without a specific troubleshooting, the following procedure is recommended:

1. Capture all the information related to the error situation (when did the error appear: during boot-up, printing, 
during physical intervention with the printer, etc.). If the error reappears in similar situations (for example, 
sending a plot of a certain format from a certain application), avoid this work-flow as a workaround until the 
issue is fixed in a future FW release.

2. Ensure the latest FW and drivers are being used. Newer FW releases contain fixes for most common asserts 
seen in the printers.

Here are some known assert codes and the solutions.

Assert code When Corrective action

B8000000

B80383B2

0005fbb6

After sending a job or during initialization How to solve: Remote troubleshooting (call agent)

1. Remove all jobs from computer’s spooler

2. Ensure latest FW and drivers are being used.

C4EB0400 During physical user intervention (for 
example, when accessing ink cartridge door, 
ink cartridge, etc.)

Onsite troubleshooting and solution (service engineer)

1. Remove covers and check that all the cables in the Bundle PCA 
and associated parts are fully connected.
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2. Refer to System error 0004–0001.

0x0af7ffc1

0af7ffc1

1800-0af7-ffc1

Booting up/Anytime Reboot. If problem persists install a new Main PCA.

0x01B6B8E6

01B6B8E6

1800-01B6-B8E6

Booting up/Anytime Reboot. If problem persists install a new Main PCA.

How to get the system error log
The last 50 system errors can be viewed on the Front Panel.

To see the error log, go to the Service Menu, enter the Information Menu, and request the error history; see 
Assert History on page 191.

To print the error history, go to the Service Menu, enter the Reports Menu, and request the error history; see Error 
history on page 183.

To check the error log by EWS go to Tools > Reports > Error Log.

Paper troubleshooting
Use the following section to troubleshoot paper-related issues when the problem has not been solved by 
following the troubleshooting of paper issues in the user's guide.

For every paper issue, first make sure you have reviewed the paper supported by the product (type and size). Also 
make sure the customer has followed the user's guide instructions to load the paper. In summary, check that the 
customer is:

● Using supported paper

● Using appropriate paper path
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● Following the front-panel instructions

For further detailed information about HP Large-Format Printing Supplies, see http://www.hp.com/go/designjet/
supplies.

Paper specifications:

Minimum Maximum

Roll width 279 mm ((11 in)) 610 mm ((24 in) )or 914 mm ((36 in))

Roll length 46 m (150 feet)

Roll diameter 100 mm ((3.9 in))

610 mm ((24 in) )roll weight 4.1 kg ((9 lb))

914 mm ((36 in) )roll weight 6.2 kg ((14 lb))

Sheet width 210 mm ((8.27 in)) 610 mm ((24 in) )or 914 mm ((36 in))

Sheet length 279 mm ((11 in)) 1676 mm ((66 in))

Paper thickness 0.3 mm ((0.01 in))

Paper weight 60 g/m² 280 g/m² (220 g/m² in multi-sheet tray)

Multi-sheet tray stacking capacity 5 mm height

Paper cannot be loaded successfully
Remote troubleshooting (call agent)

● Check that the customer has followed the paper troubleshooting included in the user's guide, if not, help the 
customer to do it.

● If the problem persists, ask the customer to restart the printer.

● If the paper still cannot be loaded after restarting, follow the next recommendations depending on the type 
of paper the user is trying to load (roll, single sheet, or from the Multi-Sheet Tray).

Unsuccessful roll load
Follow these recommendations if confronted with this situation.

1. Ensure that the Output Tray is closed. If the Output Tray is open, ask the customer to close it and try to load 
the roll again. 

2. Check spindle hubs and roll directionality feed under or over.

3. Ask the customer to try to print from the Multi-Sheet Tray. If he can print from the Multi-Sheet Tray, it 
means that the OOP sensor and the paper motor work correctly. Ask the customer to re-check that there 
are no pieces of paper stuck in the paper path.

4. If no anomalies are detected, ask the customer to cut 10 cm of the paper roll or use a new roll (if possible) 
and try to load the roll again.

5. If no anomalies are detected, ask the customer to run the OOP sensor diagnostics. If they fail the OOP 
sensor should be replaced, arrange the shipment of an OOP sensor (CSR A part) to the customer. 

6. If the OOP sensor diagnostics pass, arrange a service engineer visit to diagnose the issue.
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Unsuccessful sheet load
Follow these recommendations if confronted with this situation.

1. Ensure that the Output Tray is closed. If the Output Tray is open, ask the customer to close it and try to load 
the sheet again. 

2. Ask the customer to try to print from the Multi-Sheet Tray. If he can print from the Multi-Sheet Tray, it 
means that the OOP sensor and the paper motor work correctly. Ask the customer to re-check that there 
are no pieces of paper stuck in the paper path.

3. If no anomalies are detected, ask the customer to try to load a different paper type (roll or single sheet). If 
the load is successful, check with the customer that the type of paper failing to load is a supported paper.

4. If the paper is supported, ask the customer to run the OOP sensor diagnostics. If the diagnostics fail, the 
OOP sensor should be replaced, arrange the shipment of an OOP sensor (CSR A part) to the customer.

5. If the OOP sensor diagnostics pass, arrange a service engineer visit to diagnose the issue.

Unsuccessful load from the Multi-Sheet Tray
Follow these recommendations if confronted with this situation.

1. Ask the customer to remove all the sheets from the Multi-Sheet Tray, and load only one sheet (A4 or A3). 
Try to print. If the load is correct, ensure that the customer has not loaded too many sheets into the tray, 
also that the paper is supported.

2. Ask the customer to ensure that the Multi-Sheet Tray is well positioned.

3. If one sheet works OK, but it fails with several, it could mean that there is a problem with the Multi-Sheet 
Tray. To check this, ask the customer if roll or single sheet can be loaded successfully. If yes, the Multi-Sheet 
Tray should be replaced, arrange the shipment of a Multi-Sheet Tray (CSR A part) to the customer.

4. If it is impossible to load a sheet through the Multi-Sheet Tray, and neither roll nor single sheet can be 
loaded, ask the customer to remove the Multi-Sheet Tray and re-check whether there is any piece of paper 
stuck in the tray. 

5. If no anomalies are detected, ask the customer to run the OOP sensor diagnostics. If they fail, the OOP 
sensor should be replaced, arrange the shipment of an OOP sensor (CSR A part) to the customer. 

6. If the OOP sensor diagnostics pass, arrange a service engineer visit to diagnose the issue. 

Onsite troubleshooting

The service engineer should first follow the paper troubleshooting procedure in the user's guide, and also the 
instructions in this manual given to the customer by the call agent to double-check that the troubleshooting has 
been done correctly. In most cases the problem can be solved by following these instructions. If the problem 
persists, try the following:

1. Remove covers and check that there is no broken part in the following:

● Starwheel rail

● Pinchwheels

● Strange noise in motor or Drive Roller

● Upper paper guide is out of place or broken
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● Out-Of-Paper Sensor is badly positioned

2. If any defective or broken part is found, it should be replaced.

Multisheet Tray Sensor issues: Printer displays wrong status for Multisheet Tray
Follow these recommendations if confronted with this situation.

Onsite troubleshooting

In case front panel messages do not match actual tray status the issue may be related with the Multisheet Tray 
sensor.

1. If the printer informs that the tray is detached when it is not: Clean the mirror in the tray or check whether it 
is missing. Ultimately, replace the Multisheet Sensor.

2. If the printer informs media is present when it is not: Clean the mirror in the tray or check for media pieces 
obstructing the sensor.

3. If the printer informs media is not present when it is: The printer will trigger the loading action anyway after 
a job is sent, if the media is there, it will be picked up and moved to the Out of Paper sensor that will detect 
the media.

Media jam removal
When a paper jam occurs, you normally see a message about it in the front-panel display.

Roll has jammed
When a paper jam occurs, you normally see a message about it in the front-panel display.

1. Open the roll cover.
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2. Open the main window.

3. Rewind the roll to create a loop. Cut the paper, if needed.

4. Carefully remove any of the jammed paper that you can from the top of the printer.

5. Carefully remove any of the jammed paper from the front window. 

6. Reload the roll, or load a new sheet.
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NOTE: If you find that there is still some paper causing an obstruction within the printer, restart the procedure 
and carefully remove all pieces of paper. You may need to remove the multi-sheet tray (see Multi-sheet tray has 
jammed on page 72).

Multi-sheet tray has jammed
Paper can jam in the multi-sheet tray for a variety of reasons and there are steps to follow to correct an issue.

Proceed as follows:

1. Remove as much paper as you can from the multi-sheet tray.

2. Push down the multi-sheet tray extensions, which will make the tray easier to handle.

3. Unlock the tray, using the rotary switch behind it.

4. Pull out the tray.

5. Remove all paper from the tray.
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6. Put the tray in again.

7. Lock the tray.

ARSS: Paper Troubleshooting
Use the following section presents a guide to helping the customer identify which part is failing and how to fix it.

Troubleshooting - Remote Support
The following steps represent over-the-phone customer support for the ARSS.

1. Check if ARSS is installed.

Check if ARSS is installed with the printer by visual check. If ARSS is not installed, the issue is not related to 
ARSS. Remember that the printer has no sensor to detect the ARSS. Front panel or EWS doesn’t show the 
information.
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2. Check if ARSS is correctly installed.

Install the ARSS by following the assembly instructions to ensure it has completely inserted and Multi-sheet 
tray. Heard “click” on both sides during reseat ARSS. Outer surface is even with Guide-Roll.

3. Check if ARSS is correctly working.

a. Load cut sheets in the Multi-sheet tray.

b. Load a roll.

c. Print "Printer Status Report" (FP > User menu > Report > Printer Status Report).

d. Printer rewinds the roll and move the leading edge to the parking position (Condition A).

e. Printer picks a cut sheet from the Multi-sheet tray and print the job.

f. After between 30 seconds and several minutes, the printer automatically loads the roll, the line sensor 
checks the media, then moves it to standby position under the pinch rollers (Condition B).
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4. Check if the issue depends on media type/condition.

Deformation of the roll can brock the behavior of picking roll. Too curly especially at the end of roll, high/low 
humidity, long time no use, specific media type, etc).

5. Perform “ARSS Test” (Support Menu > Print diagnostics > ARSS Test).

Troubleshooting - Onsite Support
This guide is for use by the engineer when onsite with the customer.

Service Station

Troubleshooting for onsite engineers:

1. Open the Right Cover.

2. Perform Support Menu > Service Tests > ARSS Test to move the Service Station forward and backward.

3. Visually check if the Service Station Sled pushes and releases the trigger (white lever) in the Bridge Plate 
Module.

4. If it doesn’t work, reseat or replace the Service Station.

Bridge Plate Module and ARSS

Troubleshooting for onsite engineers:

1. Remove the Multi-sheet tray and the ARSS.
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2. Visually check if the ARSS Gear link is installed correctly.

3. Perform Support Menu > Service Tests > ARSS Test to rotate this gear. Ignore the result of the ARSS Test on 
the FP.

4. If the gear doesn’t work, reseat the ARSS Gear link then replace the Bridge Plate Module.

5. Install ARSS.

6. Perform Support Menu > Service Tests > ARSS Test to raise and lower the ARSS pickup rollers. Ignore the 
result of the ARSS Test on the FP.

7. To observe the pickup rollers, slacken the paper during the test.

a. Perform the ARSS Test.

b. Load a roll.

c. Printer moves the roll to the parking position.
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d. Create a slackness in the paper to expose the pickup rollers for visual inspection:

e. Observe the pickup rollers as the printer raises and lowers them.

8. If the pickup rollers do not perform as described, replace the ARSS.

Symptoms related to ARSS failure and corrective actions
This section details ARSS failure warning signs and the appropriate actions to take.

You would see the following symptoms if ARSS fails: Printer fails to pick up or move the roll from parking position 
to ready position, and the front panel shows the following screens after printing from the multi-sheet tray.

Issue #1: Paper Jam

Root cause: PWM of Pick Motor in the Bridge Plate Module is over its limit.
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How this happens: A paper jam occured and the paper is blocking the movement of the Pick Motor.

● ARSS was wrongly installed. The movement of the ARSS link Gear and/or the gears of the Bridge Plate 
Module are blocked.

Corrective actions - for Customer over the phone

Perform the following steps to complete this procedure.

1. Check if ARSS is installed in the printer with a visual check. If ARSS is not installed, the issue is not related to 
ARSS.

2. Remove the multi-sheet tray, roll, and ARSS.

3. Clean any paper jam from the paper path for the Multi-sheet tray if needed.

4. Install the ARSS by following the assembly instructions to ensure it and the multi-sheet tray have been 
completely and correctly inserted.

5. Load the roll manually.

Corrective actions - for Onsite Engineer at customer’s site

Perform the following steps to complete this procedure.

1. Check if there is any paper jam in the printer.

2. Reseat the ARSS link Gear.

3. Replace the Bridge Plate Module.

Issue #2: The printer cannot detect or load the media

Root cause: The line sensor cannot detect the media.
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How this happens:

1. Printer successfully picks up the roll from the parking position.

2. Then the leading edge of the roll passes over the OOPS.

3. However, it doesn’t reach the feed shaft (feed roller).

4. The feed shaft drives but it doesn’t carry the media.

5. Finally, the printer tries to detect the media presence on the print platen with the line sensor, but it doesn’t 
detect it because the media didn’t reach the print platen. It’s still located before feed shaft.

Corrective actions - for Customer over the phone

Perform the following steps to complete this procedure.

1. Check if ARSS is installed in the printer with a visual check. If ARSS is not installed, the issue is not related to 
ARSS.

2. Unload the roll and then load it manually.

3. If the issue repeats quite frequently, replace the roll to mitigate any possible deformation.
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Corrective actions - for Onsite Engineer at customer’s site

Perform the following steps to complete this procedure.

▲ Check if the roll shows any deformation (too curly, especially at the end of roll; could be due to high or low 
humidity, going a long time without use, the specific media type, etc.). If yes and the issue repeats, replace 
the roll.

Issue #3: Roll automatically unloaded

Root cause: OOPS didn’t detect the media presence within expected time.

How this happens:

1. The leading edge of the roll escaped from the area where the pick rollers of ARSS can reach or pick up. 
Potential causes include:

a. User accidently rewound the roll manually.

b. Deformation of the roll (too curly, especially at the end of roll; high or low humidity; long time without 
use; specific media type; etc.).

c. Roll was over-rewound by the rewinder for some reason.

2. ARSS was wrongly installed. It doesn’t engage with the ARSS link gear.

3. ARSS link gear is missing or failing.

4. Bridge Plate Module is failing.

5. Service station doesn’t push the trigger (white lever) of the Bridge Plate Module.

Corrective actions - for Customer over the phone

Perform the following steps to complete this procedure.

1. Check if ARSS is installed in the printer with a visual check. If ARSS is not installed, the issue is not related to 
ARSS.

2. Remove the multi-sheet tray, roll, and ARSS.

3. Install the ARSS by following the assembly instructions to ensure it and the multi-sheet tray have been 
completely and correctly inserted.

4. Load the roll manually.

5. If the issue repeats quite frequently, replace the roll to mitigate any possible deformation.
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Corrective actions - for Onsite Engineer at customer’s site

Perform the following steps to complete this procedure.

1. Check if the roll ahows any deformation (too curly, especially at the end of the roll; could be due to high 
or low humidity, going a long time without use, the specific media type, etc.). If yes and the issue repeats, 
replace the roll.

2. Check that the ARSS link gear is not missing.

3. Reseat the ARSS link Gear.

4. Replace the Bridge Plate Module.

5. Replace the Service Station.

Printer displays out of paper when paper is available
Follow these recommendations if confronted with this situation.

Remote troubleshooting

● Check if the customer has followed the paper troubleshooting included in the user's guide. If not, help him or 
her to do it.

● If the problem persists, ask the customer to unload paper, restart the printer and ask to load paper again. 
If everything is OK, it is likely the printer has an old firmware version, ask the customer to do an firmware 
upgrade.

● If there is a problem with the printer, it is likely that the customer cannot load paper after restarting the 
printer, in this case see Paper cannot be loaded successfully on page 68.

Onsite troubleshooting

The service engineer should first follow the paper troubleshooting in the user's guide, and also the instructions 
in this manual given to the customer by the call agent to double-check that the troubleshooting has been done 
correctly. In most cases the problem can be solved by following these instructions. If the problem persists:

1. Remove the covers and check that the OOP sensor is well placed and the flag is not broken.

2. Check the cables to see whether any of them is broken or disconnected (especially the OOPS cable and the 
cable in the Bundle Board).

3. If everything is OK, replace the Bundle Board (see Removal on page 340).

4. If the problem persists, replace the Main PCA (see Main PCA (5HB06-67018 & 5HB08-67008) on page 329).

Cutter does not cut, or does not cut well
Follow these recommendations if confronted with this situation.

Remote troubleshooting

● Check that the customer has followed the paper troubleshooting included in the user's guide. If not, help him 
or her to do it.

● If the problem persists, ask the customer to check whether the cutter has been disabled in the front panel 
and/or in the driver.

● Ask to try a different paper, and try to cut it using Form Fit and Cut from the front panel menu.
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● If is still not cutting, ask the customer to check that the cutter is engaged and that it moves together with the 
Carriage. If the cutter is not activated, ask the customer to open the Ink Cartridge Cover and check whether 
there is a strip of paper in the parking position causing the cutter not to activate.

● If this does not solve the issue, arrange a service engineer visit to replace the cutter assembly.

Onsite troubleshooting

The service engineer should first follow the paper troubleshooting in the user's guide, and also the instructions 
in this manual given to the customer by the call agent, to double-check that the troubleshooting has been done 
correctly. In most cases the problem can be solved by following these instructions. However, if the problem 
persists, try the following steps:

1. If the cutter is not engaged, check that the cutter bridge is well assembled.
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2. Check the cutter spring is in place.

3. If the cutter bridge is well assembled and the cutter is not activated while cutting, the cutter assembly 
should be changed..

4. Check whether there is noise due to high friction during the cut. If this occurs, the cutter assembly should be 
changed. The high friction could be due to one of the following circumstances:

a. Worn-out blades as a consequence of many cuts.

b. Dirty blades. Likely to hold some sticky glue after cutting vinyl.

c. Hard points in blades. Whenever the cutter has suffered an impact, such as falling onto the floor, the 
blades mark themselves creating a hard point.

d. Excessive friction in the mechanism of the cutter. 

Paper has jammed
Remote troubleshooting

● Check that the customer has followed the paper troubleshooting procedures described in the user's guide. If 
not, help him or her to do it.

● If the jam occurs with roll or single sheet, check with the customer that the output tray is closed. The printer 
does not allow printing or loading roll or single sheet with the Output Tray open (a message appears on the 
Front Panel). However if this is the case it is likely that the Output Tray Sensor is broken. Ask the customer to 
run the Output Tray Sensor diagnostics. If the diagnostics fail, arrange a service engineer visit to replace the 
Output Tray Sensor.

● If the jam occurs with roll, and the output tray is closed, check with the customer whether the jam occurs at 
the beginning of the print, because due to the paper curling the paper is stopped into the Output Tray (does 
not fall into the basket), provoking a paper jam. If this is the case, check with the customer whether the ribs 
in the Output Tray have risen or not. If these ribs are not up while printing from roll, it can cause paper jams 
at the beginning of the plot. If this is the case, arrange a service engineer visit to replace the Output Tray.

● If the problem persists it is probably a mechanical problem that should be diagnosed by a service engineer. 
Arrange a service engineer visit to diagnose the issue.

Onsite troubleshooting

The service engineer should first follow the paper troubleshooting in the user's guide, and also the instructions 
in this manual given to the customer by the call agent, to double-check that the troubleshooting has been done 
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correctly. In most cases the problem can be solved by following these instructions. However, if the problem 
persists, remove the covers and try the following steps:

1. Check that all the Pinchwheels are all present and well assembled; check also that all the pinchwheel 
springs are in place.

2. Check that the starwheel rail is correct.

3. Check that the spindle is not broken or inserted incorrectly, and that the spindle gear is OK.

Communication troubleshooting
Please follow these suggestions to diagnose remote communication issues.

General troubleshooting
A selection of potential issues and recommendations for user response.

1. Check the following symptoms:

● The front-panel display does not show the Printing message when an image has been sent to the 
printer.

● The computer displays an error message instead of printing.

● The computer or printer hangs (stays idle), while communication is taking place.

● The printed output shows random or inexplicable errors (misplaced lines, partial graphics, etc.).

2. To solve a communication problem:

● Ensure that the correct printer has been selected in the application.

● Ensure that the printer works correctly when printing from other applications.

● Remember that very large prints may take some time to receive, process, and print.

● If the printer is connected to a network, check the printer connectivity status: the printer should have 
an IP address and it should match the IP address specified in the printing computer. If the addresses do 
not match, then configure it correctly; if the issue persists, check the network configuration.

● Try WiFi.
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● If the printer is connected to a wireless network, try moving the printer closer to the wireless router. 
Alternatively, try connecting the printer by network.

● If the printer is connected to a wireless network, you can request a diagnostic report from the front 
panel: Scroll down the dashboard and press , then scroll down the menu and press Network Set Up 
> Print Reports >.Wireless Test Report. Alternatively, try moving the printer closer to the wireless router, 
or try connecting the printer by wired network.

When a network device automatically configures itself by receiving an IP address from the DHCP service, 
this IP address may change from the last time the device is powered off to the next time it is powered on, 
which may lead to the device being shown as "offline" when driver port settings are configured with the 
original IP address. There are at least three possible ways to avoid this:

● Increase the lease time of the DHCP server device.

● Set a fixed IP address for the printer so that it will not change by DHCP.

● Configure the printer and driver to refer to the hostname instead of the numeric IP address.

Wired network issues
Follow these steps if software installation is impeded.

▲ If the HP software provided with the printer cannot be installed, check that:

● All cable connections to the computer and the printer are secure.

● The network is operational and the network hub is turned on.

● All applications, including virus protection programs, spyware protection programs, and firewalls, are 
closed or disabled for computers running Windows.

● The printer is installed on the same subnet as the computers that use the printer.

If the installation program cannot discover the printer, print the Network Configuration Page, and enter the 
IP address manually in the installation program.

Although assigning a static address to the printer is not recommended, some installation problems (such as 
a conflict with a personal firewall) may be resolved by doing so.

Network port created does not match printer IP address (Windows)
If the computer is running Windows, make sure that the network ports created in the printer driver match the 
printer's IP address.

1. Print the printer’s Network Configuration Page.

2. From Start > Set up, and then click Printers or Printers and Faxes. - or - From Start > Front Panel, and then 
double-click Printers.

3. Right-click the printer icon, click Properties, and then click the Ports tab.

4. Select the TCP/IP port for the printer, and then click Configure Port.

5. Compare the IP address listed in the dialog box and make sure it matches the IP address listed on the 
Network Configuration Page. If the IP addresses are different, change the IP address in the dialog box to 
match the address on the Network Configuration Page..

6. Click OK twice to save the settings and close the dialog boxes.
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Wireless network issues
The following steps should assist the user when confronted with issues regarding wireless network connectivity.

1. Make sure the wireless (802.11) light at the top left of the front panel is turned on .

If the blue light is not lit, the wireless capabilities may not have been turned on. Swipe down the dashboard 
and press , then scroll down the menu and press Network Set Up > Wireless Settings > On.

2. Make sure that an Ethernet cable has not been connected to the printer. Connecting an Ethernet cable turns 
off the printer's wireless capabilities.

3. Restart components of the wireless network.

Turn off the router and the printer, and then turn them back on in this order: the router first, and then the 
printer. Then run the Wireless Setup wizard in the front panel and select your network. If you still are unable 
to connect, turn off the router, printer, and computer. Sometimes, turning off the power and then turning it 
back on recovers a network communication issue.

4. Run the Wireless Network Test.

For wireless networking issues, run the Wireless Network Test. To print a Wireless Network Test page, scroll 
down the dashboard and press , then scroll down the menu and press Network Set Up > Print Reports > 
Wireless Test Report. If a problem is detected, the printed test report includes recommendations that could 
help to solve the problem.

5. If required, print the Network Configuration Page to check deep network status information.

NOTE: The wireless connection can be affected by the location of the network router and the device. In 
order to improve your wireless connection, consider the following additional steps:

6. If possible, try to position the wireless access point in a more central position of the office as shown in figure 
no 2 below. Try and place away from dense materials; metal, concrete, double thick walls are the hardest to 
penetrate, wood and plasterboard are easier. Consider these when positioning your printer.

7. Change the wireless channel to one that’s not being used preferably; 1, 6 or 11 as these are non 
overlapping channels.

8. Extend the range of the wireless network by using a simple wireless extender or adding more wireless 
access points as shown in figures 3 and 4 below.

Wireless Network Troubleshooting Report
This report consists of a top-level assessment of whether any wireless connection problems exist between the 
printer (STA) and the home network’s wireless router, followed by more detailed sections showing the result of 
various diagnostic tests as well as a configuration summary.
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1. Print the Wireless Network Troubleshooting Report (WNTR). From the front panel: Swipe down the 
dashboard and press , then scroll down the menu and press Network Set Up > Print Reports >.Wireless 
Test Report.

For more information about the contents of the Wireless Network Troubleshooting Report, see Error case 
table on page 469. There is only one situation that requires on-site repair: when the Wireless PCA is 
defective. To replace the Wireless PCA, you must replace the Main PCA; see Main PCA (5HB06-67018 & 
5HB08-67008) on page 329.

2. If you are not using a unique network name (SSID), then it is possible that the computer could be connected 
to the wrong network. See How to check whether your computer is connected to your network on page 
465.

Network Configuration Page
The network configuration page provides easy access to a range of significant information for the benefit of the 
user and call agents.

1. Make sure that the computer's wireless networking has been turned on. For more information, see the 
documentation that came with the computer.

2. Print the Network Configuration Page. From the front panel: press , then Internal Prints > User 
Information Prints > Network Configuration Page.

This contains important wireless configuration information at a glance. Detailed configuration and status 
information is also included, such as MAC address, wireless channel and signal strength, IP settings, 
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Ports/Services status, and a list of wireless networks in range of the printer. The Network Configuration 
Page contains important details for Wireless Direct including SSID name, IP address and security pass code.

Manual driver installation
If there are issues installing the drive with the installer provided, it is necessary to perform a manual set up.

Pre-installation
In order to perform a manual driver installation, several steps must first be taken.

1. Connect printer to the PC.

2. Unzip the driver package in the Config folder >Drivers:

● X64 folder for 64-bit OS [hpi51cax.inf]

● X86 folder for 32-bit OS [hpi51cah.inf]
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3. Open the Print Management Console (In the Start menu, type “printmanagement.msc” -> In the Print 
Management Console, go to Print Servers/Local):

Setting up the driver, port, and printing queue
In order to set up the driver for the printer, required are one driver, one port, and one printing queue.

1. Driver Set Up:

a. Select the drivers section and right click on a blank area.

b. Select Add Driver.

c. Follow the steps.

d. Select “Have Disk…”.

e. Browse to the location of the driver.

2. Port Set Up:

Select port section and right click on a blank area “Add Port…”
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3. Printer/Printing Queue Set Up:

Select port section and right click on a blank area “Add Printer…”
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Drivers Troubleshooting
When reporting a customer issue, it is very important to have the following information:

● Printer Model

● Operating system version (Client/Server?)

● Driver version

● Application causing problems and version

● Full list of driver settings used

● Killer plots

● PRN

Identifying the driver version
The driver version is obtained from “Print Management”.

1. Go to Print Management > Print Server > YOURCOMPUTERNAME (local) > Drivers

Drivers Troubleshooting 91



2. See the driver version in “Driver Version” column.

PRN File
The PRN is a file containing driver information generated before the spooler sends it to the printer.

1. From “Devices and Printers”, right-click on the printer and select “Printer properties” and then go to the 
“Ports” tab.

2. Click “Add Port”, select “Local Port” type and “New Port”, and enter the full path (including file name) where 
the PRN will be generated, for example:

● C:\Users\<username>\Desktop\issue.prn

After creating the new port, it will be assigned to the Printer Queue automatically.

NOTE: Every time the user prints to this printer, a PRN file will be generated with the driver’s job information.

Table 2-3 Driver features

Feature V3 (W7) - PCL3GUI V4 (W10) - PCL3GUI V4 Class Driver - 
PCL3GUI

MacOS- PCL3GUI

Document Size ( A4, A, ...) X X X X

Margins: STD, Oversize, Clip content by 
margins

X X X

Custom page size X X OS X

Paper Source: Tray, Roll, Manual feed X X X X
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Table 2-3 Driver features (continued)

Feature V3 (W7) - PCL3GUI V4 (W10) - PCL3GUI V4 Class Driver - 
PCL3GUI

MacOS- PCL3GUI

Paper Source: including Automatic when 
Automatic Roll Switch Support

X X X

Paper type: Actual media types, not 
Generics

X X X

Quality: Fast / Normal / Best X X X X

Economode X X X X

Max detail X X X

Resize: % , Fit to ... X X OS

Disable cutter X X X

Remove top/bottom blank areas X X X

Rotate 0, 90, 180, 270 degrees X X

Autorotate X X

Print on Color/Mono/Grayscale X X X

Max Application resolution X X X

Page order: Front to Back, Back to Front X X OS

Bi-directionality X X X

Copies X X X OS

Collate X X OS

Presets X X X

HP Print Preview X X X

Ink-supplies troubleshooting

Handling ink cartridges and printhead
There are 4 replaceble ink cartridges that supply the printhead. You can check status information, and easily 
change an ink cartridge when required.

About the ink cartridges
Ink cartridges store the ink and are connected to the printhead, which distributes the ink on the paper.

CAUTION: Observe precautions when handling ink cartridges because they are ESD-sensitive devices. Avoid 
touching pins, leads and circuitry.

Storage of anonymous usage information
Each ink cartridge contains a memory chip that assists in the operation of the printer.

The memory chip stores a limited set of anonymous information about the usage of the printer, which can 
include the following: the date when the cartridge was first installed, the date when the cartridge was last used, 
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the number of pages printed using the cartridge, the page coverage, the frequency of printing, the printing 
modes used, any printing errors that may have occurred, and the product model. This information helps HP to 
design future products to meet our customers' printing needs.

The data collected by the memory chip does not include information that could be used to identify a customer or 
user of the cartridge or printer.

HP collects a sample of the memory chips from ink cartridges returned to HP's free return and recycling program 
(HP Planet Partners: http://www.hp.com/recycle). The sampled memory chips are read and studied in order to 
improve future HP products.

HP partners who assist in recycling ink cartridges may also have access to the data. Any third party possessing 
the cartridge may be able to access the anonymous information on the memory chip. If you prefer to not allow 
access to this information, you can render the chip inoperable. However, after you render the memory chip 
inoperable, the cartridge cannot be used in an HP printer.

If you are concerned about providing this anonymous information, you can turn off the memory chip's ability to 
collect printer usage information. To do so, access the front panel and tap , then Preferences > Automatically 
send printer data, or access the Embedded Web Server, and click Settings > Preferences > Data Collection 
settings. This does not prevent the cartridge from working normally in other respects. However, if you change 
your mind later, you can restore the factory defaults to resume collecting printer usage information.

Check ink cartridge status
Information about the evolution of the ink cartridges.

To view the ink levels of your ink cartridges, swipe down the dashboard and tap  on the front panel. For 

more information, tap the specific cartridge.

● You can also get this information from the HP Utility (Windows only). Go to the Supplies tab to see each 
cartridge's status.

● In the EWS go to Home > Estimated Cartridges Levels or Tools > Supply Status.

Ink cartridge status messages
There are ink cartridge status messages to alert you to an issue.

● OK: The cartridge is working normally, with no known problems.

● Missing or Damaged: There is no cartridge present, or it is not correctly connected to the printer (shown with 
an X on the status screen).

● Low: The ink level is low.

● Out of ink: The cartridge is empty.

● Not genuine HP: The cartridge is not a genuine HP cartridge.

● Wrong slot: The cartridge has been inserted into the wrong slot.

● Incompatible: The cartridge is incompatible with this printer.

Replace an ink cartridge
There are two occasions when you need to replace an ink cartridge.
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● The ink cartridge is very low and you want to replace it with a full cartridge for unattended printing (you can 
use up the remaining ink in the first cartridge at a more convenient time).

● The ink cartridge is empty or faulty, and you must replace it to continue printing.

CAUTION: Do not try to remove an ink cartridge while printing.

CAUTION: Remove an ink cartridge only if you are ready to insert another one.

NOTE: When a cartridge runs out of ink, the current job is cancelled.

1. Make sure the printer is turned on.

2. If your printer is on a stand, make sure the printer wheels are locked (the brake lever is pressed down) to 
prevent the printer from moving.

3. Open the window.

4. Press the ink cartridge to unlock it.

5. Remove the ink cartridge.
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6. Insert the new ink cartridge. Make sure that you insert the ink cartridge into the slot that has the same 
colored letter as the cartridge you are installing.

7. Close the window.

About the printhead
The printhead, which is supplied installed in the printer, is connected to the ink cartridges and jets ink onto the 
paper.

CAUTION: Observe precautions when handling the printhead, because it is an ESD-sensitive device. Avoid 
touching pins, leads, and circuitry.

For information on replacing printheads, see the chapter "Replace the printhead" in the User Guide.

Solving ink-supply problems
Most of the problems that you may encounter when working with the ink supplies are solved with guidance from 
the Front Panel. A full list of Front Panel messages is supplied in the user's guide.

You cannot insert the Ink Cartridge
If an Ink Cartridge refuses to be inserted into the carriage, perform the following checks.

1. Check that you have the correct HP no.713 printhead.

2. Check that the colored label on the cartridge is the same color as the label on the slot.

3. Check that the cartridge is correctly oriented, with the letter or letters marking the cartridge label right-side 
up and readable.

CAUTION:
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You cannot insert the printhead
If a printhead refuses to be inserted into the carriage, perform the following checks.

1. Ensure that you have the correct HP no. 713 Printhead.

2. Ensure that the Printhead is in the correct orientation.

3. Check that you have correctly latched the Printhead.

The Front Panel says to reset or replace a printhead
Perform the following steps if you encounter this situation.

1. From the Front Panel, turn the power off then on.

2. Check the Front Panel display message, if it shows the ready message, the printer is ready to print. If the 
problem remains continue with the next step.

3. Remove the printhead using the correct procedure. It is important that the ink cartridges are removed 
before removing the printhead, this is in order to avoid damaging the printhead or contaminating the 
Carriage contacts with ink.

4. Clean the electrical connections on the backside of the printhead with a lint-free cloth. You can carefully use 
distilled water if moisture is needed to remove residue. Do not use water.

This is a delicate process and may damage the printhead. Do not touch the nozzles on the bottom side of 
the printhead, especially not with alcohol.

5. Reinsert the printhead.

6. Check the Front Panel display message. If the problem remains, try a new printhead.

Ink system hardware troubleshooting
There are four hardware elements which could impact ink delivery in the event of a failure. Identifying the correct 
one is essential to efficient troubleshooting.

A potential ink system hardware failure can be reported to the user in the following way:

The printer is unable to determine whether the error is caused by a real hardware failure or which part may be 
failing (possible candidates: ink cartridges, Prime Pump, Carriage Assembly, Trailing Cable).

Follow these steps to check which parts to repair to solve the problem:
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1. Perhaps the printer will recover automatically. Restart the printer and print a test page such as the 
print-quality diagnostic report (see General print-quality troubleshooting on page 103). If the error persists, 
proceed to the next step.

2. Restart the printer. When the printer is ready, start a printhead replacement (see the chapter "Replace the 
printhead" in the User Guide) and follow the first two steps shown on the Front Panel to remove the ink 
cartridges and the printhead.

3. Inspect both the ink cartridges and the Carriage, looking for evidence of ink leaks. If you find none, move to 
step 5. If an ink cartridge is leaking, please order new ones for the customer and do the following:

a. Clean the electrical contacts in the Carriage slot inside the printer with a clean, dry, soft, lint-free cloth; 
slide the cloth up and down vertically.

b. Put the printhead back into the Carriage.

c. Insert a set of non-leaky ink cartridges.

d. Print a test page.

4. If there are no ink leaks, replace the Carriage Assembly (see Carriage Assembly with Belt and Trailing Cable 
(5HB06-67001 & 5HB10-67001) on page 380).

Printhead troubleshooting
A printhead hardware failure can be reported to the user in the following ways.

A. The printhead appears to be missing, not detected, or incorrectly installed
Perform the following action in the event of encountering this issue.

▲ Press the “Show me…” button appearing on the screen to launch the replacement/reseat wizard process.

B. System error 0027:XXXX is displayed
Perform the following process in the event of encountering this situation.

▲ Turn the printer off. See System Error 0027-00XX on page 57.

C. There is a problem with the printer or ink system
The printer is unable to determine whether the error is caused by a real hardware failure and which might be the 
failing part.

Possible candidates: Printhead, Carriage Board, Trailing Cable.

1. Turn the printer off and on again.

2. Wait until the Carriage stops moving, then open the ink cartridge cover.

3. After hearing the audio alert, remove the ink cartridges. See Replace an ink cartridge on page 94.

4. Clean the electrical contacts in the Carriage slot inside the printer with a clean, dry, soft, and lint-free cloth; 
ensure that this is done by sliding the cloth vertically.

5. Reinsert the printhead assembly (ensure that the Carriage Lifter is properly lowered once the assembly has 
been reinserted).

6. Move the Carriage to a position on the platen where you can access the printhead.
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7. Replace / Reseat the printhead (ensure that the Carriage Lifter is lowered once the printhead assembly has 
been reinserted).

8. Restart the printer.

9. Re-insert the supplies when prompted by the front panel. The printer should show a “missing cartridges” 
message.

10. If the problem persists, the printhead must be replaced (a printhead replacement kit must be provided to 
the user).

11. If the problem persists, the Carriage assembly must be replaced. See Belt and Pulley (CQ890-67112 & 
F9A30-67068) on page 374.

Printhead troubleshooting flowchart
Follow this troubleshooting flowchart when encountering issues with the printhead.
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Not enough ink message issue procedure
This section outlines the procedure to follow if, during a new printhead installation, the message "Printhead 
Startup Failure. Not enough ink to complete startup" appears.

This issue can be solved without the use of additional parts or an onsite visit with the new service Reset to force 
printhead initialization found in firmware version AXP2CN1249BR.

Conditions to use the reset

There are two conditions in which the reset can be employed.

● Printer shows Printhead Startup Failure. Not enough ink to complete startup message.
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IMPORTANT: Do not use in other circumstances.

● Printer firmware version is AXP2CN1249BR or newer. If the printer has an older firmware version, reset is 
unavailable. In case the printer is still in the OOBE phase, a special firmware upgrade procedure is required 
(see following information).

NOTE: To check the firmware version, press the Power button for 15 seconds, and access the Support 
Menu (1. Information > 1.3 Firmware Version).

Performing the reset

Customers can perform all these steps themselves.

1. Printer shows Printhead startup failure. Not enough ink to complete startup.

2. Remotely guide the customer to enter into the support menu by pressing the Home button for 15 seconds.

3. Access 3.5 Reset PHA Startup Condition.

4. Type 'PIN' number 2873, and select OK.

5. Ask the customer to check the Front Panel message after pressing OK. Either success or fail will appear, and 
the printer will automatically reboot.

NOTE: If success appears, the printer will beep. If fail appears, no beep will occur.

6. If success appears, and the printer continues with the initialization steps, the issue is fixed. If success 
appears but the printer shows another ink system failure; ask the customer for the message, and escalate 
the case to GCC for further instructions.

7. If fail appears, the cartridges are low on ink (less than 80% on each color). This fails to prevent printhead 
damage. Ask the customer to add new ink cartridges.

8. Perform a pump test.

9. If the test fails, send onsite engineer with PHA kit, bundle board, and pump motor. Replace the pump motor, 
and then run the pump test. If the test fails again, replace the bundle board and perform pump test. If 
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test passes, perform PHA reset. Restart printer. Initialize PH replacement, and remove printhead and ink 
cartridges from the printer.

10. Restart the printer. When the printer prompts for new ink cartridges and printhead, without pressing 
anything on touch panel, install new Printhead and ink cartridge, check.

Special firmware firmware upgrade procedure, only during OOBE phase

As the printer IP is not shown in the front panel, perform the following steps.

1. Connect the printer via LAN or USB.

2. Execute the driver installer. The installer searches the printer connected to the network or USB. The printer 
installs.

3. Download the latest printer firmware version from hp.com.

4. Download and install the HP DesignJet Utility (Windows OS) & HP Utility (Mac). When installed, use this 
application to upgrade the printer firmware to the latest version.

Safe Stop: printer behavior in the face of a Continuous Ink System
All DesignJet printers include this feature to detect when unsupported supply systems are used in the unit.

The printer expects an ink supply with finite volume. After an expected ink volume is extracted from the supply, 
an Out of Ink event must happen. If this event does not happen, the printer evaluates that the customer is using a 
continuous ink system.

If customers are using a continuous ink system, the printer will show the following message:

There are comments included in the User guide to inform the customer about this unsupported operation:

● The printer is not designed to use continuous ink systems. To resume printing, remove continuous ink system 
and install genuine HP (or compatible) cartridges.

● This printer is designed for ink cartridges to be used until they are empty. Refilling cartridges prior to depletion 
might cause your printer to fail. If this happens, insert a new cartridge (either genuine HP or compatible) to 
continue printing.
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There is also a clause in the warranty statement where this is clearly stated:

● 5. HP’s limited warranty is void in the event the printer is attached to an aftermarket apparatus or system that 
modifies the printer’s functionality such as a continuous ink system.

In the event the customer is using a continuous ink system:

● Do not replace cartridges under warranty. (Instruct customer to replace the incompatible cartridges with HP 
or compatible cartridges.)

● Do not replace or repair the printer under warranty!

● This error can also occur when customers refill supplies, never allowing them to become depleted.

The following messages are proposals of communication from Call Agent to Customer:

● "This printer is not designed to use continuous ink systems. To resume printing, remove continuous ink 
system and install genuine HP (or compatible) cartridges."

● "This printer is designed for ink cartridges to be used until they are empty. Refilling cartridges prior to 
depletion might cause your printer to fail. If this happens, insert a new cartridge (either genuine HP or 
compatible) to continue printing."

● "HP’s limited warranty is void in the event the printer is attached to an aftermarket apparatus or system that 
modifies the printer’s functionality such as a continuous ink system."

Print-quality troubleshooting

General print-quality troubleshooting
These procedures should help with streaked or faded prints, prints without black or other colors, prints with 
blurred or fuzzy text, prints with ink streaks or smears, and many other problems.

Try the following solutions in the order presented in order to resolve the common issues described above. When 
one of the solutions resolves the issue, there is no need to continue troubleshooting.

Use genuine HP ink cartridges
Utilizing a trustworthy source of ink is essential to ensuring the best quality output, and minimizing the 
possibility of compromising future printer performance.

▲ HP recommends that you use genuine HP ink cartridges. HP cannot guarantee the quality or reliability of 
non-HP cartridges. If you are not using genuine HP ink cartridges, the following solutions might not resolve 
your print-quality issue. 

Check the paper
Not all types of paper can be used effectively on the same job.

▲ Make sure that the paper is appropriate for the print job.

Check the print settings
The location of the Print settings option differs between Windows and Mac OS systems.
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▲ Windows: Open the Windows driver and go to the Basic section. Adjust Print Quality, Document Size, and 
Margins-Layout.

Mac OS: Open the Mac OS Print dialog and go to the Paper/Quality tab. Adjust Quality Options, Paper Size, 
Format, and Margins/Layout.

Print and evaluate a print-quality diagnostic report and troubleshoot defects
In addition to describing the print-quality diagnostic report process, see also advised actions to resolve any 
discovered issues.

NOTE: Never use demo plots to check image quality as they are optimized for settings that may not match the 
customer’s scenario.

Use the following procedure to print, and then evaluate a print-quality diagnostic report.

1. Print a print-quality diagnostic page.

a. Make sure there is plain white loaded in the printer. 

b. Swipe down the dashboard and press , then scroll down the menu and press Reports >.Print Quality 
Report. The print-quality diagnostic page prints.

2. If the lines in Test Pattern 1 are not straight and connected, follow these steps to align the printer:

a. Make sure there is plain white paper loaded in the printer.

b. Swipe down the dashboard and press , then scroll down the menu and press Printer Maintenance 
>.Align Printhead. The printhead alignment procedure will begin.

c. At the end of the process a page prints, which may be discarded. 

104 Chapter 2  Troubleshooting



3. Examine the Test Pattern 2. Shown here is a good example of the test pattern.

If any of the colored blocks in Test Pattern 2 show white lines, or are faded or missing completely, follow 
these steps to clean the printhead.

a. Make sure there is plain white paper loaded in the printer.

b. Swipe down the dashboard and press , then scroll down the menu and press Printer Maintenance 
>.Clean Printhead. The printhead cleaning process will begin.

c. At the end of the process a page prints. Examine that page to see if more cleaning is required. 
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d. If there are defects on the page that prints after cleaning, try cleaning the printhead by pressing the 
Yes button on the Front Panel for second level cleaning. Repeat the cleaning for the third level cleaning 
if it is still not resolved.

e. If the problem is still not resolved after third-level cleaning, proceed to the next step (check print 
quality), before replacing the printhead.

NOTE:  To avoid problems that require printhead cleaning, always use the Power button to turn the 
printer off. Always replace any missing cartridges as soon as possible to avoid print-quality issues and 
possible extra ink usage or damage to the ink system. Never turn off the printer when the ink 
cartridges are missing.

Check print quality

If you see no defects on the print-quality report, you can double-check the print quality with the Diagnostic 
Image.

a. Make sure there is plain white paper loaded in the printer.
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b. Press four times on the Back Key. The Support Menu will appear. Go to Reports > Agents Assisted 
Image Test.

If the Agent Assisted Images both look OK, then the print mechanism and ink supplies are working 
correctly. Ask the customer to use a higher quality print mode.

Print-quality defects
Within this section, a variety of print-quality defects are described alongside recommended actions for resolving 
them.

Horizontal lines across the image (banding)
Providing solutions for if printed images suffer from added horizontal lines as shown (the color may vary).
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1. Check that the paper type loaded corresponds to the paper type selected in the front panel and in the 
software.

2. Check that the customer is using appropriate print-quality settings for the purpose. In some cases, you can 
overcome a print-quality problem merely by selecting a higher print-quality level. For instance, if you have 
set the Print Quality setting to Fast, try setting it to Best.

3. Print the print-quality report. See General print-quality troubleshooting on page 103.

4. If the printhead is working correctly, perform paper advance calibration, see the user's guide.

If the problem persists despite all the above actions, contact your customer service representative for further 
support.

Lines are too thick, too thin or missing
Providing solutions for if lines are too thick, too thin or missing when printed.

1. Check that the paper type you have loaded corresponds to the paper type selected in the front panel and in 
your software.

2. Check that you are using appropriate print-quality settings for your purposes. Try turning on the Maximum 
detail option (if available).
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3. If the resolution of your image is greater than the printing resolution, you may notice a loss of line quality. 
You can find the Max. Application Resolution option in the driver preferences dialog.

4. If lines are too thin or missing, print the print-quality report. See General print-quality troubleshooting on 
page 103.

5. If the problem remains, align the printhead. See the chapter "Align the printhead" in the User Guide.

6. If the problem remains, perform paper advance calibration, see the user's guide.

If the problem persists despite all the above actions, contact your customer service representative for further 
support.

Lines appear stepped or jagged
Providing solutions for if lines in your image appear stepped or jagged when printed.

1. The problem may be inherent in the image. Try to improve the image with the application you are using to 
edit it.

2. Check that you are using appropriate print-quality settings, see the user's guide.

3. Turn on the Maximum detail option in the driver (if available).

Lines print double or in the wrong colors
This problem can have various visible symptoms, including color seperation and irregular or inaccurate lines.

● Colored lines are printed double, in different colors.

● The borders of colored blocks are wrongly colored.
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To correct this kind of problem, align the printhead. See the chapter "Align the printhead" in the User Guide.

Lines are discontinuous
Line discontinuity implies that unwanted gaps appear in what is intended to be a single unbroken element of the 
printed output.

If your lines are broken in the following way:

1. Check that you are using appropriate print-quality settings, see the user's guide.

2. Align the printhead. See the chapter "Align the printhead" in the User Guide.

Lines are blurred
Humidity can cause ink to soak into the paper, making the lines blurred and fuzzy.

Try the following solutions:
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1. Check that your environmental conditions (temperature, humidity) are suitable for high-quality printing.

2. Check that the paper type selected in the front panel is the same as the paper type you are using.

3. Try changing to a heavier paper type, such as HP Heavyweight Coated Paper.

4. Select a paper type that is slightly thinner than the paper you have loaded; this will persuade the printer to 
use less ink. Here are some example paper types in ascending order of thickness: Plain Paper, Coated Paper, 
Heavyweight Coated Paper.

5. If you are using glossy paper, try changing to a different type of glossy paper.

6. Align the printhead. See the chapter "Align the printhead" in the User Guide.

Line lengths are inaccurate
If you have measured your printed lines and find that the lengths are not sufficiently accurate for your purposes, 
there are potential solutions to this issue.

Attempt the following to improve line length accuracy:

1. Print on HP Matte Film, for which your printer's line length accuracy is specified.

Polyester film is about ten times more dimensionally stable than paper. However, using film that is thinner 
or thicker than HP Matte Film will reduce line length accuracy.

2. Set the Print Quality to Best.

3. Maintain the room at a steady temperature between 10 and 30°C (50 and 86°F).

4. Load the roll of film and let it rest for five minutes before printing.

5. If you are still not satisfied, try recalibrating the paper advance.

The whole image is blurry or grainy
There are potential solutions available in the event that the printed image suffers from overall quality issues.
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1. Check that the paper type you have loaded corresponds to the paper type selected in the front panel and in 
your software. 

2. Check that you are printing on the correct side of the paper.

3. Check that you are using appropriate print-quality settings. In some cases, you can overcome a print-quality 
problem merely by selecting a higher print-quality level. For instance, if you have set the Print Quality slider 
to Fast, try using Best.

4. If the problem remains, align the printhead. See the chapter "Align the printhead" in the User Guide.

5. If the problem remains, perform paper advance calibration.

If the problem persists despite all the above actions, contact your customer service representative for further 
support.

The paper is not flat
If the paper does not lie flat when it comes out of the printer, but has shallow waves in it, you are likely to see 
defects in the printed image, such as vertical stripes.

This can happen when you use thin paper that becomes saturated with ink.
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1. Check that the paper type you have loaded corresponds to the paper type selected in the front panel and in 
your software.

2. Try changing to a thicker paper type, such as HP Heavyweight Coated Paper.

3. Select a paper type that is slightly thinner than the paper you have loaded; this will persuade the printer to 
use less ink. Here are some example paper types in ascending order of thickness: Plain Paper, Coated Paper, 
Heavyweight Coated Paper.

The print is scuffed or scratched
The black ink pigment can be scuffed or scratched when touched by a finger, a pen or some other object. This is 
particularly noticeable on coated paper.

Glossy paper may be extremely sensitive to the basket or to anything else that it contacts soon after printing, 
depending on the amount of ink used and the environmental conditions at the time of printing.

To reduce the risk of scuffs and scratches:

● Handle prints carefully.

● Avoid stacking prints on top of each other.

● Catch your prints as they are cut from the roll and do not let them fall into the basket. Alternatively, leave a 
sheet of paper in the basket so that freshly printed sheets do not make direct contact with the basket.

● Increase the drying time. At the front panel, press , then Print Settings > Drying time > Extended.

Ink marks on the paper
This problem can occur for several different reasons.

Horizontal smears on the front of coated paper

If a lot of ink is used on plain or coated paper, the paper absorbs the ink quickly and expands. As the printhead 
moves over the paper, the printhead may come into contact with the paper and smear the printed image.

This problem is normally seen only on cut sheets of paper (not on roll paper).
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Whenever you notice this problem, cancel the printing job immediately. Press  and also cancel the job from 
your computer application. Soaked paper can damage the printhead.

Try the following suggestions to avoid this problem:

1. Check that the paper type you have loaded corresponds to the paper type selected in the front panel and in 
your software. 

2. If using sheet paper, try rotating the sheet 90 degrees. The orientation of the paper fibers may affect 
performance.

3. Try changing to a thicker paper type, such as HP Heavyweight Coated Paper.

4. Select a paper type that is slightly thinner than the paper you have loaded; this will persuade the printer to 
use less ink. Here are some example paper types in ascending order of thickness: Plain Paper, Coated Paper, 
Heavyweight Coated Paper.

5. Try to increase the margins by relocating the image to the center of the page using your software 
application.

Ink marks on the back of the paper

Clean the platen with a soft cloth. Clean each rib separately.

Black ink comes off when you touch the print
This problem may be caused by printing with matte black ink on glossy paper. The printer will not use matte 
black ink if it knows that the paper will not retain it. To be sure of avoiding matte black ink, you can select Photo 
Glossy Paper as the paper type (in the Photo Paper category).

Edges of objects are stepped or not sharp
This issue is when the edges of objects, or lines in general, appear to be poorly defined or lighter in density.

114 Chapter 2  Troubleshooting



If you have already set the print-quality in the driver dialog, select the custom print-quality options, and try 
setting the quality level to Normal.

Edges of objects are darker than expected
Unwanted edge darkness can be encountered even when settings have been selected to give preferrence to 
output quality over speed.

If edges of objects seem darker than expected, and you have already set the print-quality in the driver dialog, 
select Fast quality.

Vertical lines of different colors
There are a number of potential solutions available if your print shows vertical bands of different colors.

Try the following:

1. Use thicker paper, choosing from the recommended paper types such as HP Heavyweight Coated Paper.

2. Use higher print-quality settings. For instance, if you have set the Print Quality slider to Fast, try setting it to 
Best.

White spots on the print
White spots on the print are probably due to paper fibers, dust, or loose coating material.

To avoid this problem:

1. Try cleaning the paper manually with a brush before printing, to remove any loose fibers or particles.

2. Always keep the cover of your printer closed.

3. Protect your paper rolls and sheets by storing them in bags or boxes.
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Colors are inaccurate
If the colors of your print do not match your expectations, there are a number of potential solutions available.

Try the following:

1. Check that the paper type you have loaded corresponds to the paper type selected.

2. Check that you are printing on the correct side of the paper.

3. Check that you are using appropriate print-quality settings. For the most accurate colors, select Best 
quality.

4. Print the print-quality report. See General print-quality troubleshooting on page 103.

Colors are fading
If you print on instant-dry photo paper, your prints will fade rapidly. If you plan to display the prints for more than 
two weeks, you should laminate them to achieve longer life.

Prints on swellable coated papers will fade much less rapidly. However, lamination will increase the life of prints 
(depending on the type of lamination) with all paper types. For more information, consult your laminate provider.

The image is incomplete (clipped at the bottom)
There are a number of alternative explanations for the production of an incomplete image. Investigate the 
following possibilities and actions for remedying the situation.

● Did you press  before all the data was received by the printer? If so, you have interrupted the data 
transmission and will have to print the page again.

● There may be a communications problem between your computer and the printer. Check your USB or 
network cable, or your Wi-Fi connection.

● Check to make sure that your software settings are correct for your current page size (for example, long-axis 
prints).

● If you are using network software, make sure it has not timed out.
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The image is clipped
Clipping normally indicates a discrepancy between the actual printable area on the loaded paper and the 
printable area as understood by your software.

● Check the actual printable area for the paper size you have loaded.

printable area = paper size – margins

● Check what your software understands to be the printable area (which it may call "printing area" or 
"imageable area"). For example, some software applications assume standard printable areas that are larger 
than those used in this printer.

● If you have defined a custom page size with very narrow margins, the printer may impose its own minimal 
margins, clipping your image slightly. You may want to consider using a larger paper size.

● If your image contains its own margins, you may be able to print it successfully by using the Clip Contents by 
Margins option.

● If you are trying to print a very long image on a roll, check that your software is capable of printing an image 
of that size.

● You may have asked to rotate the page from portrait to landscape on a paper size that is not wide enough.

● If necessary, reduce the size of the image or document in your software application, so it fits between the 
margins.

If you try to print an image larger than this from these applications, the bottom of the image may be clipped. To 
print the whole image, try these suggestions:

● The driver dialog includes an option called Max. application resolution, which enables you to print 
successfully in this situation. You will not normally need to change the default setting, which is Auto. 
However, you can find the option in the preferences dialog.

● Save the file in another format, such as TIFF or EPS, and open it with another application.

● Use a RIP to print the file.

Some objects are missing from the printed image
Large quantities of data may be necessary to print a large-format print job, and in some specific workflows there 
may be an issue that can lead to some objects missing from the printed image.

Issue

Some objects are missing from the printed image.

NOTE: Print jobs which might be affected are files containing complex objects such as objects with multiple 
layers, objects with gradients or/and the file size is relatively big in most of case. Usually this kind complex job is 
made by CAD applications (For example AutoCAD).

Solutions

1. Update the printer’s firmware to the latest version. It can be downloaded and installed from hp.com.

2. Use the latest driver. It can be downloaded and installed from hp.com.
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▲ Select Max. Application resolution: 300.

3. Select a smaller page size and enlarge it to the desired final page size in the driver or in the front panel. 

4. Reduce the resolution of bitmap images in your application software.

5. Select a lower print quality in order to reduce the resolution of the printed image.

6. Update the application software to the latest version.

7. If the source file is a PDF:

a. Regenerate the PDF file: Open the PDF file with the printing application, then save it again as PDF 
format. This could reduce the file complexity. 

b. Use an alternative PDF reader to discard application issues.

8. Save the file in another format, such as TIFF or PDF, and print it from another application.

9. Try another software to print the file.

10. Use a RIP to print the file.

NOTE: If you are working under Mac OS, not all of these options are available.

Some options may adversely affect the final output quality or the time necessary to generate the print job. 
Therefore, they should be cancelled if they do not help to solve the problem.

Links to download firmware and drivers

● HP DesignJet T600 Printer series: https://www.hp.com/go/HP-DesignJet-T600-Printer-series/firmware
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● HP DesignJet T200 Printer series: https://www.hp.com/go/HP-DesignJet-T200-Printer-series/firmware

● HP DesignJet Studio Printer series: https://www.hp.com/go/HP-DesgnJet-Studio-Printer-series/firmware

A PDF file is clipped or objects are missing
In older versions of Adobe Acrobat or Adobe Reader, large PDF files could be clipped or lose some objects when 
printing with the driver at high resolution.

In order to avoid such problems, upgrade your Adobe Acrobat or Adobe Reader software to the latest version. 
From version DC onwards, these problems should be solved.

Print mode summary table
The following table details information about media families which can be viewed in the Front Panel.

Table 2-4 Simplified PM Chart 1.1

Media Family in Front 
Panel

Bond and Coated Paper Bond and Coated Paper & 
Adhesive Paper

Bond and Coated Paper Bond and Coated Paper

Media type in the Front 
Panel

Plain Paper

HP Bright White Inkjet 
Paper

HP Universal Bond Paper

Coated Paper

HP Coated Paper

HP Universal Coated 
Paper

Ahesive Paper

HP Universal Adhesive 
Vinyl

Heavyweight Coated 
Paper

HP Heavyweight Coated 
Paper

HP Universal 
Heavyweight Coated 
Paper

Plain Paper for Graphics

fast

(-2)

1p bidi

30ips

1p L2R

30ips, 40ips retrace

N/A 1p L2R

30ips, 40ips retrace

econo fast

(-1)

1p bidi

40ips

1p L2R

30ips, 40ips retrace

N/A 1p bidi

40ips

normal

(0)

K/C: 1p/2pNUA

30ips

4p bidi

30ips

6p bidi

30ips

4p L2R

30ips, 40ips retrace

best

(+1)

6p L2R

30ips, 40ips retrace

6p L2R

30ips, 40ips retrace

8p L2R

20ips, 40ips retrace

6p L2R

30ips, 40ips retrace

max dpi

(+2)

N/A N/A N/A N/A

Table 2-5 Simplified PM Chart 1.2

Media Family in Front Panel Technical Paper Photo Paper & Adhesive Paper Film

Media type in the Front Panel HP Natural Tracing Paper

Natural Tracing Paper Rubber 
Resistant

Natural Tracing Paper < 65gr

Photo Gloss Paper

Photo Semi-Gloss/Satin Paper

Polypropylene Satin

HP Universal Gloss Photo Paper

Transparent/Clear Film

Matte Film

HP Clear Film

HP Matte Film

A PDF file is clipped or objects are missing 119

https://www.hp.com/go/HP-DesignJet-T200-Printer-series/firmware
https://www.hp.com/go/HP-DesgnJet-Studio-Printer-series/firmware


Table 2-5 Simplified PM Chart 1.2 (continued)

Media Family in Front Panel Technical Paper Photo Paper & Adhesive Paper Film

Natural Tracing Paper > 65gr HP Universal Saatin Photo Paper

HP Universal Instant-dry Gloss 
Photo Paper

HP Universal Instant-dry Satin 
Photo Paper

Adhesive Polipropylene Gloss

HP Everyday Adhesive Gloss 
Polypropylene

Specal Clear Film High KOD

fast

(-2)

1p bidi

30ips

N/A 1p bidi

30ips

econo fast

(-1)

1p bidi

30ips

N/A 1p bidi

30ips

normal

(0)

K/C: 1p/2pNUA

30ips

8p bidi

20ips

K/C: 1p/2pNUA

30ips

best

(+1)

4p L2R

30ips, 40ips retrace

10p L2R

20ips, 40ips retrace

4p L2R

30ips, 40ips retrace

max dpi

(+2)

N/A 12p L2R

18ips, 40ips retrace

N/A

Firmware Update
There are various ways to download and install firmware updates. Choose the one you find most convenient.

NOTE: A firmware update package can be large; you may want to consider whether there are any implications 
for your network or Internet connection.

● Using the front panel, tap , then Printer Maintenance ► Update the Printer ► Check Now to check 
whether new firmware is available. If new firmware is available, you are given the opportunity to download 
and install it.

● Using the Embedded Web Server, click Tools ► Printer Updates ► Firmware Updates ► Check Now.

● Using the HP DesignJet Utility under Windows, select your printer, the Support tab, then Firmware Update. 
Follow the instructions on the screen.
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The printer restarts to finish the firmware upgrade, and the printer status report is printed.

Check that the firmware version is the latest from the front panel:

NOTE: The firmware includes a set of the most commonly used paper presets.
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Support Menus, Diagnostic Plots & Calibrations3

This chapter provides a detailed exploration of the Support Menu and the Extended Support Menu, as well as 
examples of the diagnostic plots that can be printed for calibration purposes.

Support menus
All the service options and utilities under the Support Menu are available to customers under the assistance of an 
HP call agent.

Entering the support menus
There are two different menus: the Support Menu, for use by customers, and the Service Menu, which is 
accessible only by service engineers.

The Support Menu is for customers following instructions by phone assisted by a call agent in order to 
troubleshoot an issue, and/or to access printer information when a customer has contacted HP for assistance. 
The Service Menu is used by service engineers for troubleshooting, diagnosis during repair, calibrations, reset, 
and accessing printer information during a service operation.

Entering the Support Menu for customers
Use the following procedure to enter into the Support menu.

1. The Support Menu for the customer is accessible from the Home screen by pressing: Back  / Back  /
Back  / Back . The Support Menu is sometimes also accessible from other screens (for example, from 
a System Error screen). This menu may not be accessible from inside certain workflows (for example, while 
clearing a paper jam) or if the printer hangs-up.

2. The following screen will display, select Support Menu.
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3. The following screen will display: 

4. Navigate through the menu using the Up ( ) and Down ( ) arrows in the Front Panel display.

5. To go back to the previous level, use the Cancel ( ) key.

Entering the Service Menu for service engineers
Use the following procedure to enter into the service engineer's Service Menu:

1. The Service menu is only for use by the service engineer, and is accessible from the Home screen pressing 
home button for 15 seconds.
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2. The Service menu can also be accessed by pressing Home / Back  / Home / Home and selecting the 
option Service menu in the list that appears.

3. The Service Menu is sometimes also accessible from other screens (for example, from a System Error 
screen). This menu may not be accessible from inside certain workflows (for example, while clearing a paper 
jam) or if the printer hangs-up.

Support and Service menu trees
Here you will find a complete list of the Support and Service menu options.

Support menu
The following tables present the sub-menu options of the Support menu.

Table 3-1 Information Menu

Model number

Serial number

Region/Language

Counters

Firmware version

Assert history

Printer region

Pen supply region

Pen supply serial number (SN)

Pen supply level of ink (LOI)

Relocks remaining

Relock attempts remaining

Gather/Scramble Scheme

Check sum for Relock Data

NHO

IRO
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Table 3-1 Information Menu (continued)

Wireless region

SS

Table 3-2 Reset Menu

Country/Language reset

Partial reset

Semi-full reset

OOBE reset

Table 3-3 Systems Configuration Menu

Set boot mode to user mode

Table 3-4 Service Test

Test Carriage

Test Service Station

Test Keys

Test LEDs

Test Display

Printhead rec level 1

Printhead rec level 2

Printhead rec level 3

PHA/IDS Diagnostics

Ink Supplies Report

Nozzle test

Paper Servo

Line Sensor (Zim/Spot)

RTC battery status

Rewinder motor

ARSS Test

Table 3-5 Connectivity Diagnostic Menu

Connectivity Report

Wireless Diagnostic Test

Print Wireless Metrics
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Table 3-6 Reports Menu

Printer Status Report

Extended Self Test

Print Quality Report

Print-mech Button Tap

Network Security Page

Counter Report

Error history

Agent assisted image test

Service menu
The following tables present the sub-menu options of the Service menu.

Table 3-7 System Configuration Menu

Enter Ethernet MAC Address

Enter Wireless MAC Address

Table 3-8 Resets Menu

Country & Language Reset

Partial Reset

Semi-full Reset

OOBe reset

PMK 1

PMK 2

Linefeed Mfg Calibration

RTC Battery expired

Table 3-9 Service Test

Test Carriage

Test Service Station

Test Keys

Test LEDs

Test Display

Test Sensors

Cont_print_pick

Infinite H`s Test
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Table 3-9 Service Test (continued)

Infinite Color H`s Test

Printhead rec level 1

Printhead rec level 2

Printhead rec level 3

PHA/IDS Diagnostics

Ink Supplies Report

Nozzle test

ByPass Pen Alignment

Paper Servo

Line Sensor (Zim/Spot)

RTC battery status

Rewinder motor

ARSS Test

Table 3-10 Special/Service/Support Reports

Printer Status Report

Extended Self-test

Print Quality Report

Network Security Page

Counter

Print-Mech Button Tap

Error History

Agent Assisted Image Test

Service Menu
This section contains a detailed breakdown of the Service Menu options.

System Configuration
This menu contains items to set up the ethernet and wireless MAC address.

Enter Ethernet MAC Address
This item lets you modify the Printer's Ethernet MAC Address through the main button: [top, low, left, and right 
keys].

Once you modify it, the number will be changed regardless of whether you cancel or continue.
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NOTE: Use this item when the Ethernet MAC address is lost, or when you see every digit is set to zero.

TIP: If the MAC address was not set, navigate to Setup > Network Setup > Restore Network Settings to set the 
MAC address to default.

The diagnostic allows you to write 12 digits. You do not need to write any dots ( . ) or dashes ( - ), only letters or 
numbers. In order to set-up the new MAC Address, use the top, bottom, left, and right keys.

Here is an example of an Ethernet MAC Address: B8-BB-DA-BA-DB-AD

To correctly enter this address, you would input: B8BBDABADBAD

Once you finish, press the OK button and you will see the screen below:
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Enter Wireless MAC Address
This item lets you modify the Printer's Wireless MAC Address through the main button: [top, low, left, and right 
keys].

Once you modify it, the number will be changed regardless of whether you cancel or continue.

NOTE: Use this item when the Wireless MAC address is lost, or when you see every digit is set to zero.

TIP: If the MAC address was not set, navigate to Setup > Network Setup > Restore Network Settings to set the 
MAC address to default.

The diagnostic allows you to write 12 digits. You do not need to write any dots ( . ) or dashes ( - ), only letters or 
numbers. In order to set-up the new MAC Address, use the top, bottom, left, and right keys.

Here is an example of an Ethernet MAC Address: B8-BB-DA-BA-DB-AD

To correctly enter this address, you would input: B8BBDABADBAD

Once you finish, press the OK button and you will see the screen below:
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Information menu
This menu has several items which give you information about printer, cartridges, connections and printer’s 
components status.

Relocks remaining
This test is only used for manufacturing purposes.

Relock attempts remaining
This test is only used for manufacturing purposes.
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Gather/Scramble Scheme
This test is only used for manufacturing purposes.

Checksum for Relock Data
This test is only used for manufacturing purposes.

NIHO
This test shows whether a non-HP cartridge has been installed in the printer.

0 means the cartridge is an original HP supply, 1 means it is a cloned cartridge.
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IRO
This test shows whether an altered cartridge (refilled) has been installed in the printer.

0 means the cartridge has not been altered, 1 means it has.

SS
This test is only used for manufacturing purposes.

Resets Menu
This menu has several items which let you reset printer characteristics to default. The printer will turn off after 
executing each one of these items.
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Country/Language reset
Erases country and language settings.

When selected, the printer will shut down and restart. When it boots up, the printer asks for selecting “Language” 
and “Country”.
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Partial reset
This test performs a partial reset of the printer to factory defaults.

After its execution, user will be prompted to reconfigure some settings (country, language, etc.).

Semi-full reset
This test performs a semi-full reset of the printer to factory defaults (more extensive than a partial reset, less 
than an OOBE reset).

After its execution, users will be prompted to reconfigure some settings (country, language, etc.).

OOBE reset
This test resets the printer to factory defaults and starts the out of the box experience.

CAUTION: Do not perform this reset as an initial tool for troubleshooting purposes when printer is not in good 
condition. The printer can go to an unexpected state (showing the HP logo or a Blue screen). Please check the 
front panel message to determine the standard corrective action.

PMK1 reset
Use this option to reset the counters after installing the Print Maintenance Kit 1 or if replacing the Carriage 
Assembly/Carriage Belt/Cutter/Encoder Strip.

NOTE: To check the status of PMK1, print the Printer Status Report. Check the row 16 “MK”, the first 2 
numbers that appear are the % for the PMK1 and PMK2.

PMK2 reset
Use this option to reset the counters after installing the Print Maintenance Kit 2 or if replacing the Service Station.

NOTE: To check the status of PMK1, print the Printer Status Report. Check the row 16 “MK”, the first 2 
numbers that appear are the % for the PMK1 and PMK2.

Partial reset 135



RTC Battery expired
Use this option to reset the RTC battery flag after replacing the RTC battery.

Service Test
This menu provides access to extensive service testing options.

Test Carriage
Select this test to check if the carriage moves correctly.

The carriage will reproduce several moves getting out from the service station, depending on how many cycles 
you set (from 0 until 65535 cycles).

Associated errors

When the following errors occur in the printer, this diagnostics procedure must be performed:

● System error 0042-0017

● Paper jam error

1. Navigate to Support menu > Service Test > Test carriage and then press OK.

2. At the following screen you can set up the number of cycles the carriage will perform (from 0 to 65535 
cycles). The movement does not complete the entire SCAN AXIS, just checks that the carriage can move 
properly.
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NOTE: If any issue is found during the diagnostic performance, please reboot the printer and a system 
error will prompt during the restart.

3. Once the test finishes, if everything it is okay, you will see the following screen. Press Cancel in order to go 
back to the main menu or Continue to perform the test again.

Test Service Station
Select this test to check if the service station moves correctly.

The service station will reproduce several moves completing a bump to bump, depending on how many cycles 
you set (from 0 until 65535 cycles).

Associated errors

When the following errors occur in the printer, this diagnostics procedure must be performed:

● System error 0021-0017

● System error 0042-0017

● Paper jam error

1. Navigate to Support menu > Service Test > Test service station and then press OK.
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2. At the following screen you can set up the number of cycles the carriage will perform (from 0 to 65535 
cycles). The movement completes the entire service station's stroke, in order to check that the service 
station can move properly.

NOTE: If any issue is found during the diagnostic performance, please reboot the printer and a system 
error will prompt during the restart.

3. Once the test finishes, if everything it is okay, you will see the following screen. Press Cancel in order to go 
back to the main menu or Continue to perform the test again.

Test Keys
This test verifies the functioning of all the keys in the Front Panel frame: Home, Help, Back, and the Power key 
located on the back of the Front Panel side.

When this test is done you are asked to press these keys one by one to check whether any are damaged.

Associated errors

When the following error occurs in the printer, this diagnostics procedure must be performed:

● One or more keys are unresponsive.
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1. Navigate to Support menu > Service Test > Test keys and then press OK.

2. The following screen will display:

3. Check the Home key is on (the icon should be illuminated), press this key and then one by one through all 
the keys. The last one is the Help key. The screens below will appear in the following order:

●
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●

●

4. 4. If you press all the keys and they work correctly you will see:

5. If any key does not work, the diagnostic will not pass to the next key, and will stay always in the screen of 
the failing key therefore the front panel should be changed. To recover the printer, restart it by switching it 
off and on with the power key.

Test LEDs
This test verifies all the keys’ LEDs in the Front Panel frame: Home, Help, and Back.
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When this test is done you are asked to press the OK key one by one to check whether any are damaged.

Associated errors

When the following error occurs in the printer, this diagnostics procedure must be performed:

● One or more keys are not shining.

1. Navigate to Support menu > Service Test > Test LEDs and then press OK.

2. The following screen will display, press OK in order to start the test.
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3. Check the Home key LED is on (the icon should be illuminated), then press OK. Go through the other keys 
one by one to check their LED functionality. The last one is the Help LED. The screens will appear in the 
following order:

●

●

●
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4. If you press all the keys and they work correctly you will see the following:

Test Display
This test verifies that the Front Panel display works properly.

Associated errors

There is no specific error associated with a failure of some pixels or the backlight of the Front Panel. This 
diagnostic should be run when you want to check if the front panel display is okay, or if the Front Panel does not 
respond.

1. Navigate to Support menu > Service Test > Test display and then press OK.

2. The test will display the following screens, press OK in order to continue through the test. Each time OK is 
pressed, the display color will change.

●
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●

●

●

●
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●

●

●

3. Once the test is finished you will see the screen below:
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Cont_print_pick
This test prints infinite plots with marked with 4 dots (2 dots on the left side and 2 dots in the right side of the 
paper).

Associated errors

When any of the following errors occur in the printer, this diagnostics procedure must be performed:

● Use it to check the media paper advance.

● Use it to check the skew paper.

1. Navigate to Support menu > Service Test > Cont_print_pick and then press OK.
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2. The printed report is the following. Press Cancel when you would like to stop printing plots.
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Infinite H's Test
This test prints infinite plots filled with black H's.

Use it to see the print quality in order to know if the printer needs calibrations, printhead cleaning, or purges.

Associated errors

When any of the following errors occur in the printer, this diagnostics procedure must be performed:

● Use it to check the paper media advance calibration is correct.

● Use it to check the printhead calibrations quality.

1. Navigate to Support menu > Service Test > Infinite H's Test and then press OK.

2. Press Cancel button when you would like to stop printing plots.

●
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●

The printed report is the following. Press Cancel button when you would like to stop printing plots.
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Infinite Color H's Test
This test prints infinite plots filled with H's in color (black, magenta, yellow and cyan).

Use it to see the print quality in order to know if the printer needs calibrations, printhead cleaning, or purges.

Associated errors

When any of the following errors occur in the printer, this diagnostics procedure must be performed:

● Use it to check the paper media advance calibration is correct.

● Use it to check the printhead calibrations quality.

1. Navigate to Support menu > Service Test > Infinite color H's Test and then press OK.

2. Press Cancel button when you would like to stop printing plots.

●
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●

The printed report is the following:
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Print head rec level 1
This test is used to clear the printhead, spitting several times with a soft strength.
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This test consumes a low quantity of ink, diminishing the cartridges levels a little bit.

Associated errors

When any of the following errors occur in the printer, this diagnostics procedure must be performed:

● Use it when the plot quality is low even when calibrations have been performed.

● When some of the main colors were missing in plots (Printhead’s dies are blocked).

TIP: Before using the upper levels of Print head rec diagnostic, first try the lower one, then print in order to 
check whether it was enough or not. If you do not see any improvement, go to the diagnostic’s next levels.

NOTE: Expends a moderate amount of cartridge ink.

1. Navigate to Support menu > Service Test > Print head rec level 1 and then press OK.

2. The following screen will display, press OK in order to start the test.

3. When the test is finished it automatically goes to the menu.

Print head rec level 2
This test is used to clear the printhead, spitting several times with a medium strength.

This test consumes a moderate quantity of ink, diminishing the cartridges levels.

Associated errors

When any of the following errors occur in the printer, this diagnostics procedure must be performed:
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● Use it when the plot quality is low even when calibrations have been performed.

● When some of the main colors were missing in plots (Printhead’s dies are blocked).

TIP: Before using the upper levels of Print head rec diagnostic, first try the lower one, then print in order to 
check whether it was enough or not. If you do not see any improvement, go to the diagnostic’s next levels.

NOTE: Use only if you have performed Print head rec level 1 without seeing any improvement.

NOTE: Expends a high amount of cartridge ink.

1. Navigate to Support menu > Service Test > Print head rec level 2 and then press OK.

2. The following screen will display, press OK in order to start the test.

3. When the test is finished it automatically goes to the menu.

Print head rec level 3
This test is used to clear the printhead, spitting several times with a hard strength.

This test consumes a high quantity of ink, diminishing the cartridges levels very much.

Associated errors

When any of the following errors occur in the printer, this diagnostics procedure must be performed:

● Use it when the plot quality is low even when calibrations have been performed.
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● When some of the main colors were missing in plots (Printhead’s dies are blocked).

TIP: Before using the upper levels of Print head rec diagnostic, first try the lower one, then print in order to 
check whether it was enough or not. If you do not see any improvement, go to the diagnostic’s next levels.

NOTE: Use only if you have performed Print head rec level 1 and 2 without seeing any improvement.

NOTE: Expends a high amount of cartridge ink, between 15% and 20% of the cartridge's total ink level. Take 
care to have additional cartridges available in case performing the test consumes the current cartridge entirely.

1. Navigate to Support menu > Service Test > Print head rec level 3 and then press OK.

2. The following screen will display, press OK in order to start the test.

3. When the test is finished it automatically goes to the menu.

PHA/IDS Diagnostics
This test prints a printhead health pattern in order to show possible wrong calibrations or printhead errors.

Associated errors

When any of the following errors occur in the printer, this diagnostics procedure must be performed:

● Use it to check the plot quality.

● Use it after calibrating the printhead to check the results.
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1. Navigate to Support menu > Service Test > PHA/IDS diagnostics and then press OK.

2. The following screen will display, press OK in order to start the test.

The printed report is as follows:
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Ink Supplies Report
This test prints a report on the ink supplies information.

Associated errors

When any of the following errors occur in the printer, this diagnostics procedure must be performed:

● Use it to check the plot quality.

● Use it after calibrating the printhead to check the results.

1. Navigate to Support menu > Service Test > Ink supplies report and then press OK.

2. The following screen will display, press OK in order to start the test.

●

●
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The printed report is as follows:
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Nozzle Test
Prints the nozzle health pattern.

While performing this test, paper is needed in the Multi-sheet tray. Also, it is required to be an A4 or Letter Size 
paper, otherwise there will be a paper size mismatch message. There will be the option to print anyway.

▲ Navigate to Support menu > Service Test > Nozzle test and then press OK.

The printed report is as follows:
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Bypass Pen Alignment
Skips printhead alignment during start up or printhead replacement. This can be useful for some 
troubleshooting.
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1. Navigate to Support menu > Service Test > Bypass pen alignment and then press OK.

2. The following screen will display, press OK in order to start the test.

3. The following screen will be displayed. The Pen Alignment is bypassed now. Press Cancel to continue and go 
back to the main menu.

Paper Servo
This test verifies all the components associated with the Paper Servo Subsystem: Paper Motor, Feed Encoder 
Disk, Feed Encoder PCA, and Index Encoder PCA.

When the test is done, the feed roller is moved a small distance in both directions in order to check that all the 
components work properly or demonstrate if any are damaged.
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Associated errors

When any of the following errors occur in the printer, this diagnostics procedure must be performed:

● System error 0041-0017.

● Paper jam error.

1. Navigate to Support menu > Service Test > Paper Servo and then press OK.

2. Take care that the multi sheet tray is properly connected and load A4 paper. Roll paper could also work!

TIP: If there is no roll paper loaded and in order to check easily if the feed roller is moving or not, you can 
introduce a paper sheet into the top input slot (where single sheets are loaded, see the following image). If 
the feed roller moves correctly you will see the paper moving up and down.
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3. The feed roller will be moved a bit in both directions. If everything is fine, the following screen will be 
displayed:

4. If any issue is found one of these system errors should prompt: 0041-0017, 0085-0101, 0085-0201.

Line Sensor (Zim/Spot)
This test verifies the Line Sensor.

When this test is done you will be asked to load paper into the Multi-Sheet Tray in order to check that the sensor 
is not damaged.

Associated errors

When the following error occurs in the printer, this diagnostics procedure must be performed:

● The printer is unable to complete the load because it cannot detect the paper.
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1. Navigate to Support menu > Service Test > Line Sensor (Zim/Spot) and then press OK.

2. The following screen will be displayed, press OK again to start the test.

3. Check that there is paper in the Multi-Sheet Tray and the roll is unloaded and press OK. Then one sheet 
will be loaded to perform the test. If the test is correctly done you will hear 3 beeps, and the paper will be 
unloaded to finish the test, and the following will be displayed:
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4. If the sensor is not working properly (broken, dirty or disconnected) the system error 0955-0050 will 
appear. The Line Sensor should be replaced. If the test fails, the screen below will be prompted.

5. If the test fails, check that there is no paper jam preventing the sheet loading process. Remove the 
Multi-Sheet Tray if necessary.

RTC Battery Status
This test checks whether the Real-Time Clock’s battery has expired.

Associated errors

There is no error. The symptom is that the date and time is lost when the power cord is disconnected. To check 
that the battery is okay, perform this diagnostic by following the procedure below.

1. Switch off the printer and remove the power cable.

2. Wait for 20 seconds.

3. Reconnect the power cord and turn on the printer.

4. Navigate to Support menu > Service Test > RTC Battery Status and then press OK.
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5. The following screen is displayed:

●

●

6. If the test passes, the following screen is shown:

7. If the battery is exhausted, the following message is displayed:

Problem found: Battery expired or RTC problem. Call HP support and provide the following code: 0001-0082

Rewinder motor
This test verifies all the components associated with the Rewinder motor and Rewinder Encoder Disk.

When the test is done the rewinder motor turns a small distance in both directions in order to check that all the 
components work properly or if any are damaged.

Associated errors
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This test should be conducted when there are issues unloading the roll, or media advance problems affecting IQ.

NOTE: Remember to retire the roll bar (with media paper roll) before executing this diagnostic in order to 
properly check the components. In any other case, the diagnostic could fail.

1. Unload roll.

2. Navigate to Support menu > Service Test > Rewinder Motor and then press OK.

3. The following screen will display, press OK in order to start the diagnostic.

4. The following screen will appear. Open the roll cover and press OK to continue with the diagnostic.
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5. The rewinder will move in both directions. If everything is fine the following screen will be displayed:

ARSS Test
This test verifies that the ARSS mechanical components are not damaged.

Associated errors

This test should be conducted when there are issues changing the media type between roll media and multi­
sheet tray in case the roll media was loaded.

NOTE: You need to have installed the multi-sheet tray and the roll paper in your printer in order to perform 
this test.

First, you should manually load the roll paper in printer mode or load it during the test. The following 
paragraphs describe the test and its steps.

1. Navigate to Support menu > Service Test > ARSS Test and then press OK.
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2. Load the roll paper (in case it is not already loaded) and press OK to continue.

3. Once the roll is loaded, the rewinder will unload the roll paper.

4. The printer will activate the ARSS mechanically in order to change between roll paper and multi-sheet tray.

5. The test will display the result on-screen, reporting Pass or Failuredepending on whether or not ARSS 
moves correctly.

Special/Service/Support Reports
This menu contains options for printing various printer status reports.

NOTE: In some cases, there is a delay between the moment when you press OK in the support menu and 
when the printer starts to print the report. Please be patient.

Printer status report
A high-level view of the product status.

172 Chapter 3  Support Menus, Diagnostic Plots & Calibrations



The printed report is as shown below:
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Extended self-test
Includes printhead specific information.
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The printed report is as shown below:
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Print Quality report
Standard print quality report available from the customer UI.

The printed report is as shown below:
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Network Security Page
Network report which contains printer connection info and the security information.

The printed report is as shown below:
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Counter
Select this item to print an unlimited number of pages which count from zero to infinite. You can stop the plot 
whenever you want.
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The printed report is as shown below:
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Print-Mech Button Tap
Advanced testing for manufacturing purposes. Only certain code numbers work.

Error history
Prints the error log, a list with the latest 50 SE detected.
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The printed report is as shown below:
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Agent Assisted image test
Prints IQ troubleshooting page. It is recommended to use Plain paper (>85gsm).
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The printed report is as shown below:

186 Chapter 3  Support Menus, Diagnostic Plots & Calibrations



Support menu
In this section of the service manual you will find an explanation in detail of each of the menus included on the 
Support Menu.
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All these service options and utilities are available to customers under the assistance of an HP call agent. For a 
diagram of the menu tree, see Menu options on page 463.

Information menu
This menu has several items which give you information about printer, cartridges, connections and printer’s 
components status.

Model number
Select this to get the printer's Model Number.

You will see the following screens:

Serial number
Select this to get the printer's Serial Number.
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You will see the following screens:

Region/Language
Select this to get the printer's country location and language setting.

You will see the following screens:
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Counters
Select this to get information about the number of pages printed and Carriage cycles.

You will see the following screens:

Firmware version
Select this to get the printer's Firmware Version.

The firmware version is identified by the week and year it is released. For example: FW name: 
xxxxxxxxx.1941F.xxxx, where:

● 19 = Year

● 41 = Week

● F = Minor weekly revision
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Assert History
Select this to get the printer’s information about the last five asserts which have appeared on it.

You will only see the assert’s codes, for example:
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Printer Region
Select this to get the printer region.

Printer region is always "0":

Pen supply region
Select this to get the pen and Ink supply region.

Supply region is always "1".
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Pen supply serial number
Select this option to check the pen and ink supply serial number.
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Pen supply level of ink (LOI)
Select this option to check the status of the ink supply.

Pen refers to the cartridge.OK means cartridge is okay for use.
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Extra Printhead information (not included in the Service Menu)
Printhead install date and Printhead drop count can be retrieved from the standard menu. Simply go to the 
dashboard and key on the PHA icon.

Check this to get the PHA installation date, and use it to find out the PHA warranty.

Check printhead drop count to display the amount of ink fired (ml) by the printhead for each color. Also shows 
printhead warranty status.

*Warranty Info Status can be:

● In Warranty

● Out of Warranty

Wireless region
Select this to verify the wireless region.
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By default, the Wireless region is configured to WorldSafe.

Resets menu
This menu has several items which let you reset printer characteristics to default.

Country/Language reset
Erases country and language settings.

When selected, the printer will shut down and restart. When it boots up, the printer asks for selecting “Language” 
and “Country”.

Resets menu 197
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Linefeed Mfg Calibration (NEW&FOTO)
Deletes user media advance calibrations.

Restores the manufacturing ones. Unit will power down and reboot.

Support Menu Resets
This menu has several items which let you reset printer characteristics to default.

Partial reset
This test performs a partial reset of the printer to factory defaults.

After its execution, user will be prompted to reconfigure some settings (country, language, etc.).

Semi-full reset
This test performs a semi-full reset of the printer to factory defaults (more extensive than partial reset, less than 
OOBE reset).

After its execution, user will be prompted to reconfigure some settings (country, language, etc.).

OOBE reset
This test resets the printer to factory defaults and starts the out of the box experience.

CAUTION: Do not perform this reset as an initial tool for troubleshooting purposes when printer is not in good 
condition. The printer can go to an unexpected state (showing the HP logo or a Blue screen). Please check the 
front panel message to determine the standard corrective action.

System Configuration Menu
This menu contains an item which let you set up the printer to user mode.
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Set boot mode to user mode
Sets the unit from manufacturing mode to “user mode”.

This option should only be used if Front Panel shows a white grid (manufacturing mode).

Service Test
This menu contains options for checking the functionality of different modules, plus printhead tests and reports.

Test Carriage
Select this test to check if the carriage moves correctly.

The carriage will reproduce several moves getting out from the service station, depending on how many cycles 
you set (from 0 until 65535 cycles).
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Associated errors

When the following errors occur in the printer, this diagnostics procedure must be performed:

● System error 0042-0017

● Paper jam error

1. Navigate to Support menu > Service Test > Test carriage and then press OK.

2. At the following screen you can set up the number of cycles the carriage will perform (from 0 to 65535 
cycles). The movement does not complete the entire SCAN AXIS, just checks that the carriage can move 
properly.

NOTE: If any issue is found during the diagnostic performance, please reboot the printer and a system 
error will prompt during the restart.
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3. Once the test finishes, if everything it is okay, you will see the following screen. Press Cancel in order to go 
back to the main menu or Continue to perform the test again.

Test Service Station
Select this test to check if the service station moves correctly.

The service station will reproduce several moves completing a bump to bump, depending on how many cycles 
you set (from 0 until 65535 cycles).

Associated errors

When the following errors occur in the printer, this diagnostics procedure must be performed:

● System error 0021-0017

● System error 0042-0017

● Paper jam error

1. Navigate to Support menu > Service Test > Test service station and then press OK.
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2. At the following screen you can set up the number of cycles the carriage will perform (from 0 to 65535 
cycles). The movement completes the entire service station's stroke, in order to check that the service 
station can move properly.

NOTE: If any issue is found during the diagnostic performance, please reboot the printer and a system 
error will prompt during the restart.

3. Once the test finishes, if everything it is okay, you will see the following screen. Press Cancel in order to go 
back to the main menu or Continue to perform the test again.

Test Keys
This test verifies the functioning of all the keys in the Front Panel frame: Home, Help, Back, and the Power key 
located on the back of the Front Panel side.

When this test is done you are asked to press these keys one by one to check whether any are damaged.

Associated errors

When the following error occurs in the printer, this diagnostics procedure must be performed:

● One or more keys are unresponsive.
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1. Navigate to Support menu > Service Test > Test keys and then press OK.

2. The following screen will display:

3. Check the Home key is on (the icon should be illuminated), press this key and then one by one through all 
the keys. The last one is the Help key. The screens below will appear in the following order:

●
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●

●

4. 4. If you press all the keys and they work correctly you will see:

5. If any key does not work, the diagnostic will not pass to the next key, and will stay always in the screen of 
the failing key therefore the front panel should be changed. To recover the printer, restart it by switching it 
off and on with the power key.

Test LEDs
This test verifies all the keys’ LEDs in the Front Panel frame: Home, Help, and Back.
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When this test is done you are asked to press the OK key one by one to check whether any are damaged.

Associated errors

When the following error occurs in the printer, this diagnostics procedure must be performed:

● One or more keys are not shining.

1. Navigate to Support menu > Service Test > Test LEDs and then press OK.

2. The following screen will display, press OK in order to start the test.
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3. Check the Home key LED is on (the icon should be illuminated), then press OK. Go through the other keys 
one by one to check their LED functionality. The last one is the Help LED. The screens will appear in the 
following order:

●

●

●
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4. If you press all the keys and they work correctly you will see the following:

Test Display
This test verifies that the Front Panel display works properly.

Associated errors

There is no specific error associated with a failure of some pixels or the backlight of the Front Panel. This 
diagnostic should be run when you want to check if the front panel display is okay, or if the Front Panel does not 
respond.

1. Navigate to Support menu > Service Test > Test display and then press OK.

2. The test will display the following screens, press OK in order to continue through the test. Each time OK is 
pressed, the display color will change.

●
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●

●

●

●

Test Display 209



●

●

●

3. Once the test is finished you will see the screen below:
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Cont_print_pick
This test prints infinite plots with marked with 4 dots (2 dots on the left side and 2 dots in the right side of the 
paper).

Associated errors

When any of the following errors occur in the printer, this diagnostics procedure must be performed:

● Use it to check the media paper advance.

● Use it to check the skew paper.

1. Navigate to Support menu > Service Test > Cont_print_pick and then press OK.
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2. The printed report is the following. Press Cancel when you would like to stop printing plots.
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Infinite H's Test
This test prints infinite plots filled with black H's.

Use it to see the print quality in order to know if the printer needs calibrations, printhead cleaning, or purges.

Associated errors

When any of the following errors occur in the printer, this diagnostics procedure must be performed:

● Use it to check the paper media advance calibration is correct.

● Use it to check the printhead calibrations quality.

1. Navigate to Support menu > Service Test > Infinite H's Test and then press OK.

2. Press Cancel button when you would like to stop printing plots.

●
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●

The printed report is the following. Press Cancel button when you would like to stop printing plots.
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Infinite Color H's Test
This test prints infinite plots filled with H's in color (black, magenta, yellow and cyan).

Use it to see the print quality in order to know if the printer needs calibrations, printhead cleaning, or purges.

Associated errors

When any of the following errors occur in the printer, this diagnostics procedure must be performed:

● Use it to check the paper media advance calibration is correct.

● Use it to check the printhead calibrations quality.

1. Navigate to Support menu > Service Test > Infinite color H's Test and then press OK.

2. Press Cancel button when you would like to stop printing plots.

●
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●

The printed report is the following:
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Print head rec level 1
This test is used to clear the printhead, spitting several times with a soft strength.
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This test consumes a low quantity of ink, diminishing the cartridges levels a little bit.

Associated errors

When any of the following errors occur in the printer, this diagnostics procedure must be performed:

● Use it when the plot quality is low even when calibrations have been performed.

● When some of the main colors were missing in plots (Printhead’s dies are blocked).

TIP: Before using the upper levels of Print head rec diagnostic, first try the lower one, then print in order to 
check whether it was enough or not. If you do not see any improvement, go to the diagnostic’s next levels.

NOTE: Expends a moderate amount of cartridge ink.

1. Navigate to Support menu > Service Test > Print head rec level 1 and then press OK.

2. The following screen will display, press OK in order to start the test.

3. When the test is finished it automatically goes to the menu.

Print head rec level 2
This test is used to clear the printhead, spitting several times with a medium strength.

This test consumes a moderate quantity of ink, diminishing the cartridges levels.

Associated errors

When any of the following errors occur in the printer, this diagnostics procedure must be performed:
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● Use it when the plot quality is low even when calibrations have been performed.

● When some of the main colors were missing in plots (Printhead’s dies are blocked).

TIP: Before using the upper levels of Print head rec diagnostic, first try the lower one, then print in order to 
check whether it was enough or not. If you do not see any improvement, go to the diagnostic’s next levels.

NOTE: Use only if you have performed Print head rec level 1 without seeing any improvement.

NOTE: Expends a high amount of cartridge ink.

1. Navigate to Support menu > Service Test > Print head rec level 2 and then press OK.

2. The following screen will display, press OK in order to start the test.

3. When the test is finished it automatically goes to the menu.

Print head rec level 3
This test is used to clear the printhead, spitting several times with a hard strength.

This test consumes a high quantity of ink, diminishing the cartridges levels very much.

Associated errors

When any of the following errors occur in the printer, this diagnostics procedure must be performed:

● Use it when the plot quality is low even when calibrations have been performed.
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● When some of the main colors were missing in plots (Printhead’s dies are blocked).

TIP: Before using the upper levels of Print head rec diagnostic, first try the lower one, then print in order to 
check whether it was enough or not. If you do not see any improvement, go to the diagnostic’s next levels.

NOTE: Use only if you have performed Print head rec level 1 and 2 without seeing any improvement.

NOTE: Expends a high amount of cartridge ink, between 15% and 20% of the cartridge's total ink level. Take 
care to have additional cartridges available in case performing the test consumes the current cartridge entirely.

1. Navigate to Support menu > Service Test > Print head rec level 3 and then press OK.

2. The following screen will display, press OK in order to start the test.

3. When the test is finished it automatically goes to the menu.

PHA/IDS Diagnostics
This test prints a printhead health pattern in order to show possible wrong calibrations or printhead errors.

Associated errors

When any of the following errors occur in the printer, this diagnostics procedure must be performed:

● Use it to check the plot quality.

● Use it after calibrating the printhead to check the results.
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1. Navigate to Support menu > Service Test > PHA/IDS diagnostics and then press OK.

2. The following screen will display, press OK in order to start the test.

The printed report is as follows:
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Ink Supplies Report
This test prints a report on the ink supplies information.

Associated errors

When any of the following errors occur in the printer, this diagnostics procedure must be performed:

● Use it to check the plot quality.

● Use it after calibrating the printhead to check the results.

1. Navigate to Support menu > Service Test > Ink supplies report and then press OK.

2. The following screen will display, press OK in order to start the test.

●

●
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The printed report is as follows:
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Nozzle Test
Prints the nozzle health pattern.

While performing this test, paper is needed in the Multi-sheet tray. Also, it is required to be an A4 or Letter Size 
paper, otherwise there will be a paper size mismatch message. There will be the option to print anyway.

▲ Navigate to Support menu > Service Test > Nozzle test and then press OK.

The printed report is as follows:
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Bypass Pen Alignment
Skips printhead alignment during start up or printhead replacement. This can be useful for some 
troubleshooting.

228 Chapter 3  Support Menus, Diagnostic Plots & Calibrations



1. Navigate to Support menu > Service Test > Bypass pen alignment and then press OK.

2. The following screen will display, press OK in order to start the test.

3. The following screen will be displayed. The Pen Alignment is bypassed now. Press Cancel to continue and go 
back to the main menu.

Paper Servo
This test verifies all the components associated with the Paper Servo Subsystem: Paper Motor, Feed Encoder 
Disk, Feed Encoder PCA, and Index Encoder PCA.

When the test is done, the feed roller is moved a small distance in both directions in order to check that all the 
components work properly or demonstrate if any are damaged.
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Associated errors

When any of the following errors occur in the printer, this diagnostics procedure must be performed:

● System error 0041-0017.

● Paper jam error.

1. Navigate to Support menu > Service Test > Paper Servo and then press OK.

2. Take care that the multi sheet tray is properly connected and load A4 paper. Roll paper could also work!

TIP: If there is no roll paper loaded and in order to check easily if the feed roller is moving or not, you can 
introduce a paper sheet into the top input slot (where single sheets are loaded, see the following image). If 
the feed roller moves correctly you will see the paper moving up and down.
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3. The feed roller will be moved a bit in both directions. If everything is fine, the following screen will be 
displayed:

4. If any issue is found one of these system errors should prompt: 0041-0017, 0085-0101, 0085-0201.

Line Sensor (Zim/Spot)
This test verifies the Line Sensor.

When this test is done you will be asked to load paper into the Multi-Sheet Tray in order to check that the sensor 
is not damaged.

Associated errors

When the following error occurs in the printer, this diagnostics procedure must be performed:

● The printer is unable to complete the load because it cannot detect the paper.
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1. Navigate to Support menu > Service Test > Line Sensor (Zim/Spot) and then press OK.

2. The following screen will be displayed, press OK again to start the test.

3. Check that there is paper in the Multi-Sheet Tray and the roll is unloaded and press OK. Then one sheet 
will be loaded to perform the test. If the test is correctly done you will hear 3 beeps, and the paper will be 
unloaded to finish the test, and the following will be displayed:

232 Chapter 3  Support Menus, Diagnostic Plots & Calibrations



4. If the sensor is not working properly (broken, dirty or disconnected) the system error 0955-0050 will 
appear. The Line Sensor should be replaced. If the test fails, the screen below will be prompted.

5. If the test fails, check that there is no paper jam preventing the sheet loading process. Remove the 
Multi-Sheet Tray if necessary.

RTC Battery Status
This test checks whether the Real-Time Clock’s battery has expired.

Associated errors

There is no error. The symptom is that the date and time is lost when the power cord is disconnected. To check 
that the battery is okay, perform this diagnostic by following the procedure below.

1. Switch off the printer and remove the power cable.

2. Wait for 20 seconds.

3. Reconnect the power cord and turn on the printer.

4. Navigate to Support menu > Service Test > RTC Battery Status and then press OK.
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5. The following screen is displayed:

●

●

6. If the test passes, the following screen is shown:

7. If the battery is exhausted, the following message is displayed:

Problem found: Battery expired or RTC problem. Call HP support and provide the following code: 0001-0082

Rewinder motor
This test verifies all the components associated with the Rewinder motor and Rewinder Encoder Disk.

When the test is done the rewinder motor turns a small distance in both directions in order to check that all the 
components work properly or if any are damaged.

Associated errors
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This test should be conducted when there are issues unloading the roll, or media advance problems affecting IQ.

NOTE: Remember to retire the roll bar (with media paper roll) before executing this diagnostic in order to 
properly check the components. In any other case, the diagnostic could fail.

1. Unload roll.

2. Navigate to Support menu > Service Test > Rewinder Motor and then press OK.

3. The following screen will display, press OK in order to start the diagnostic.

4. The following screen will appear. Open the roll cover and press OK to continue with the diagnostic.
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5. The rewinder will move in both directions. If everything is fine the following screen will be displayed:

ARSS Test
This test verifies that the ARSS mechanical components are not damaged.

Associated errors

This test should be conducted when there are issues changing the media type between roll media and multi­
sheet tray in case the roll media was loaded.

NOTE: You need to have installed the multi-sheet tray and the roll paper in your printer in order to perform 
this test.

First, you should manually load the roll paper in printer mode or load it during the test. The following 
paragraphs describe the test and its steps.

1. Navigate to Support menu > Service Test > ARSS Test and then press OK.
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2. Load the roll paper (in case it is not already loaded) and press OK to continue.

3. Once the roll is loaded, the rewinder will unload the roll paper.

4. The printer will activate the ARSS mechanically in order to change between roll paper and multi-sheet tray.

5. The test will display the result on-screen, reporting Pass or Failuredepending on whether or not ARSS 
moves correctly.

Connectivity Diagnostics Menu
This menu contains options for printing different connectivity reports.

Connectivity report
Prints a report that contains all the various Connectivity settings.
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The printed report is as follows:
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Wireless diagnostics test
Performs the same Wireless Diagnostics Test as in the "Customer UI”, through the Front Panel of the printer. This 
diagnostic tool tests the wireless setup of the product.

The printed report is as follows:
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Print wireless metrics
Prints details on disconnect counts, disconnect duration, signal strength, noise levels, wifi frame lost details etc.

The printed report is as follows:
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Reports
This menu contains options for printing various printer status reports.

In some cases there is a delay between the moment when you press OK in the support menu and when the 
printer starts to print the report. Please be patient.

Printer status report
A high-level view of the product status.

The printed report is as shown below:
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Extended self-test
Includes printhead specific information.
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The printed report is as shown below:
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Print Quality report
Standard print quality report available from the customer UI.

The printed report is as shown below:
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Network Security Page
Network report which contains printer connection info and the security information.

The printed report is as shown below:
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Counter
Select this item to print an unlimited number of pages which count from zero to infinite. You can stop the plot 
whenever you want.
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The printed report is as shown below:
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Print-Mech Button Tap
Advanced testing for manufacturing purposes. Only certain code numbers work.

Error history
Prints the error log, a list with the latest 50 SE detected.
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The printed report is as shown below:
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Agent Assisted image test
Prints IQ troubleshooting page. It is recommended to use Plain paper (>85gsm).
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The printed report is as shown below:
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Parts and diagrams4

This chapter provides a complete reference for the key components of the printer, with detailed visual 
representations of their locations and arrangement within each subsystem.

Introduction
The list of parts in this chapter include the notation CSR A or CSR B for parts that can be replaced by the 
customer.

● All other parts must be replaced by an engineer. See Customer Self Repair parts on page 295.

● For information on the preventive maintenance kits, see Preventive maintenance kits on page 446.
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Printer support A
The printer support includes the stand assembly and all the hardware kit required to mount or repair it.

HP part number Part description Removal and 
Installation 
reference

Applicable products

1 5HB08-67001 Stand Assembly
CSR A. See 
the flyer 
Stand 

HP DesignJet T650 24-in Printer
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HP part number Part description Removal and 
Installation 
reference

Applicable products

Assembly 
Instructions 
(T200) on 
page 494.

HP DesignJet T650 24-in Printer GSA

HP DesignJet T630 24-in Printer

5HB10-67002 Stand Assembly

CSR A. See 
the flyer 
Stand 
Assembly 
Instructions 
(T200) on 
page 494.

HP Designjet T650 36-in Printer

HP Designjet T630 36-in Printer

2

5HB08-67002 Stand Hardware Kit

HP DesignJet T650 24-in Printer

HP DesignJet T650 24-in Printer GSA

HP DesignJet T630 24-in Printer

HP DesignJet T650 36-in Printer

HP DesignJet T630 36-in Printer
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Printer support B
The printer support includes the stand assembly and all the hardware kit required to mount or repair it.

HP part number Part description Removal and 
Installation 
reference

Applicable products

1 5HB12-67014 Basket Right Cover HP DesignJet Studio 24-in Printer
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HP part number Part description Removal and 
Installation 
reference

Applicable products

HP DesignJet Studio 36-in Printer

2
5HB12-67012

Basket
HP DesignJet Studio 24-in Printer

5HB14-67009 HP DesignJet Studio 36-in Printer

3 5HB12-67002 Stand Hardware Kit
HP DesignJet T650 24-in Printer

HP DesignJet Studio 36-in Printer

4

5HB12-67001

Stand SV

CSR A. See 
the flyer HP 
DesignJet 
Studio Stand 
Assembly 
Instructions 
on page 502.

HP DesignJet Studio 24-in Printer

5HB14-67001 HP DesignJet Studio 36-in Printer

5 5HB12-67013 Basket Left Cover
HP DesignJet Studio 24-in Printer

HP DesignJet Studio 36-in Printer
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Covers
These are the external protective covers of the printer.

Table 4-1

Item Part Number Description Removal and Installation 
reference

Applicable products

1 5HB12-67007

Top Trim (5HB06-67004 
& 5HB10-67003 
& 5HB12-67003, 
5HB14-67002 & 
5HB12-67019 & 
5HB14-67011) on page 
297

HP DesignJet T250 24-in 
Printer

HP DesignJet T230 24-in 
Printer

HP DesignJet T210 24-in 
Printer

HP DesignJet T650 24-in 
Printer

HP DesignJet T650 24-in 
Printer GSA
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Table 4-1 (continued)

Item Part Number Description Removal and Installation 
reference

Applicable products

HP DesignJet T630 24-in 
Printer

HP DesignJet Studio 24­
in Printer

5HB14-67005

Top Trim (5HB06-67004 
& 5HB10-67003 
& 5HB12-67003, 
5HB14-67002 & 
5HB12-67019 & 
5HB14-67011) on page 
297

HP DesignJet T650 36-in 
Printer

HP DesignJet T630 36-in 
Printer

HP DesignJet Studio 36­
in Printer

2

5HB06-67006

Right Cover 
(5HB06-67006 & 
5HB12-67006) on page 
303

HP DesignJet T250 24-in 
Printer

HP DesignJet T230 24-in 
Printer

HP DesignJet T210 24-in 
Printer

HP DesignJet T650 24-in 
Printer

HP DesignJet T650 24-in 
Printer GSA

HP DesignJet T630 24-in 
Printer

HP DesignJet T650 36-in 
Printer

HP DesignJet T630 36-in 
Printer

5HB12-67006

Right Cover 
(5HB06-67006 & 
5HB12-67006) on page 
303

HP DesignJet Studio 24­
in Printer

HP DesignJet Studio 36­
in Printer

3

5HB06-67010

Front Cover

Front Cover 
(5HB06-67010 
& 5HB10-67008, 
5HB12-67011 & 
5HB14-67008) on page 
299

HP DesignJet T250 24-in 
Printer

HP DesignJet T230 24-in 
Printer

HP DesignJet T210 24-in 
Printer

HP DesignJet T650 24-in 
Printer

HP DesignJet T650 24-in 
Printer GSA

HP DesignJet T630 24-in 
Printer

5HB10-67008
Front Cover 
(5HB06-67010 
& 5HB10-67008, 

HP DesignJet T650 36-in 
Printer
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Table 4-1 (continued)

Item Part Number Description Removal and Installation 
reference

Applicable products

5HB12-67011 & 
5HB14-67008) on page 
299

HP DesignJet T630 36-in 
Printer

5HB12-67011

Front Cover 
(5HB06-67010 
& 5HB10-67008, 
5HB12-67011 & 
5HB14-67008) on page 
299

HP DesignJet Studio 24­
in Printer

5HB14-67008

Front Cover 
(5HB06-67010 
& 5HB10-67008, 
5HB12-67011 & 
5HB14-67008) on page 
299

HP DesignJet Studio 36­
in Printer

4

5HB06-67005

Front Door 
(5HB06-67005 
& 5HB10-67005, 
5HB12-67005 & 
5HB14-67004) on page 
305

HP DesignJet T250 24-in 
Printer

HP DesignJet T230 24-in 
Printer

HP DesignJet T210 24-in 
Printer

HP DesignJet T650 24-in 
Printer

HP DesignJet T650 24-in 
Printer GSA

HP DesignJet T630 24-in 
Printer

5HB10-67005

Front Door 
(5HB06-67005 
& 5HB10-67005, 
5HB12-67005 & 
5HB14-67004) on page 
305

HP DesignJet T650 36-in 
Printer

HP DesignJet T630 36-in 
Printer

5HB12-67005

Front Door 
(5HB06-67005 
& 5HB10-67005, 
5HB12-67005 & 
5HB14-67004) on page 
305

HP DesignJet Studio 24­
in Printer

5HB14-67004

Front Door 
(5HB06-67005 
& 5HB10-67005, 
5HB12-67005 & 
5HB14-67004) on page 
305

HP DesignJet Studio 36­
in Printer

5 5HB06-67008

Cutter Door 
(5HB06-67008 & 
5HB12-67009) on page 
300

HP DesignJet T250 24-in 
Printer

HP DesignJet T230 24-in 
Printer

HP DesignJet T210 24-in 
Printer
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Table 4-1 (continued)

Item Part Number Description Removal and Installation 
reference

Applicable products

HP DesignJet T650 24-in 
Printer

HP DesignJet T650 24-in 
Printer GSA

HP DesignJet T630 24-in 
Printer

HP DesignJet T650 36-in 
Printer

HP DesignJet T630 36-in 
Printer

5HB12-67009

Cutter Door 
(5HB06-67008 & 
5HB12-67009) on page 
300

HP DesignJet Studio 24­
in Printer

HP DesignJet Studio 36­
in Printer

6

5HB06-67017

Left Cover 
(5HB06-67017 & 
5HB12-67008) on page 
301

HP DesignJet T250 24-in 
Printer

HP DesignJet T230 24-in 
Printer

HP DesignJet T210 24-in 
Printer

HP DesignJet T650 24-in 
Printer

HP DesignJet T650 24-in 
Printer GSA

HP DesignJet T630 24-in 
Printer

HP DesignJet T650 36-in 
Printer

HP DesignJet T630 36-in 
Printer

5HB12-67008

Left Cover 
(5HB06-67017 & 
5HB12-67008) on page 
301

HP DesignJet Studio 24­
in Printer

HP DesignJet Studio 36­
in Printer

7 CQ890-67010

Back Cover 
(CQ890-67010 & 
CQ893-67002) on page 
308

HP DesignJet T250 24-in 
Printer

HP DesignJet T230 24-in 
Printer

HP DesignJet T210 24-in 
Printer

HP DesignJet T650 24-in 
Printer

HP DesignJet T650 24-in 
Printer GSA
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Table 4-1 (continued)

Item Part Number Description Removal and Installation 
reference

Applicable products

HP DesignJet T630 24-in 
Printer

HP DesignJet Studio 24­
in Printer

CQ893-67002

Back Cover 
(CQ890-67010 & 
CQ893-67002) on page 
308

HP DesignJet T650 36-in 
Printer

HP DesignJet T630 36-in 
Printer

HP DesignJet Studio 36­
in Printer

8

5HB06-67004

Top Trim (5HB06-67004 
& 5HB10-67003 
& 5HB12-67003, 
5HB14-67002 & 
5HB12-67019 & 
5HB14-67011) on page 
297

HP DesignJet T250 24-in 
Printer

HP DesignJet T230 24-in 
Printer

HP DesignJet T210 24-in 
Printer

HP DesignJet T650 24-in 
Printer

HP DesignJet T650 24-in 
Printer GSA

HP DesignJet T630 24-in 
Printer

5HB10-67003

Top Trim (5HB06-67004 
& 5HB10-67003 
& 5HB12-67003, 
5HB14-67002 & 
5HB12-67019 & 
5HB14-67011) on page 
297

HP DesignJet T650 36-in 
Printer

HP DesignJet T630 36-in 
Printer

5HB12-67003

Top Trim (5HB06-67004 
& 5HB10-67003 
& 5HB12-67003, 
5HB14-67002 & 
5HB12-67019 & 
5HB14-67011) on page 
297

HP DesignJet Studio 24­
in Printer

5HB14-67002

Top Trim (5HB06-67004 
& 5HB10-67003 
& 5HB12-67003, 
5HB14-67002 & 
5HB12-67019 & 
5HB14-67011) on page 
297

HP DesignJet Studio 36­
in Printer

5HB12-67019

Top Trim (5HB06-67004 
& 5HB10-67003 
& 5HB12-67003, 
5HB14-67002 & 
5HB12-67019 & 
5HB14-67011) on page 
297

HP DesignJet Studio 24­
in Printer

HP DesignJet Studio 
Steel 24-in Printer
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Table 4-1 (continued)

Item Part Number Description Removal and Installation 
reference

Applicable products

5HB14-67011

Top Trim (5HB06-67004 
& 5HB10-67003 
& 5HB12-67003, 
5HB14-67002 & 
5HB12-67019 & 
5HB14-67011) on page 
297

HP DesignJet Studio 36­
in Printer

HP DesignJet Studio 
Steel 36-in Printer

270 Chapter 4  Parts and diagrams



Roll covers
These are the external protective covers of the substrate roll and its supports, rewinders, and dampers.

Table 4-2

Item Part Number Description Removal and Installation 
reference

Applicable Products

1 5HB08-67003

Roll Cover 
(5HB08-67003 
& 5HB10-67004, 
5HB12-67004 & 
5HB14-67003) on page 
311

CSR A. See the flyer Roll 
Cover (T200) on page 
499.

HP DesignJet T250 24-in 
Printer

HP DesignJet T230 24-in 
Printer

HP DesignJet T210 24-in 
Printer

HP DesignJet T650 24-in 
Printer

HP DesignJet T650 24-in 
Printer GSA

HP DesignJet T630 24-in 
Printer
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Table 4-2 (continued)

Item Part Number Description Removal and Installation 
reference

Applicable Products

5HB10-67004

Roll Cover 
(5HB08-67003 
& 5HB10-67004, 
5HB12-67004 & 
5HB14-67003) on page 
311

CSR A. See the flyer Roll 
Cover (T200) on page 
499.

HP DesignJet T650 36-in 
Printer

HP DesignJet T630 36-in 
Printer

5HB12-67004

Roll Cover 
(5HB08-67003 
& 5HB10-67004, 
5HB12-67004 & 
5HB14-67003) on page 
311

CSR A. See the flyer Roll 
Cover (T200) on page 
499.

HP DesignJet Studio 24­
in Printer

5HB14-67003

Roll Cover 
(5HB08-67003 
& 5HB10-67004, 
5HB12-67004 & 
5HB14-67003) on page 
311

CSR A. See the flyer Roll 
Cover (T200) on page 
499.

HP DesignJet Studio 36­
in Printer

2

5HB08-67004

Left Roll Support 
with Rewinder and 
Cover (5HB08-67004 & 
5HB12-67016) on page 
313

HP DesignJet T250 24-in 
Printer

HP DesignJet T230 24-in 
Printer

HP DesignJet T210 24-in 
Printer

HP DesignJet T650 24-in 
Printer

HP DesignJet T650 24-in 
Printer GSA

HP DesignJet T630 24-in 
Printer

HP DesignJet T650 36-in 
Printer

HP DesignJet T630 36-in 
Printer

5HB12-67016

Left Roll Support 
with Rewinder and 
Cover (5HB08-67004 & 
5HB12-67016) on page 
313

HP DesignJet Studio 24­
in Printer

HP DesignJet Studio 36­
in Printer

3 5HB08-67005

Right Roll Support with 
Cover (5HB08-67005 & 
5HB12-67017) on page 
319

HP DesignJet T250 24-in 
Printer

HP DesignJet T230 24-in 
Printer

HP DesignJet T210 24-in 
Printer

HP DesignJet T650 24-in 
Printer

HP DesignJet T650 24-in 
Printer GSA
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Table 4-2 (continued)

Item Part Number Description Removal and Installation 
reference

Applicable Products

HP DesignJet T630 24-in 
Printer

HP DesignJet T650 36-in 
Printer

HP DesignJet T630 36-in 
Printer

5HB12-67017

Right Roll Support with 
Cover (5HB08-67005 & 
5HB12-67017) on page 
319

HP DesignJet Studio 24­
in Printer

HP DesignJet Studio 36­
in Printer

Roll covers 273



Right-hand assemblies
This includes the primp pump, the bundle board, and the various elements of the service station assembly.

HP part number Part description Removal 
and 
Installation 
reference

Applicable products

1 5HB06-67021 Bundle PCA (5HB06-67021) on page 
340

All

2 CQ890-67045 Service Station Assembly 
(CQ890-67045) on page 342

All

3 CQ890-67030 Prime Pump (CQ890-67030) on page 
349

All

Service Station kit
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These are the elements of the service station assembly.
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Left-hand assemblies
This includes the printer's control panel, main PCA, power supply, encoder disk, ink cartridge cover PCA, and the 
left spittoon.

Item Part Number Description Removal 
and 
Installation 
reference

Applicable products

1 5HB06-67002 Front Panel (5HB06-67002) on page 
326 All

2 CQ890-67044 Left Spittoon (CQ890-67044) on page 
334 All

3 5HB06-67018 Main PCA (5HB06-67018 & 
5HB08-67008) on page 329

HP DesignJet T250 24-in Printer

HP DesignJet T230 24-in Printer

HP DesignJet T210 24-in Printer
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Item Part Number Description Removal 
and 
Installation 
reference

Applicable products

5HB08-67008 Main PCA (5HB06-67018 & 
5HB08-67008) on page 329

HP DesignJet T650 24-in Printer

HP DesignJet T650 24-in Printer GSA

HP DesignJet T630 24-in Printer

HP DesignJet T650 36-in Printer

HP DesignJet T630 36-in Printer

HP DesignJet Studio 24-in Printer

HP DesignJet Studio 36-in Printer

4 5HB06-67022 NVM Backup PCA (5HB06-67022) on 
page 328

CSR A. See 
the flyer 
NVM 
Backup 
PCA on 
page 505.

All

5 CQ890-67089 5V Power Supply SV (CQ890-67089) on 
page 332 All

6 CQ890-67033 Encoder Disk (CQ890-67033) on page 
337

All

7 5HB06-67019 Sensor PCA and flat cable, see Cables 
and Sensors (5HB06-67019) on page 

396.

All

Encoder Disk kit

This also includes an instructional flier and gloves.
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Carriage assembly
This includes the carriage assembly, belt and pulley, aerosol shield, line sensor, encoder strip, cutter, and carriage 
motor.

HP part number Part description Removal 
and 
Installation 
reference

Applicable products

1

5HB06-67001
Carriage Assembly with Belt and 
Trailing Cable (5HB06-67001 & 

5HB10-67001) on page 380

HP DesignJet T250 24-in Printer

HP DesignJet T230 24-in Printer

HP DesignJet T210 24-in Printer

HP DesignJet T650 24-in Printer

HP DesignJet T650 24-in Printer GSA

HP DesignJet T630 24-in Printer

HP DesignJet Studio 24-in Printer

5HB10-67001 Carriage Assembly with Belt and 
Trailing Cable (5HB06-67001 & 

5HB10-67001) on page 380

HP DesignJet T650 36-in Printer

HP DesignJet T630 36-in Printer

HP DesignJet Studio 36-in Printer
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HP part number Part description Removal 
and 
Installation 
reference

Applicable products

2 CQ890-67001 Carriage Line Sensor (ZIM sensor) 
(CQ890-67001) on page 387

All

3

CQ890-67112 Belt and Pulley (CQ890-67112 & 
F9A30-67068) on page 374

HP DesignJet T250 24-in Printer

HP DesignJet T230 24-in Printer

HP DesignJet T210 24-in Printer

HP DesignJet T650 24-in Printer

HP DesignJet T650 24-in Printer GSA

HP DesignJet T630 24-in Printer

HP DesignJet Studio 24-in Printer

F9A30-67068 Belt and Pulley (CQ890-67112 & 
F9A30-67068) on page 374

HP DesignJet T650 36-in Printer

HP DesignJet T630 36-in Printer

HP DesignJet Studio 36-in Printer

4

CQ890-67096 Encoder Strip (CQ890-67096 & 
CQ893-67029) on page 376

HP DesignJet T250 24-in Printer

HP DesignJet T230 24-in Printer

HP DesignJet T210 24-in Printer

HP DesignJet T650 24-in Printer

HP DesignJet T650 24-in Printer GSA

HP DesignJet T630 24-in Printer

HP DesignJet Studio 24-in Printer

CQ893-67029 Encoder Strip (CQ890-67096 & 
CQ893-67029) on page 376

HP DesignJet T650 36-in Printer

HP DesignJet T630 36-in Printer

HP DesignJet Studio 36-in Printer

5 CQ890-67108 Cutter with Clutch (CQ890-67108) on 
page 412

CSR A. See 
the flyer 
Cutter 
replaceme
nt 
instruction
s on page 
500.

All

6 5HB06-67003 Carriage Motor (5HB06-67003) on 
page 391

All

Carriage Line Sensor kit
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This kit also includes a T-6 screwdriver.

Encoder Strip kit

This kit also includes gloves for safe handling.
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Paper path (front)
This includes the starwheel assembly, right gear train module, output tray, ouutput platen, and output tray 
sensor.

HP part number Part description Removal 
and 
Installation 
reference

Applicable products

1

5HB06-67014 Starwheel Assembly (5HB06-67014 & 
5HB10-67010) on page 368

HP DesignJet T250 24-in Printer

HP DesignJet T230 24-in Printer

HP DesignJet T210 24-in Printer

HP DesignJet T650 24-in Printer

HP DesignJet T650 24-in Printer GSA

HP DesignJet T630 24-in Printer

HP DesignJet Studio 24-in Printer

5HB10-67010 Starwheel Assembly (5HB06-67014 & 
5HB10-67010) on page 368

HP DesignJet T650 36-in Printer

HP DesignJet T630 36-in Printer

HP DesignJet Studio 36-in Printer

2 5HB06-67012 Bridge Platen (5HB06-67012) on page 
371

All
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HP part number Part description Removal 
and 
Installation 
reference

Applicable products

3

5HB06-67009
Output Platen (5HB06-67009 & 
5HB10-67007, 5HB12-67010 & 

5HB14-67007) on page 322

HP DesignJet T250 24-in Printer

HP DesignJet T230 24-in Printer

HP DesignJet T210 24-in Printer

HP DesignJet T650 24-in Printer

HP DesignJet T650 24-in Printer GSA

HP DesignJet T630 24-in Printer

5HB10-67007 Output Platen (5HB06-67009 & 
5HB10-67007, 5HB12-67010 & 

5HB14-67007) on page 322

HP DesignJet T650 36-in Printer

HP DesignJet T630 36-in Printer

5HB12-67010 Output Platen (5HB06-67009 & 
5HB10-67007, 5HB12-67010 & 

5HB14-67007) on page 322

HP DesignJet Studio 24-in Printer

5HB14-67007 Output Platen (5HB06-67009 & 
5HB10-67007, 5HB12-67010 & 

5HB14-67007) on page 322

HP DesignJet Studio 36-in Printer
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Paper path (rear) A
This includes the pinchwheels assembly, paper motor, multi-sheet tray module and extension, and the out-of­
paper sensor.

HP part number Part description Removal 
and 
Installation 
reference

Applicable products

1

5HB08-67007 Multi-Sheet Tray SV (5HB08-67007 & 
5HB12-67015) on page 425

CSR A. See 
the flyer 
Multi-
Sheet Tray 
SV (T200, 
T600, 
Studio) on 
page 487.

HP DesignJet T650 24-in Printer

HP DesignJet T650 24-in Printer GSA

HP DesignJet T630 24-in Printer

HP Designjet T650 36-in Printer

HP DesignJet T630 36-in Printer

5HB12-67015 Multi-Sheet Tray SV (5HB08-67007 & 
5HB12-67015) on page 425

CSR A. See 
the flyer 
Multi-
Sheet Tray 
SV (T200, 
T600, 

HP DesignJet Studio 24-in Printer

HP DesignJet Studio 36-in Printer
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HP part number Part description Removal 
and 
Installation 
reference

Applicable products

Studio) on 
page 487.

2 CQ890-67102 Out Of Paper Sensor without cable 
(CQ890-67102) on page 419

CSR A. See 
the flyer 
Out-Of-
Paper 
Sensor 
without 
cable on 
page 489.

All

3

5HB06-67024
Multi-Sheet Tray Sensor Assembly 

(5HB06-67024 & 5HB08-67010) on 
page 358

HP DesignJet T250 24-in Printer

HP DesignJet T230 24-in Printer

HP DesignJet T210 24-in Printer

HP DesignJet T650 24-in Printer

HP DesignJet T650 24-in Printer GSA

HP DesignJet T630 24-in Printer

HP DesignJet Studio 24-in Printer

5HB08-67010
Multi-Sheet Tray Sensor Assembly 

(5HB06-67024 & 5HB08-67010) on 
page 358

HP DesignJet T650 36-in Printer

HP DesignJet T630 36-in Printer

HP DesignJet Studio 36-in Printer
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Paper path (rear) B
This includes the input roll guide, multi-sheet tray sensor assembly, and ARSS.

Item HP part number Part description Removal 
and 
Installation 
reference

Applicable products

1 5HB06-67016 Input Roll Guide (5HB06-67016 & 
5HB10-67011) on page 354

HP DesignJet T250 24-in Printer

HP DesignJet T230 24-in Printer

HP DesignJet T210 24-in Printer

HP DesignJet T650 24-in Printer

HP DesignJet T650 24-in Printer GSA

HP DesignJet T630 24-in Printer

HP DesignJet Studio 24-in Printer
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Item HP part number Part description Removal 
and 
Installation 
reference

Applicable products

5HB10-67011 Input Roll Guide (5HB06-67016 & 
5HB10-67011) on page 354

HP DesignJet T650 36-in Printer

HP DesignJet T630 36-in Printer

HP DesignJet Studio 36-in Printer

2 CQ890-67036 Paper Motor (CQ890-67036) on page 
366 All

3 CQ890-67060 Pinchwheels Assembly (CQ890-67060) 
on page 360

All

4 5HB08-67006

ARSS (5HB08-67006) on page 352

CSR A. See 
the flyer 
ARSS on 
page 483.

All
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Roll supports
This includes the spindle module.

Item Part Number Description Removal 
and 
Installation 
reference

Applicable products

1

5HB06-67027 Spindle module SV

HP DesignJet T250 24-in Printer

HP DesignJet T230 24-in Printer

HP DesignJet T210 24-in Printer

HP DesignJet T650 24-in Printer

HP DesignJet T650 24-in Printer GSA

HP DesignJet Studio 24-in Printer

HP DesignJet T650 36-in Printer

5HB10-67012 Spindle module SV

HP DesignJet T630 36-in Printer

HP DesignJet Studio 36-in Printer

HP DesignJet T250 24-in Printer
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Miscellaneous parts
These include the cables service kit, the labels kit, and a region-specific power cord.

Table 4-3

Item Part Number Description Removal and Installation 
reference

Applicable products

1 CQ891-60023 Power Cord: APJ SV KIT All

2 CQ891-60021 Power Cord: EU SV KIT All

3 CQ891-60022 Power Cord: AMS SV KIT All
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Cables and sensors A (5HB06-67019)

Table 4-4

Item Part Number Description Removal and Installation 
reference

1 5HB06-67019 Door sensor PCA - ESD 
(F9A30-60262) on page 408

2 5HB06-67019 FFC Front Window to MPCA 
(5HB06-50001) on page 409

3 5HB06-67019 Encoder PCA (CQ890-60204) 
and Index (CM751-60021) on 
page 396

4 5HB06-67019 FFC-Paper-Feed-Sensors 
(CQ890-80014) on page 399
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Table 4-4 (continued)

Item Part Number Description Removal and Installation 
reference

5 5HB06-67019 Encoder PCA (CQ890-60204) 
and Index (CM751-60021) on 
page 396
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Cables and sensors B (5HB06-67019)

Table 4-5

Item Part Number Description Removal and Installation 
reference

1 5HB06-67019

Assy PBB to MPCA FFC 36in 
(5HB10-60066) / Assy PBB to 
MPCA FFC 24in (5HB06-60099) 
on page 403

Assy PBB to MPCA FFC 36in 
(5HB10-60066) / Assy PBB to 
MPCA FFC 24in (5HB06-60099) 
on page 403

2 5HB06-67019 Out-Of-Paper Sensor TL 
Assembly (5HB06-60066) on 
page 400
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Table 4-5 (continued)

Item Part Number Description Removal and Installation 
reference

3 5HB06-67019

FFC Airprint to MPCA 24in 
(5HB06-60026) / FFC Airprint to 
MPCA 36in (5HB10-60008) on 
page 411

FFC Airprint to MPCA 24in 
(5HB06-60026) / FFC Airprint to 
MPCA 36in (5HB10-60008) on 
page 411
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Removal and installation5

This chapter provides detailed instructions related to the maintanance of the printer, facilitating the replacement 
of exhausted, malfunctioning, or outdated components.

Procedure reference table
The Removal and Installation procedures are listed here in alphabetical and removal order.

Parts in alphabetical order Parts in removal order

5V Power Supply SV (CQ890-67089) on page 332 Top Trim (5HB06-67004 & 5HB10-67003 & 5HB12-67003, 
5HB14-67002 & 5HB12-67019 & 5HB14-67011) on page 297

ARSS (5HB08-67006) on page 352 Front Cover (5HB06-67010 & 5HB10-67008, 5HB12-67011 & 
5HB14-67008) on page 299

Back Cover (CQ890-67010 & CQ893-67002) on page 308 Cutter Door (5HB06-67008 & 5HB12-67009) on page 300

Basket (5HB12-67012 & 5HB14-67009) on page 429 Left Cover (5HB06-67017 & 5HB12-67008) on page 301

Basket Left Cover (5HB12-67013) on page 434 Right Cover (5HB06-67006 & 5HB12-67006) on page 303

Basket Right Cover (5HB12-67014) on page 426 Front Door (5HB06-67005 & 5HB10-67005, 5HB12-67005 & 
5HB14-67004) on page 305

Belt and Pulley (CQ890-67112 & F9A30-67068) on page 374 Top Rear Cover (5HB12-67007 & 5HB14-67005) on page 307

Bridge Platen (5HB06-67012) on page 371 Back Cover (CQ890-67010 & CQ893-67002) on page 308

Bundle PCA (5HB06-67021) on page 340 Roll Cover (5HB08-67003 & 5HB10-67004, 5HB12-67004 & 
5HB14-67003) on page 311

Cables and Sensors (5HB06-67019) on page 396 Left Roll Support with Rewinder and Cover (5HB08-67004 & 
5HB12-67016) on page 313

Carriage Assembly with Belt and Trailing Cable (5HB06-67001 & 
5HB10-67001) on page 380

Right Roll Support with Cover (5HB08-67005 & 5HB12-67017) on 
page 319

Carriage Line Sensor (ZIM sensor) (CQ890-67001) on page 387 Output Platen (5HB06-67009 & 5HB10-67007, 5HB12-67010 & 
5HB14-67007) on page 322

Carriage Motor (5HB06-67003) on page 391 Front Panel (5HB06-67002) on page 326

Cutter Door (5HB06-67008 & 5HB12-67009) on page 300 NVM Backup PCA (5HB06-67022) on page 328

Cutter with Clutch (CQ890-67108) on page 412 Main PCA (5HB06-67018 & 5HB08-67008) on page 329

Encoder Disk (CQ890-67033) on page 337 5V Power Supply SV (CQ890-67089) on page 332

Encoder Strip (CQ890-67096 & CQ893-67029) on page 376 Left Spittoon (CQ890-67044) on page 334

Front Cover (5HB06-67010 & 5HB10-67008, 5HB12-67011 & 
5HB14-67008) on page 299

Encoder Disk (CQ890-67033) on page 337

Front Door (5HB06-67005 & 5HB10-67005, 5HB12-67005 & 
5HB14-67004) on page 305

Bundle PCA (5HB06-67021) on page 340

Front Panel (5HB06-67002) on page 326 Service Station Assembly (CQ890-67045) on page 342

Input Roll Guide (5HB06-67016 & 5HB10-67011) on page 354 Prime Pump (CQ890-67030) on page 349
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Parts in alphabetical order Parts in removal order

Left Cover (5HB06-67017 & 5HB12-67008) on page 301 ARSS (5HB08-67006) on page 352

Left Roll Support with Rewinder and Cover (5HB08-67004 & 
5HB12-67016) on page 313

Input Roll Guide (5HB06-67016 & 5HB10-67011) on page 354

Left Spittoon (CQ890-67044) on page 334 Multi-Sheet Tray Sensor Assembly (5HB06-67024 & 
5HB08-67010) on page 358

Main PCA (5HB06-67018 & 5HB08-67008) on page 329 Pinchwheels Assembly (CQ890-67060) on page 360

Multi-Sheet Tray Sensor Assembly (5HB06-67024 & 
5HB08-67010) on page 358

Paper Motor (CQ890-67036) on page 366

Multi-Sheet Tray SV (5HB08-67007 & 5HB12-67015) on page 425 Starwheel Assembly (5HB06-67014 & 5HB10-67010) on page 368

NVM Backup PCA (5HB06-67022) on page 328 Bridge Platen (5HB06-67012) on page 371

Out Of Paper Sensor without cable (CQ890-67102) on page 419 Belt and Pulley (CQ890-67112 & F9A30-67068) on page 374

Output Platen (5HB06-67009 & 5HB10-67007, 5HB12-67010 & 
5HB14-67007) on page 322

Encoder Strip (CQ890-67096 & CQ893-67029) on page 376

Paper Motor (CQ890-67036) on page 366 Carriage Assembly with Belt and Trailing Cable (5HB06-67001 & 
5HB10-67001) on page 380

Pinchwheels Assembly (CQ890-67060) on page 360 Carriage Line Sensor (ZIM sensor) (CQ890-67001) on page 387

Prime Pump (CQ890-67030) on page 349 Carriage Motor (5HB06-67003) on page 391

Right Cover (5HB06-67006 & 5HB12-67006) on page 303 Cables and Sensors (5HB06-67019) on page 396

Right Roll Support with Cover (5HB08-67005 & 5HB12-67017) on 
page 319

Cutter with Clutch (CQ890-67108) on page 412

Roll Cover (5HB08-67003 & 5HB10-67004, 5HB12-67004 & 
5HB14-67003) on page 311

Out Of Paper Sensor without cable (CQ890-67102) on page 419

Service Station Assembly (CQ890-67045) on page 342 Multi-Sheet Tray SV (5HB08-67007 & 5HB12-67015) on page 425

Starwheel Assembly (5HB06-67014 & 5HB10-67010) on page 368 Basket Right Cover (5HB12-67014) on page 426

Top Rear Cover (5HB12-67007 & 5HB14-67005) on page 307 Basket (5HB12-67012 & 5HB14-67009) on page 429

Top Trim (5HB06-67004 & 5HB10-67003 & 5HB12-67003, 
5HB14-67002 & 5HB12-67019 & 5HB14-67011) on page 297

Basket Left Cover (5HB12-67013) on page 434

Introduction
This chapter is a step-by-step guide to the removal and installation of the key components of the printer. Use the 
illustrations for each procedure to identify the parts referred to in the text.

NOTE: Before using this chapter to remove and install a new component, always make sure that you have 
performed the relevant service test. If the test passes you will not need to replace the component.

NOTE: We recommend that, every time a part is removed, the Line Sensor and the Encoder Strip are cleaned. 
See Clean the Carriage Line Sensor on page 439 and Clean the Encoder Strip on page 440.

NOTE: There are no parts in this printer that require calibration after installation.

IMPORTANT: It is highly recommended to review the Safety Precautions appendix before performing any 
removals or installations. This section includes General Safety Guidelines, plus specific best practices regarding 
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Electrical/Fire Hazards, Mechanical Hazards, and Electrostatic Discharge (ESD) Precautions. See Safety 
precautions on page 481.

Required tools
All the special tools and equipment required to disassemble, service, and repair the printer are provided in the 
Toolkit P/N Q6683-67001. Some tools can be ordered separately from the toolkit.

The Toolkit contains the following tools:

Table 5-1 Toolkit tools

Description/Comments HP part number

General-purpose industrial cleaner Q6675-60091

Cleaning Cloth 9300-2531

Protective Plastic Gloves Q6675-60035

Tweezers Q6675-60037

Flat screwdriver

Torx screwdriver 6, 10

Pliers

You may also need the following standard hand tools:

Table 5-2 Standard hand tools

Description/Comments Size

Long Torx Screwdriver 1/4 inch drive

Torx bit (75 mm) 15

20

Customer Self Repair parts
Some printer parts are designated Customer Self Repair (CSR) parts, which means that a faulty part can be 
replaced by the customer. Non-CSR parts need to be replaced by an engineer.

There are two categories of CSR parts:

● CSR A: Customer self-repair is mandatory, as mentioned in the printer's warranty statement. If HP is asked 
to replace such parts, the customer will be charged for travel and labor costs. Parts should be replaceable 
by end users (customers) from a mechanical perspective within 5 minutes, with simple or no tools required. 
Examples include spindles and cartridges.

● CSR B: Parts are easy to replace, but some knowledge of the printer and technical skills may be required. The 
customer can decide whether to replace the part or to call for an engineer.

The CSR parts are listed below.
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Table 5-3 CSR parts

5HB08-67006 ARSS CSR A No

5HB06-67008 Cutter Door (T200 and T600) CSR A Yes

5HB12-67009 Cutter Door (Studio) CSR A Yes

CQ890-67108 Cutter with clutch CSR A Yes

5HB08-67007 Multi-Sheet Tray SV (T200 and 
T600)

CSR A Yes

5HB12-67015 Multi-Sheet Tray SV (Studio) CSR A Yes

CQ890-67102 Out-Of-Paper Sensor without 
cable

CSR B Yes

CQ891-60022 Power Cord: AMS SV KIT CSR A No

CQ891-60023 Power Cord: APJ SV KIT CSR A No

CQ891-60021 Power Cord: EU SV KIT CSR A No

5HB08-67003 Roll Cover (T200 and T600 24in) CSR A Yes

5HB10-67004 Roll Cover (T600 36in) CSR A Yes

5HB06-67027 Spindle module SV (24in) CSR A No

5HB10-67012 Spindle module SV (36in) CSR A No

5HB08-67001 Stand Assembly (T200 and 
T600 24in)

CSR A No

5HB10-67002 Stand Assembly (T200 and 
T600 36in)

CSR A No

5HB12-67001 Stand Assembly (Studio 24in) CSR A No

5HB14-67001 Stand Assembly (Studio 36in) CSR A No

5HB08-67002 Stand Hardware Kit (T200 and 
T600 24in)

CSR A No

5HB12-67002 Stand Hardware Kit (Studio) CSR A No

5HB12-67019 Top Trim Metalic (Studio Steel 
24in)

CSR A No

5HB14-67011 Top Trim Metalic (Studio Steel 
36in)

CSR A No

5HB12-67003 Top Trim Wood (Studio 24in) CSR A No

5HB14-67002 Top Trim Wood (Studio36in) CSR A No

Copies of most of the fliers can be found in the appendices to this manual: see Flyers on page 483.

Recommended checks after replacing parts
After replacing a part, we recommend checking the status of the printer.

The basic check of the printer status is as follows:
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1. Turn on the printer and check that there is no system error.

2. Print the print-quality diagnostic report on an A4 or US Letter sheet of paper and check that there are no 
problems.

3. Load a roll of paper and perform some form feeds and cuts.

For some parts, further actions are required:

● After replacing the Main PCA, check for firmware updates and set up Web Services.

● After replacing the Service Station, perform the appropriate preventive maintenance reset.

Top Trim (5HB06-67004 & 5HB10-67003 & 5HB12-67003, 
5HB14-67002 & 5HB12-67019 & 5HB14-67011)

This section explains the removal and installation processes for this component.

Removal
The following steps provide the complete procedure for this topic.

1. Turn off the printer and disconnect the Power cable.

2. Open the Front Door.

3. Remove 3 screws.

NOTE: Only for HP DesignJet T200 & T600 Series.
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4. Close the Front Door and Open the Roll Cover.

5. Unclip the Top Trim.

a. For HP DesignJet T200&T600 Series:

36 inch: Unclip 1 clip at the Front and 4 at the Back

24 inch: Unclip 1 clip at the Front and 3 at the Back

b. For HP DesignJet Studios Series:

36 inch & 24 inch: There aren't clips, only velcros
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6. Remove the Top Trim.

Front Cover (5HB06-67010 & 5HB10-67008, 5HB12-67011 & 
5HB14-67008)

This section explains the removal and installation processes for this component.

Removal
The following steps provide the complete procedure for this topic.

1. Turn off the printer and disconnect the Power cable.

2. For HP DesignJet Studio SKUs, pull the Basket until it reaches the down position.
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3. Pull the Front Cover from the right edge, unclipping the snap, then continue unclipping the remaining snaps 
in a perpendicular direction from right to left.

4. Remove the Front Cover.

Installation
The following steps provide the complete procedure for this topic.

▲ Insert the front cover.

Cutter Door (5HB06-67008 & 5HB12-67009)
This section explains the removal and installation processes for this component.
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Removal
The following steps provide the complete procedure for this topic.

1. Turn off the printer and disconnect the Power cable.

2. Open the Front Door.

3. Remove 1 screw.

4. Remove the Cutter Door.

Left Cover (5HB06-67017 & 5HB12-67008)
This section explains the removal and installation processes for this component.
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Removal
The following steps provide the complete procedure for this topic.

1. Turn off the printer and disconnect the Power cable and LAN Cable.

2. Remove the Top Trim, see Top Trim (5HB06-67004 & 5HB10-67003 & 5HB12-67003, 5HB14-67002 & 
5HB12-67019 & 5HB14-67011) on page 297

3. Remove the Front Cover, see Front Cover (5HB06-67010 & 5HB10-67008, 5HB12-67011 & 5HB14-67008) 
on page 299

4. Remove the Cutter Door. See Cutter Door (5HB06-67008 & 5HB12-67009) on page 300.

5. Remove 3 screws.

6. Remove 2 screws.
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7. Remove 3 screws.

8. Remove the Left Cover.

Installation
The following steps provide the complete procedure for this topic.

NOTE: When installing the Left Cover, take care not to disconnect or damage the FFC cables.

Right Cover (5HB06-67006 & 5HB12-67006)
This section explains the removal and installation processes for this component.

Removal
The following steps provide the complete procedure for this topic.

1. Turn off the printer and disconnect the Power cable.

2. Remove the Top Trim, see Top Trim (5HB06-67004 & 5HB10-67003 & 5HB12-67003, 5HB14-67002 & 
5HB12-67019 & 5HB14-67011) on page 297

3. Remove the Front Cover, see Front Cover (5HB06-67010 & 5HB10-67008, 5HB12-67011 & 5HB14-67008) 
on page 299
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4. Open the Front Door.

5. Remove 3 screws.

6. Remove 2 screws.
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7. Remove 3 screws.

8. Remove the Right Cover.

Front Door (5HB06-67005 & 5HB10-67005, 5HB12-67005 & 
5HB14-67004)

This section explains the removal and installation processes for this component.

Removal
The following steps provide the complete procedure for this topic.

1. Turn off the printer and disconnect the Power cable.

2. Remove the Top Trim, see Top Trim (5HB06-67004 & 5HB10-67003 & 5HB12-67003, 5HB14-67002 & 
5HB12-67019 & 5HB14-67011) on page 297.
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3. Remove 2 screws.

4. Remove 4 screws.

NOTE: One screw has a grounding cable attached.

5. Unclip the Front Door from both sides.
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6. Remove the Front Door.

Installation
The following steps provide the complete procedure for this topic.

NOTE: Remember to screw the grounding cable.

Top Rear Cover (5HB12-67007 & 5HB14-67005)
This section explains the removal and installation processes for this component.

Removal
The following steps provide the complete procedure for this topic.

1. Turn off the printer and disconnect the Power cable.

2. Remove the Top Trim, see Top Trim (5HB06-67004 & 5HB10-67003 & 5HB12-67003, 5HB14-67002 & 
5HB12-67019 & 5HB14-67011) on page 297.
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3. Remove 2 screws.

4. Remove the Top Rear Cover.

Installation
The following steps provide the complete procedure for this topic.

▲ Please follow the steps of the Removal procedure in the reverse order.

Back Cover (CQ890-67010 & CQ893-67002)
This section explains the removal and installation processes for this component.

Removal
The following steps provide the complete procedure for this topic.

1. Turn off the printer and disconnect the Power cable.

2. Remove the Multi-Sheet Tray SV. Note that this is only necessary for for HP DesignJet T600 & Studio Series. 
See Multi-Sheet Tray SV (5HB08-67007 & 5HB12-67015) on page 425.

Remove the Rear Cover (note that this is only necessary for the HP DesignJet T200 Series).
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3. Remove 4 screws.

4. Unclip the four bottom clips.

5. Unclip the left top clip.
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6. Unclip the two top clips.

7. Rotate the Back Cover slightly and slide it to the left to remove it.

Installation
The following steps provide the complete procedure for this topic.

NOTE: Put the pins in the holes.

NOTE: When installing the Back Cover, take care not to disconnect or damage the FFC cables.
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Roll Cover (5HB08-67003 & 5HB10-67004, 5HB12-67004 & 
5HB14-67003)

This section explains the removal and installation processes for this component.

Removal
The following steps provide the complete procedure for this topic.

1. Turn off the printer and disconnect the Power cable.

2. Remove the Top Trim, see Top Trim (5HB06-67004 & 5HB10-67003 & 5HB12-67003, 5HB14-67002 & 
5HB12-67019 & 5HB14-67011) on page 297.

3. Remove the Front Cover, see Front Cover (5HB06-67010 & 5HB10-67008, 5HB12-67011 & 5HB14-67008) 
on page 299.

4. Remove the Cutter Door, see Cutter Door (5HB06-67008 & 5HB12-67009) on page 300.

5. Remove the Left Cover. See Left Cover (5HB06-67017 & 5HB12-67008) on page 301.

6. Remove the Right Cover. See Removal on page 303.

7. Close the Roll Cover.

8. Remove 3 screws.
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9. Remove 3 screws.

10. Unclip and detach the left side of the Roll Cover, bending it carefully.

CAUTION: Take care not to damage the Rewinder cables.

11. Unclip and detach the right side of the Roll Cover, bending it carefully.
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12. Remove the Roll Cover.

Installation
The following steps provide the complete procedure for this topic.

NOTE: When installing the Roll Cover, ensure that the key is correctly installed when attaching the Roll Cover to 
the Gear Damper.

Left Roll Support with Rewinder and Cover (5HB08-67004 & 
5HB12-67016)

This section explains the removal and installation processes for this component.

Removal
The following steps provide the complete procedure for this topic.

1. Turn off the printer and disconnect the power cable.

2. Remove the Top Trim, see Top Trim (5HB06-67004 & 5HB10-67003 & 5HB12-67003, 5HB14-67002 & 
5HB12-67019 & 5HB14-67011) on page 297

3. Remove the Front Cover, see Front Cover (5HB06-67010 & 5HB10-67008, 5HB12-67011 & 5HB14-67008) 
on page 299.

4. Remove the Cutter Door, see Cutter Door (5HB06-67008 & 5HB12-67009) on page 300
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5. Remove the Left Cover, see Left Cover (5HB06-67017 & 5HB12-67008) on page 301

6. Remove the Right Cover, see Right Cover (5HB06-67006 & 5HB12-67006) on page 303

7. Remove the Roll Cover, see Roll Cover (5HB08-67003 & 5HB10-67004, 5HB12-67004 & 5HB14-67003) on 
page 311

8. Remove the Spindle Module SV (5HB06-67027 & 5HB10-67012).

9. Remove the Multisheet Tray SV, see Multi-Sheet Tray SV (5HB08-67007 & 5HB12-67015) on page 425. 
Note: Only for HP DesignJet T600 & Studio Series.

Remove the Rear Cover. Note: Only for HP DesignJet T200 Series.

10. Remove the Back Cover, see Back Cover (CQ890-67010 & CQ893-67002) on page 308.

11. Remove the ARSS, see ARSS (5HB08-67006) on page 352.

12. Remove the Input Roll Guide, see Input Roll Guide (5HB06-67016 & 5HB10-67011) on page 354.

13. Disconnect the flat cable.

14. Detach the flat cable.

15. Disconnect the round cable.

CAUTION: Take care, because the small connector is easy to break.
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16. Unroute the round cable.

17. Make sure both cables are free.
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18. Unclip the Retainer Damper.

19. Remove the Retainer Damper.

20. Remove the Gear Damper.
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21. Remove 4 screws.

22. Remove three T-10 screws.

23. Rotate the Left Roll Support Cover to the left a little to detach it from the bracket.
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24. Remove the Left Roll Support, taking care not to damage the cables.

Installation
The following steps provide the complete procedure for this topic.

NOTE: Be careful to ensure that the cable routing is the same as before removal.

1. Follow the instructions to remove the left roll support in the reverse order.

2. When mounting the Left Roll Support, make sure to pass both cables through the arch.

NOTE: Check that the routing of the cables does not obstruct any moving parts or prevent any covers 
from being installed correctly.
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3. Make sure the Left Roll Support is attached inside the two holes.

NOTE: When connecting the cables to the Main PCA, make sure that the blue side of the flat cables is 
facing you; and, with the red/black cables, the red color should always be on the left.

Right Roll Support with Cover (5HB08-67005 & 5HB12-67017)
This section explains the removal and installation processes for this component.

Removal
The following steps provide the complete procedure for this topic.

1. Turn off the printer and disconnect the power cable.

2. Remove the Top Trim, see Top Trim (5HB06-67004 & 5HB10-67003 & 5HB12-67003, 5HB14-67002 & 
5HB12-67019 & 5HB14-67011) on page 297

3. Remove the Front Cover, see Front Cover (5HB06-67010 & 5HB10-67008, 5HB12-67011 & 5HB14-67008) 
on page 299.

4. Remove the Cutter Door, see Cutter Door (5HB06-67008 & 5HB12-67009) on page 300

5. Remove the Left Cover, see Left Cover (5HB06-67017 & 5HB12-67008) on page 301.

6. Remove the Right Cover, see Removal on page 303.

7. Remove the Roll Cover, see Roll Cover (5HB08-67003 & 5HB10-67004, 5HB12-67004 & 5HB14-67003) on 
page 311.

8. Remove the Spindle Module SV (5HB06-67027 & 5HB10-67012).

9. Remove the Multisheet Tray SV, see Multi-Sheet Tray SV (5HB08-67007 & 5HB12-67015) on page 425. 
Note: Only for HP DesignJet T600 & Studio Series.

Remove the Rear Cover. Note: Only for HP DesignJet T200 Series.

10. Remove the Back Cover, see Back Cover (CQ890-67010 & CQ893-67002) on page 308.

11. Remove the ARSS, see ARSS (5HB08-67006) on page 352.

12. Remove the Input Roll Guide, see Input Roll Guide (5HB06-67016 & 5HB10-67011) on page 354.
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13. Unclip the Retainer Damper.

14. Remove the Retainer Damper.

15. Remove the Gear Damper.
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16. Remove 8 screws.

17. Remove the Right Roll Support Cover.

18. Remove 2 screws.
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19. Remove the Right Roll Support.

Output Platen (5HB06-67009 & 5HB10-67007, 5HB12-67010 & 
5HB14-67007)

This section explains the removal and installation processes for this component.

Removal
The following steps provide the complete procedure for this topic.

1. Turn off the printer and disconnect the power cable.

2. Remove the Top Trim, see Top Trim (5HB06-67004 & 5HB10-67003 & 5HB12-67003, 5HB14-67002 & 
5HB12-67019 & 5HB14-67011) on page 297

3. Remove the Front Cover, see Front Cover (5HB06-67010 & 5HB10-67008, 5HB12-67011 & 5HB14-67008) 
on page 299.

4. Remove the Cutter Door, see Cutter Door (5HB06-67008 & 5HB12-67009) on page 300

5. Remove the Left Cover, see Left Cover (5HB06-67017 & 5HB12-67008) on page 301.

6. Remove the Right Cover, see Removal on page 303.

7. Pull out the left side of the Cutter Extraction Lid.
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8. Slide the Cutter Extraction Lid to the left to detach it from the hole.

9. Remove the Cutter Extraction Lid.

10. Remove the Cutter.
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11. Remove 3 screws on the left side of the Output platen.

12. Remove 3 screws on the right side.

13. Remove 6 screws.
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14. Remove 1 screw.

15. Remove the Output Platen.

Installation
The following steps provide the complete procedure for this topic.

1. There are 4 pins and locators when mounting the Output Platen.

Installation 325



2. Remember to screw down the grounding cable.

Front Panel (5HB06-67002)
This section explains the removal and installation processes for this component.

Removal
The following steps provide the complete procedure for this topic.

1. Turn off the printer and disconnect the Power cable.

2. Remove the Top Trim, see Top Trim (5HB06-67004 & 5HB10-67003 & 5HB12-67003, 5HB14-67002 & 
5HB12-67019 & 5HB14-67011) on page 297.

3. Remove the Front Cover, see Front Cover (5HB06-67010 & 5HB10-67008, 5HB12-67011 & 5HB14-67008) 
on page 299.

4. Remove the Cutter Door, see Cutter Door (5HB06-67008 & 5HB12-67009) on page 300.

5. Remove the Left Cover, see Left Cover (5HB06-67017 & 5HB12-67008) on page 301.

6. Unplug the FFC Cable.
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7. Remove 1 screw.

8. Remove the Front Panel.

Installation
The following steps provide the complete procedure for this topic.

1. Follow the instructions for removing the front panel in reverse order.

2. If the Front Panel cable is not correctly connected, the printer can sometimes start up with colors that are 
different from the normal colors (orange, blue).
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NVM Backup PCA (5HB06-67022)
This section explains the removal and installation processes for this component.

Removal
The following steps provide the complete procedure for this topic.

1. Turn off the printer and disconnect the Power cable.

2. Remove the Top Trim, see Top Trim (5HB06-67004 & 5HB10-67003 & 5HB12-67003, 5HB14-67002 & 
5HB12-67019 & 5HB14-67011) on page 297.

3. Remove the Front Cover, see Front Cover (5HB06-67010 & 5HB10-67008, 5HB12-67011 & 5HB14-67008) 
on page 299.

4. Remove the Cutter Door, see Cutter Door (5HB06-67008 & 5HB12-67009) on page 300.

5. Remove the Left Cover, see Left Cover (5HB06-67017 & 5HB12-67008) on page 301.

6. Remove 1 screw.

7. Pull out the NVM Backup PCA, without tilting it.

NOTE: Be careful not to damage it.
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Main PCA (5HB06-67018 & 5HB08-67008)
This section explains the removal and installation processes for this component.

Removal
The following steps provide the complete procedure for this topic.

1. Turn off the printer and disconnect the Power cable.

2. Remove the Top Trim, see Top Trim (5HB06-67004 & 5HB10-67003 & 5HB12-67003, 5HB14-67002 & 
5HB12-67019 & 5HB14-67011) on page 297.

3. Remove the Front Cover, see Front Cover (5HB06-67010 & 5HB10-67008, 5HB12-67011 & 5HB14-67008) 
on page 299.

4. Remove the Cutter Door, see Cutter Door (5HB06-67008 & 5HB12-67009) on page 300.

5. Remove the Left Cover, see Left Cover (5HB06-67017 & 5HB12-67008) on page 301.

6. Remove the NVM Backup PCA, see NVM Backup PCA (5HB06-67022) on page 328.

7. Disconnect the round cables.

8. Unclip the clamp.
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9. Unroute the round cables.

10. Disconnect the FFC cables.

11. Remove 2 screws.
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12. Remove 2 screws.

13. Disengage the Main PCA from the Hook and remove it.

Installation
The following steps provide the complete procedure for this topic.

CAUTION: Do not forget to reuse the NVM Backup PCA. Move the NVM Backup PCA from the original Main PCA 
to new Main PCA.

1. When mounting the Main PCA, remember to insert it in the hook.
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2. First place these two screws, because it will be easier to screw in the next two screws.

3. Push in the bracket of the Main PCA to align the two holes and screw the two screws without damaging 
them.

4. When connecting the cables to the Main PCA, make sure that the blue side of the flat cables is facing you; 
and, with the red/black cables, the red color should always be on the left.

5V Power Supply SV (CQ890-67089)
This section explains the removal and installation processes for this component.
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Removal
The following steps provide the complete procedure for this topic.

1. Turn off the printer and disconnect the Power cable.

2. Remove the Top Trim, see Top Trim (5HB06-67004 & 5HB10-67003 & 5HB12-67003, 5HB14-67002 & 
5HB12-67019 & 5HB14-67011) on page 297.

3. Remove the Front Cover, see Front Cover (5HB06-67010 & 5HB10-67008, 5HB12-67011 & 5HB14-67008) 
on page 299.

4. Remove the Cutter Door, see Cutter Door (5HB06-67008 & 5HB12-67009) on page 300.

5. Remove the Left Cover, see Left Cover (5HB06-67017 & 5HB12-67008) on page 301.

6. Disconnect the Power Supply Cable.

7. Remove 2 screws.

8. Slide the Power Supply to the side.

NOTE: Take care to not disconnect cables.
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9. Remove the Power Supply.

NOTE: Never take out the Power Supply by pulling the cable, because you will damage it.

Installation
The following steps provide the complete procedure for this topic.

▲ Follow the instructions for removing the 5V Power Supply SV in reverse order.

Left Spittoon (CQ890-67044)
This section explains the removal and installation processes for this component.
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Removal
The following steps provide the complete procedure for this topic.

1. Turn off the printer and disconnect the power cable.

2. Remove the Cutter Door, see Cutter Door (5HB06-67008 & 5HB12-67009) on page 300

3. Slide the Cutter to the right.

4. Unclip the flange of the Left Spittoon (1). Maintain it in the unclipped position and slide it up (2).

5. Slide up the Left Spittoon until it is detached from the bracket.
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6. Remove the Left Spittoon in the vertical position. You are recommended to wear gloves.

7. Never incline the Left Spittoon, because the ink can fall out.

Installation
The following steps provide the complete procedure for this topic.

1. When sliding the Left Spittoon down, make sure to slide it by the path of the bracket.
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2. Press down the Left Spittoon until you hear a click; make sure the flange is clipped.

Encoder Disk (CQ890-67033)
This section explains the removal and installation processes for this component.

Removal
The following steps provide the complete procedure for this topic.

1. Turn off the printer and disconnect the power cable.

2. Remove the Top Trim, see Top Trim (5HB06-67004 & 5HB10-67003 & 5HB12-67003, 5HB14-67002 & 
5HB12-67019 & 5HB14-67011) on page 297

3. Remove the Front Cover, see Front Cover (5HB06-67010 & 5HB10-67008, 5HB12-67011 & 5HB14-67008) 
on page 299.

4. Remove the Cutter Door, see Cutter Door (5HB06-67008 & 5HB12-67009) on page 300

5. Remove the Left Cover, see Left Cover (5HB06-67017 & 5HB12-67008) on page 301.

6. Remove the NVM Backup PCA, seee NVM Backup PCA (5HB06-67022) on page 328.

7. Remove the Main PCA, see Main PCA (5HB06-67018 & 5HB08-67008) on page 329.

8. Remove one T-10 screw.
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9. Remove the Holder Brush Feed Shaft.

10. IMPORTANT: Do not remove the Encoder Disk without checking the position of the black reference mark.

10. Rotate the Encoder Disk to a position where the black reference mark is entirely below the midpoint of the 
disk (so that it looks like a smile). 
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11. Remove the Encoder Disk by pulling it off (without moving the Roller).

Installation
The following steps provide the complete procedure for this topic.

1. Remove the film from the new Encoder Disk. IMPORTANT: Wear gloves.

2. Clean the new Encoder Disk with a lint-free cloth dampened with a general-purpose industrial cleaner to 
remove any remaining glue. Let it dry before proceeding.

3. Attach the new Encoder Disk with the black reference mark in exactly the same position as it was when you 
removed it (without moving the Roller).
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4. Make sure the Encoder Disk is firmly attached.

Bundle PCA (5HB06-67021)
This section explains the removal and installation processes for this component.

Removal
The following steps provide the complete procedure for this topic.

1. Turn off the printer and disconnect the power cable.

2. Remove the Top Trim, see Top Trim (5HB06-67004 & 5HB10-67003 & 5HB12-67003, 5HB14-67002 & 
5HB12-67019 & 5HB14-67011) on page 297

3. Remove the Front cover, see Front Cover (5HB06-67010 & 5HB10-67008, 5HB12-67011 & 5HB14-67008) 
on page 299.

4. Remove the Right Cover, see Removal on page 303.

5. Disconnect 3 motor cables.
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6. Disconnect 4 FFC (flat flexible cables) from the Bundle Board.

7. Remove 2 screws.

8. Detach the Bundle Board from the hook.
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9. Remove the Bundle Board.

Installation
The following steps provide the complete procedure for this topic.

NOTE: Remember to screw down the grounding cable.

Service Station Assembly (CQ890-67045)
This section explains the removal and installation processes for this component.

Removal
The following steps provide the complete procedure for this topic.

1. Turn off the printer and disconnet the power cable.

2. Remove the Top Trim, see Top Trim (5HB06-67004 & 5HB10-67003 & 5HB12-67003, 5HB14-67002 & 
5HB12-67019 & 5HB14-67011) on page 297

3. Remove the Front Cover, see Front Cover (5HB06-67010 & 5HB10-67008, 5HB12-67011 & 5HB14-67008) 
on page 299.

4. Remove the Right Cover, see Removal on page 303.
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5. Uncap the Carriage.

CAUTION: Avoid touching the Encoder Disk by mistake.

6. Move the Carriage to the left.

7. Disconnect the tube.

Removal 343



8. Unclip the tube.

9. Unclip the Tee Pump Prime.

10. Remove the Tee Pump Prime.

344 Chapter 5  Removal and installation



11. Disconnect the tube.

12. Disconnect the cable.

13. Disconnect the flat cable.
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14. Remove 1 screw.

15. Loosen only 1 screw.

16. Rotate the Xlimiter.
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17. Move the cap to push the Trigger.

18. Hold the Trigger and then unlock the Service Station.
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19. Push down the metal sheet and slide out the Service Station.

20. If, while you are sliding out the Service Station, there is an interaction with the metallic bracket, then you 
should push down the Service Station.

21. Remove the Service Station.

Installation
The following steps provide the complete procedure for this topic.

NOTE: Install the blue washers of the tube on the left side of the hook.
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NOTE: After the successful installation of this part, perform the Preventive Maintenance Kit Reset procedure.

Prime Pump (CQ890-67030)
This section explains the removal and installation processes for this component.

Removal
The following steps provide the complete procedure for this topic.

1. Turn off the printer and disconnect the power cable.

2. Remove the Top Trim, see Top Trim (5HB06-67004 & 5HB10-67003 & 5HB12-67003, 5HB14-67002 & 
5HB12-67019 & 5HB14-67011) on page 297

3. Remove the Front Cover, see Front Cover (5HB06-67010 & 5HB10-67008, 5HB12-67011 & 5HB14-67008) 
on page 299.

4. Remove the Right Cover, see Removal on page 303

5. Disconnect the cable from the Bundle PCA.
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6. Disconnect the tube.

7. Unclip the tube.

8. Unclip the Tee Pump Prime.
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9. Remove the Tee Pump Prime.

10. Disconnect the tube.

11. Remove 1 screw.

Removal 351



12. Remove the Prime Pump, taking care of the cables.

Installation
The following steps provide the complete procedure for this topic.

NOTE: Install the blue washers of the tube on the left side of the hook.

ARSS (5HB08-67006)
This section explains the removal and installation processes for this component.

Removal

1. Turn off the printer and disconnect the Power cable.

2. Remove the Multisheet Tray SV, see Multi-Sheet Tray SV (5HB08-67007 & 5HB12-67015) on page 425. 
Note: Only for HP DesignJet T600 & Studio Series.

Remove the Rear Cover. Note: Only for HP DesignJet T200 Series.

3. Remove the Back Cover, see Back Cover (CQ890-67010 & CQ893-67002) on page 308.
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4. Unlock the Blue Latch and keep unlocked.

5. Keep the Blue Latch unlocked and remove the Guide Roll Media Accessory.

6. Unclip the Gear ARSS Link.
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7. Remove the Gear ARSS Link.

Installation
The following steps provide the complete procedure for this topic.

▲ Follow the instructions for removing the ARSS in reverse order.

Input Roll Guide (5HB06-67016 & 5HB10-67011)
This section explains the removal and installation processes for this component.

Removal
The following steps provide the complete procedure for this topic.

1. Turn off the printer and disconnect the Power cable.

2. Remove the Top Trim, see Top Trim (5HB06-67004 & 5HB10-67003 & 5HB12-67003, 5HB14-67002 & 
5HB12-67019 & 5HB14-67011) on page 297.

3. Remove the Front Cover, see Front Cover (5HB06-67010 & 5HB10-67008, 5HB12-67011 & 5HB14-67008) 
on page 299.

4. Remove the Cutter Door, see Cutter Door (5HB06-67008 & 5HB12-67009) on page 300.

5. Remove the Left Cover, see Left Cover (5HB06-67017 & 5HB12-67008) on page 301.

6. Remove the Right Cover, see Right Cover (5HB06-67006 & 5HB12-67006) on page 303.

7. Remove the Roll Cover, see Roll Cover (5HB08-67003 & 5HB10-67004, 5HB12-67004 & 5HB14-67003) on 
page 311.

8. Remove the Spindle module SV (5HB06-67027 & 5HB10-67012).

9. Remove the Multisheet Tray SV, see Multi-Sheet Tray SV (5HB08-67007 & 5HB12-67015) on page 425. 
Note: Only for HP DesignJet T600 & Studio Series.

Remove the Rear Cover. Note: Only for HP DesignJet T200 Series.

10. Remove the Back Cover, see Back Cover (CQ890-67010 & CQ893-67002) on page 308.

11. Remove the ARSS, see ARSS (5HB08-67006) on page 352.
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12. Remove the Tape.

13. Remove 1 screw.

14. Slide the Multi-Sheet Tray Sensor Assembly sideways.
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15. Carefully leave the Multi-Sheet Tray Sensor Assembly on the structure of the printer.

16. Remove 2 screws.

17. Remove 2 screws.
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18. Lift the Input Roll Paper Guide to detach the pin from both sides.

19. Slide the Input Roll Paper Guide sideways to release both pins from the holes.

20. Rotate the Input Roll Paper Guide out and upward.
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21. Remove the Input Roll Paper Guide.

Installation
The following steps provide the complete procedure for this topic.

NOTE: When installing the Input Roll Guide, take care not to disconnect or damage the FFC cables.

Multi-Sheet Tray Sensor Assembly (5HB06-67024 & 5HB08-67010)
This section explains the removal and installation processes for this component.

Removal
The following steps provide the complete procedure for this topic.

1. Turn off the printer and disconnect the Power cable.

2. Remove the Top Trim, see Top Trim (5HB06-67004 & 5HB10-67003 & 5HB12-67003, 5HB14-67002 & 
5HB12-67019 & 5HB14-67011) on page 297.

3. Remove the Front Cover, see Front Cover (5HB06-67010 & 5HB10-67008, 5HB12-67011 & 5HB14-67008) 
on page 299.

4. Remove the Cutter Door, see Cutter Door (5HB06-67008 & 5HB12-67009) on page 300.

5. Remove the Left Cover, see Left Cover (5HB06-67017 & 5HB12-67008) on page 301.
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6. Remove the Multisheet Tray SV, see Multi-Sheet Tray SV (5HB08-67007 & 5HB12-67015) on page 425. 
Note: Only for HP DesignJet T600 & Studio Series.

Remove the Rear Cover. Note: Only for HP DesignJet T200 Series.

7. Remove the Back Cover, see Back Cover (CQ890-67010 & CQ893-67002) on page 308.

8. Disconnect the FFC Cable.

9. Unroute the FFC Cable and pass it through the ferrite.

10. Remove the Tape.
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11. Remove 1 screw.

12. Slide the Multi-Sheet Tray Sensor Assembly.

13. Remove the Multi-Sheet Tray Sensor Assembly.

Installation
The following steps provide the complete procedure for this topic.

▲ Follow the instructions for removing the Multi-Sheet Tray Sensor Assembly in reverse order.

Pinchwheels Assembly (CQ890-67060)
This section explains the removal and installation processes for this component.
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Removal
The following steps provide the complete procedure for this topic.

1. Turn off the printer and disconnect the power cable.

2. Remove the Top Trim, see Top Trim (5HB06-67004 & 5HB10-67003 & 5HB12-67003, 5HB14-67002 & 
5HB12-67019 & 5HB14-67011) on page 297

3. Remove the Front Cover, see Front Cover (5HB06-67010 & 5HB10-67008, 5HB12-67011 & 5HB14-67008) 
on page 299.

4. Remove the Cutter Door, see Cutter Door (5HB06-67008 & 5HB12-67009) on page 300

5. Remove the Left Cover, see Left Cover (5HB06-67017 & 5HB12-67008) on page 301.

6. Remove the Right Cover, see Removal on page 303.

7. Remove the Roll Cover, see Roll Cover (5HB08-67003 & 5HB10-67004, 5HB12-67004 & 5HB14-67003) on 
page 311

8. Remove the Spindle Module SV (5HB06-67027 & 5HB10-67012).

9. Remove the Multisheet Tray SV, see Multi-Sheet Tray SV (5HB08-67007 & 5HB12-67015) on page 425. 
Note: Only for HP DesignJet T600 & Studio Series.

Remove the Rear Cover. Note: Only for HP DesignJet T200 Series.

10. Remove the Back Cover, see Back Cover (CQ890-67010 & CQ893-67002) on page 308.

11. Remove the ARSS, see ARSS (5HB08-67006) on page 352.

12. Remove the Input Roll Guide, see Input Roll Guide (5HB06-67016 & 5HB10-67011) on page 354.

13. Remove the Top Rear Cover, see Top Rear Cover (5HB12-67007 & 5HB14-67005) on page 307.

14. If the damaged Pinchwheels are in the zone indicated in green below, remove the Aerosol Shields and go to 
step 22..
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15. If the damaged Pinchwheels are in the zone indicated in green below, continue with the next steps.

16. Uncap the Carriage, move it to the right, and leave it in the position indicated below.

17. Disconnect the two flat trailing cables from the Main PCA.
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18. Remove one T-10 screw.

19. Detach the flex retainer assembly from the backbone.

20. Slide the flex retainer with the trailing cable to the right. Be careful not to damage the trailing cable.
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21. Leave the flex retainer with the trailing cable in the position shown below.

22. Loosen the screws that secure the Pinchwheels.

23. Locate the tool needed to detach the springs.
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24. Detach the left end of the Pinchwheels.

25. Detach the right end of the Pinchwheels.

Remove one T-10 screw.
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26. Remove the Pinchwheels.

Installation
The following steps provide the complete procedure for this topic.

1. Make sure that the new Pinchwheels are properly aligned (1). Then tighten the screw (2).

2. Attach the spring to the hook by pushing with the tool provided.

Paper Motor (CQ890-67036)
This section explains the removal and installation processes for this component.
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Removal
The following steps provide the complete procedure for this topic.

1. Turn off the printer and disconnect the power cable.

2. Remove the Top Trim, see Top Trim (5HB06-67004 & 5HB10-67003 & 5HB12-67003, 5HB14-67002 & 
5HB12-67019 & 5HB14-67011) on page 297

3. Remove the Front Cover, Front Cover (5HB06-67010 & 5HB10-67008, 5HB12-67011 & 5HB14-67008) on 
page 299.

4. Remove the Cutter Door, see Cutter Door (5HB06-67008 & 5HB12-67009) on page 300

5. Remove the Left Cover, see Left Cover (5HB06-67017 & 5HB12-67008) on page 301.

6. Remove the NVM Backup PCA, see NVM Backup PCA (5HB06-67022) on page 328.

7. Remove the Main PCA, see Main PCA (5HB06-67018 & 5HB08-67008) on page 329.

8. Remove two screws.

9. Slide the Paper Motor inwards, and hold it with a finger to stop it falling down.
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10. Slide it out from this hole.

11. Remove the Paper Motor.

Installation
Make sure to reinstall the cable correctly. The red color should always be on the left.

▲ Follow the instructions for removing the paper motor in reverse order.

Starwheel Assembly (5HB06-67014 & 5HB10-67010)
This section explains the removal and installation processes for this component.
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There are two configurations of the Starwheel Assembly: Starwheel Assembly without metal lid (24” Model) 
and Starwheel Assembly with metal lid (36” Model). The installation/removal method are the same for both 
configurations.

NOTE: There are two T8 size screws that are used to fasten a pair of plastic deflectors to the Starwheel 
Assembly located near the ends of both sides of the Assembly:

It is important to keep it at the factory state and avoid over/under tightening, which can affect the localized 
controlled deflection role of the Starwheel Assembly.

Removal
The following steps provide the complete procedure for this topic.

1. Turn off the printer and disconnect the power cable.

2. Remove the Top Trim, see Top Trim (5HB06-67004 & 5HB10-67003 & 5HB12-67003, 5HB14-67002 & 
5HB12-67019 & 5HB14-67011) on page 297
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3. Remove the Front Cover, see Front Cover (5HB06-67010 & 5HB10-67008, 5HB12-67011 & 5HB14-67008) 
on page 299.

4. Remove the Cutter Door, see Cutter Door (5HB06-67008 & 5HB12-67009) on page 300

5. Remove the Left Cover, see Left Cover (5HB06-67017 & 5HB12-67008) on page 301.

6. Remove the Right Cover, see Removal on page 303.

7. Remove one T-10 screw on the left side of the Starwheel Assembly.

8. Remove one T-10 screw on the right side of the Starwheel Assembly.

9. Detach the Starwheel Assembly from the two hooks by sliding it up.
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10. Remove the Starwheel Assembly.

Installation
When installing the Starwheel Assembly, make sure it is located correctly on the hooks.

▲ Follow the instructions for removing the starwheel assembly in reverese order.

Bridge Platen (5HB06-67012)
This section explains the removal and installation processes for this component.

Removal
The following steps provide the complete procedure for this topic.

1. Turn off the printer and disconnect the power cable.

2. Remove the Top Trim, see Top Trim (5HB06-67004 & 5HB10-67003 & 5HB12-67003, 5HB14-67002 & 
5HB12-67019 & 5HB14-67011) on page 297

3. Remove the Front Cover, see Front Cover (5HB06-67010 & 5HB10-67008, 5HB12-67011 & 5HB14-67008) 
on page 299.

4. Remove the Cutter Door, see Cutter Door (5HB06-67008 & 5HB12-67009) on page 300

5. Remove the Left Cover, see Left Cover (5HB06-67017 & 5HB12-67008) on page 301

6. Remove the Right Cover, see Right Cover (5HB06-67006 & 5HB12-67006) on page 303
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7. Remove the Roll Cover, see Roll Cover (5HB08-67003 & 5HB10-67004, 5HB12-67004 & 5HB14-67003) on 
page 311

8. Remove the Spindle Module SV (5HB06-67027 & 5HB10-67012).

9. Remove the Multisheet Tray SV, see Multi-Sheet Tray SV (5HB08-67007 & 5HB12-67015) on page 425. 
Note: Only for HP DesignJet T600 & Studio Series.

Remove the Rear Cover. Note: Only for HP DesignJet T200 Series.

10. Remove the Back Cover, see Back Cover (CQ890-67010 & CQ893-67002) on page 308.

11. Remove the ARSS, see ARSS (5HB08-67006) on page 352.

12. Remove the Input Roll Guide, see Input Roll Guide (5HB06-67016 & 5HB10-67011) on page 354.

13. Remove the Right Roll Support with Cover, see Right Roll Support with Cover (5HB08-67005 & 
5HB12-67017) on page 319.

14. Remove the Top Rear Cover, see Top Rear Cover (5HB12-67007 & 5HB14-67005) on page 307.

15. Remove the Service Station Assembly, see Service Station Assembly (CQ890-67045) on page 342.

16. Remove the Prime Pump, see Prime Pump (CQ890-67030) on page 349.

17. Remove the Bundle PCA, see Bundle PCA (5HB06-67021) on page 340.

18. Remove 3 screws.

19. Remove the Guide Base Right.
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20. Unroute the FFC cable.

21. Remove 2 screws.

22. Remove 3 screws.
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23. Remove 2 screws on the top.

24. Remove 1 screw on the back.

25. Remove the bridge platen while holding the arch for better access.

Belt and Pulley (CQ890-67112 & F9A30-67068)
This section explains the removal and installation processes for this component.

Removal
The following steps provide the complete procedure for this topic.
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1. Turn off the printer and disconnect the power cable.

2. Remove the Top Trim, see Top Trim (5HB06-67004 & 5HB10-67003 & 5HB12-67003, 5HB14-67002 & 
5HB12-67019 & 5HB14-67011) on page 297

3. Remove the Front Cover, see Front Cover (5HB06-67010 & 5HB10-67008, 5HB12-67011 & 5HB14-67008) 
on page 299.

4. Remove the Right Cover, see Removal on page 303.

5. Remove the Cutter Door, see Cutter Door (5HB06-67008 & 5HB12-67009) on page 300

6. Remove the Left Cover, see Left Cover (5HB06-67017 & 5HB12-67008) on page 301.

7. Remove the Front Door, see Front Door (5HB06-67005 & 5HB10-67005, 5HB12-67005 & 5HB14-67004) 
on page 305.

8. Remove the Top Rear Cover, see Top Rear Cover (5HB12-67007 & 5HB14-67005) on page 307.

9. Remove the Service Station Assembly, see Service Station Assembly (CQ890-67045) on page 342.

10. Do not touch the Service Station's Encoder Disk when handling the Service Station.

11. Remove the Encoder Strip, see Encoder Strip (CQ890-67096 & CQ893-67029) on page 376.

12. Remove the Ink Cartridges and the Printhead Assembly.

13. Remove the Carriage Assembly with Belt and Trailing Cable, see Carriage assembly on page 278.

14. Rotate the Carriage to see the bottom side.

15. Slide the Carriage Belt.
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16. Remove the Carriage Belt.

NOTE: After the successful installation of this part, perform the Preventive Maintenance Kit Reset 
procedure.

Installation
The following steps provide the complete procedure for this topic.

▲ Please follow the steps of the Removal procedure in the reverse order.

Encoder Strip (CQ890-67096 & CQ893-67029)
This section explains the removal and installation processes for this component.

Removal
The following steps provide the complete procedure for this topic.

1. Turn off the printer and disconnect the power cable.

2. Remove the Top Trim, see Top Trim (5HB06-67004 & 5HB10-67003 & 5HB12-67003, 5HB14-67002 & 
5HB12-67019 & 5HB14-67011) on page 297

3. Remove the Front Cover, see Front Cover (5HB06-67010 & 5HB10-67008, 5HB12-67011 & 5HB14-67008) 
on page 299.

4. Remove the Right Cover, see Removal on page 303.

5. Remove the Cutter Door, see Cutter Door (5HB06-67008 & 5HB12-67009) on page 300

6. Insert some paper (of any type) to prevent grease or dirt from falling into the printer.

NOTE: When working in this area, in which dirt and grease can contaminate other parts of the printer, we 
recommend wearing gloves.
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7. Uncap the Carriage and move it to the left.

8. Detach the spring.

CAUTION: The Encoder Strip must not come into contact with the slider rod grease! Handle with care, and 
be careful with your hands and the Encoder Strip.

CAUTION: The primer pipe at the end plate can become damaged.
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9. Rotate the Encoder Strip a little to detach it from the hook.

10. Detach the Encoder Strip from the hook.

11. Slide the Encoder Strip carefully from the right side, and remove it.

Installation
The following steps provide the complete procedure for this topic.

1. Move the Carriage to cap position.
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2. Pass the Encoder Strip through the hole of the bracket. Very important: The face is shown here:

NOTE: The Encoder Strip must be inserted from the right side of the Carriage into the left side.

3. Pass the Encoder Strip through the hole of the Carriage, taking care not to bend it.

4. The Encoder Strip should go out through the other side of the Carriage as shown.
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5. The right end of the Encoder Strip must have the triangle in the position as shown below.

6. When you attach the left end of the Encoder Strip to the hook, make sure the position of the face is as 
shown in the following image:

7. Attach the Encoder Strip at the left before attaching the spring at the right.

Carriage Assembly with Belt and Trailing Cable (5HB06-67001 & 
5HB10-67001)

This section explains the removal and installation processes for this component.

Removal
The following steps provide the complete procedure for this topic.

CAUTION: Do not remove the trailing cable from carriage. The trailing cable is well-aligned in factory and is not 
a field replaceable part. Replace the whole carriage instead of a single trailing cable.

1. Turn off the printer and disconnect the power cable.

2. Remove the Top Trim, see Top Trim (5HB06-67004 & 5HB10-67003 & 5HB12-67003, 5HB14-67002 & 
5HB12-67019 & 5HB14-67011) on page 297

3. Remove the Front Cover, see Front Cover (5HB06-67010 & 5HB10-67008, 5HB12-67011 & 5HB14-67008) 
on page 299.
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4. Remove the Right Cover, see Right Cover (5HB06-67006 & 5HB12-67006) on page 303

5. Remove the Cutter Door, see Cutter Door (5HB06-67008 & 5HB12-67009) on page 300

6. Remove the Left Cover, see Left Cover (5HB06-67017 & 5HB12-67008) on page 301

7. Remove the Front Door, see Front Door (5HB06-67005 & 5HB10-67005, 5HB12-67005 & 5HB14-67004) 
on page 305.

8. Remove the Top Rear Cover, see Top Rear Cover (5HB12-67007 & 5HB14-67005) on page 307.

9. Remove the Service Station Assembly, see Service Station Assembly (CQ890-67045) on page 342.

TIP: Do not touch the Service Station's Encoder Disk when handling the Service Station.

10. Remove the Encoder Strip, see Encoder Strip (CQ890-67096 & CQ893-67029) on page 376.

11. Remove the Ink Cartridges and the Printhead Assembly.

12. Make sure the Carriage is in this position.

13. Disconnect the two flat cables from the PCA.
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14. Remove one T-15 screw from the left side.

15. Unclip the trailing cable retainer clip shown here (1) and slide it to the right (2).

16. Slide the right backbone end plate to the right.
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17. Leave the right backbone on the platen.

18. Remove two T-10 screws from the Right End Plate.

19. Remove the Right End Plate.
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20. Unhook the Carriage Belt with a finger and lift it away.

21. Remove the Carriage Belt from the end pulley.

22. Remove one T-15 screw.
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23. Unclip the pulley latch shown here (1) and slide it to the right (2).

24. Remove the pulley latch.

25. Pull the latch down.
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26. Slide the Carriage, the Belt, and the Trailing Cable to the right.

27. Remove the Carriage Assembly.

Installation
The following steps provide the complete procedure for this topic.

1. To reinstall the Belt, use a screwdriver to lever the Belt back on.

2. When installing the Carriage Assembly, make sure you slide the part indicated here onto the slider rod. 

3. When the installation is complete, clean the Encoder Strip (see Clean the Encoder Strip on page 440) and 
the Line Sensor (see Clean the Carriage Line Sensor on page 439).
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Carriage Line Sensor (ZIM sensor) (CQ890-67001)
This section explains the removal and installation processes for this component.

Removal
The following steps provide the complete procedure for this topic.

1. Turn off the printer and disconnect the power cable.

2. Remove the Top Trim, see Top Trim (5HB06-67004 & 5HB10-67003 & 5HB12-67003, 5HB14-67002 & 
5HB12-67019 & 5HB14-67011) on page 297

3. Remove the Front Cover, see Front Cover (5HB06-67010 & 5HB10-67008, 5HB12-67011 & 5HB14-67008) 
on page 299.

4. Remove the Right Cover, see Right Cover (5HB06-67006 & 5HB12-67006) on page 303

5. Make sure the Carriage is located in the right position.

6. Detach the right side of the Cover PCA Carriage.
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7. Remove the Cover PCA Carriage.

8. Disconnect the flat cable.

9. Uncap the carriage.

IMPORTANT: If the Carriage is in the capped position, move the Service Station gear clockwise to uncap it.
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10. Move the Carriage slightly to allow access to the Carriage Line Sensor, maintain a separation of 4 cm.

11. Remove one screw.

CAUTION: Make sure that the screw does not fall down into the Service Station.

12. Open the Carriage latch upwards to allow access to the Carriage Line Sensor.
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13. Detach the Line Sensor from the Carriage.

14. Remove the Carriage Line Sensor.

Installation
The following steps provide the complete procedure for this topic.

1. Make sure to introduce the end of the Carriage Line Sensor into the hole in the Carriage.

2. Follow the instructions for removing the Carriage Line Sensor in reverse order.

3. Before putting the covers back on, clean the Carriage Line Sensor.
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Carriage Motor (5HB06-67003)
This section explains the removal and installation processes for this component.

Removal
The following steps provide the complete procedure for this topic.

1. Turn off the printer and disconnect the power cable.

2. Remove the Top Trim, see Top Trim (5HB06-67004 & 5HB10-67003 & 5HB12-67003, 5HB14-67002 & 
5HB12-67019 & 5HB14-67011) on page 297

3. Remove the Front Cover, see Front Cover (5HB06-67010 & 5HB10-67008, 5HB12-67011 & 5HB14-67008) 
on page 299.

4. Remove the Cutter Door, see Cutter Door (5HB06-67008 & 5HB12-67009) on page 300

5. Remove the Left Cover, see Left Cover (5HB06-67017 & 5HB12-67008) on page 301

6. Remove the Front Panel, see Front Panel (5HB06-67002) on page 326.

7. Disconnect the Carriage Motor Cable.

8. Unclip it from the holder in the chassis.
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9. Remove the Carriage Motor Cable.

10. Slide the Cutter to the right.

11. Leave the Cutter in that position.
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12. Insert some paper (of any type) to prevent grease or dirt from falling into the printer.

13. Rotate the Encoder Strip a little bit to detach it from the hook.

14. Detach the Encoder Strip from the hook.
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15. Leave the Encoder Strip on the Output Platen.

16. Keep the screwdriver inserted while levering and at the same time releasing the left end of the Belt from the 
Carriage Pulley Motor.

17. Remove the Carriage Belt from the pulley.
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18. Remove two T-15 screws.

19. Rotate the Carriage Motor to have better access to it.

20. Remove the Carriage Motor.

Installation
The following steps provide the complete procedure for this topic.
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▲ When you attach the left end of the Encoder Strip to the hook, make sure the position of the face is as 
shown below.

Cables and Sensors (5HB06-67019)
This section explains the removal and installation processes for these components.

Table 5-4

Parts in alphabetical order Parts in removal order

Assy PBB to MPCA FFC 36in (5HB10-60066) / Assy PBB to MPCA FFC 
24in (5HB06-60099) on page 403

Encoder PCA (CQ890-60204) and Index (CM751-60021) on page 
396

Door sensor PCA - ESD (F9A30-60262) on page 408 FFC-Paper-Feed-Sensors (CQ890-80014) on page 399

Encoder PCA (CQ890-60204) and Index (CM751-60021) on page 
396

Out-Of-Paper Sensor TL Assembly (5HB06-60066) on page 400

FFC Airprint to MPCA 24in (5HB06-60026) / FFC Airprint to MPCA 
36in (5HB10-60008) on page 411

Assy PBB to MPCA FFC 36in (5HB10-60066) / Assy PBB to MPCA FFC 
24in (5HB06-60099) on page 403

FFC Front Window to MPCA (5HB06-50001) on page 409 Door sensor PCA - ESD (F9A30-60262) on page 408

FFC-Paper-Feed-Sensors (CQ890-80014) on page 399 FFC Front Window to MPCA (5HB06-50001) on page 409

Out-Of-Paper Sensor TL Assembly (5HB06-60066) on page 400 FFC Airprint to MPCA 24in (5HB06-60026) / FFC Airprint to MPCA 
36in (5HB10-60008) on page 411

Encoder PCA (CQ890-60204) and Index (CM751-60021)
This section explains the removal and installation processes for this component.

Removal
The following steps provide the complete procedure for this topic.

1. Turn off the printer and disconnect the power cable.

2. Remove the Top Trim, see Top Trim (5HB06-67004 & 5HB10-67003 & 5HB12-67003, 5HB14-67002 & 
5HB12-67019 & 5HB14-67011) on page 297

3. Remove the Front Cover, see Front Cover (5HB06-67010 & 5HB10-67008, 5HB12-67011 & 5HB14-67008) 
on page 299.
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4. Remove the Cutter Door, see Cutter Door (5HB06-67008 & 5HB12-67009) on page 300

5. Remove the Left Cover, see Left Cover (5HB06-67017 & 5HB12-67008) on page 301

6. Remove the Main PCA, see Main PCA (5HB06-67018 & 5HB08-67008) on page 329.

7. Remove one screw.

CAUTION: Be careful not to damage the Encoder Disk.

8. Release the Encoder PCA from the pin or locator.

9. Rotate the Encoder PCA to see the connector.
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10. Disconnect the flat cable.

11. Remove one screw from the Index PCA.

CAUTION: Be careful not to damage the Encoder Disk.

12. Release the Index PCA from the pin or locator.
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13. Disconnect the flat cable.

Installation
The following steps provide the complete procedure for this topic.

1. Be careful not to damage the Encoder Strip when you mount the two PCAs.

2. When connecting the cables to the PCAs, make sure that the blue side of the flat cables is facing up.

FFC-Paper-Feed-Sensors (CQ890-80014)
This section explains the removal and installation processes for this component.
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Removal
The following steps provide the complete procedure for this topic.

1. Turn off the printer and disconnect the power cable.

2. Remove the Top Trim, see Top Trim (5HB06-67004 & 5HB10-67003 & 5HB12-67003, 5HB14-67002 & 
5HB12-67019 & 5HB14-67011) on page 297

3. Remove the Front Cover, see Front Cover (5HB06-67010 & 5HB10-67008, 5HB12-67011 & 5HB14-67008) 
on page 299.

4. Remove the Cutter Door, see Cutter Door (5HB06-67008 & 5HB12-67009) on page 300

5. Remove the Left Cover, see Left Cover (5HB06-67017 & 5HB12-67008) on page 301

6. Remove the Main PCA, see Main PCA (5HB06-67018 & 5HB08-67008) on page 329.

7. Disconnect the flat cable from the Encoder PCA and from the Index sensor.

Installation
The following steps provide the complete procedure for this topic.

▲ When connecting the cables to the PCAs, make sure that the blue side of the flat cables is facing up.

Out-Of-Paper Sensor TL Assembly (5HB06-60066)
This section explains the removal and installation processes for this component.
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Removal
The following steps provide the complete procedure for this topic.

1. Turn off the printer and disconnect the Power cable.

2. Remove the Top Trim, see Top Trim (5HB06-67004 & 5HB10-67003 & 5HB12-67003, 5HB14-67002 & 
5HB12-67019 & 5HB14-67011) on page 297.

3. Remove the Front Cover, see Front Cover (5HB06-67010 & 5HB10-67008, 5HB12-67011 & 5HB14-67008) 
on page 299.

4. Remove the Right Cover, see Removal on page 303.

5. Remove the Multi-sheet Tray SV, see Multi-Sheet Tray SV (5HB08-67007 & 5HB12-67015) on page 425. 
Note: only for HP DesignJet T600 & Studio Series.

Remove the Rear Cover. Note: Only for HP DesignJet T200 Series.

6. Remove the Back Cover, see Back Cover (CQ890-67010 & CQ893-67002) on page 308.

7. Remove the Out-Of-Paper Sensor without cable, see Out Of Paper Sensor without cable (CQ890-67102) on 
page 419.

8. Unclip the locator FFC. 

9. Disconnect the Out-Of-Paper Sensor Cable from the Bundle Board.
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10. Unroute the Out-Of-Paper Sensor Cable through the hook.

11. Remove the Out-Of-Paper Sensor Cable. 

Installation
Follow these steps when installing the Out-Of-Paper Sensor Cable.

1. When you pass the Out-Of-Paper Sensor Cable through the hook, make sure that the blue end of the cable 
is facing you.

2. Follow the instructions for removing the Out Of Paper Sensor cable in reverse order.
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Assy PBB to MPCA FFC 36in (5HB10-60066) / Assy PBB to MPCA FFC 24in 
(5HB06-60099)

This section explains the removal and installation processes for this component.

Removal
The following steps provide the complete procedure for this topic.

1. Turn off the printer and disconnect the power cable.

2. Remove the Top Trim, see Top Trim (5HB06-67004 & 5HB10-67003 & 5HB12-67003, 5HB14-67002 & 
5HB12-67019 & 5HB14-67011) on page 297.

3. Remove the Front Cover, see Front Cover (5HB06-67010 & 5HB10-67008, 5HB12-67011 & 5HB14-67008) 
on page 299.

4. Remove the Cutter Door, see Cutter Door (5HB06-67008 & 5HB12-67009) on page 300.

5. Remove the Left Cover, see Left Cover (5HB06-67017 & 5HB12-67008) on page 301

6. Remove the Right Cover, see Removal on page 303.

7. Remove the Multisheet Tray SV, see Multi-Sheet Tray SV (5HB08-67007 & 5HB12-67015) on page 425. 
Note: Only for HP DesignJet T600 & Studio Series.

Remove the Rear Cover. Note: Only for HP DesignJet T200 Series.

8. Remove the Back Cover, see Back Cover (CQ890-67010 & CQ893-67002) on page 308.

9. Disconnect the FFC cable from the Bundle Board.
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10. Unclip the two locators FFC, by first pushing up and pushing out.

11. Unroute the Bundle Board Cable FFC.

12. Unclip the locators FFC.

● 3 clips in the 24 inch printer

● 4 clips in the 36 inch printer
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13. Carefully remove the FFC from the hook of the left arch.

14. Disconnect the Bundle Board cable FFC from the Main PCA.

15. Remove the tape.
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16. Carefully remove the FFC from the 2 hooks of the left arch, and remove the FFC cable.

Installation
The following steps provide the complete procedure for this topic.

1. When re-installing the Bundle FFC into the hooks of the left arch, orient the FFC inclined as in the following 
image. Make sure to assemble the Bundle Ferrite in the same position close to the Bundle Board.

NOTE: When re-installing the Bundle FFC, hook each clamp first on the upper clip and then push on the 
bottom area.

2. Unclip to remove the ferrite of the right arch.
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3. Remove the ferrite.

4. Route the Bundle FFC. Re-install the Bundle FFC in exactly the same place where the ferrite was.

5. Pass the ferrite through the FFC.
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6. Attach the ferrite to the right arch.

Door sensor PCA - ESD (F9A30-60262)
This section explains the removal and installation processes for this component.

Removal
The following steps provide the complete procedure for this topic.

1. Turn off the printer and disconnect the power cable.

2. Remove the Cutter Door, see Cutter Door (5HB06-67008 & 5HB12-67009) on page 300

3. Remove 1 screw.
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4. Carefully slide the sensor and disconnect the cable.

5. Remove the sensor.

Installation
The following steps provide the complete procedure for this topic.

▲ When connecting the cables to the PCAs, make sure that the blue side of the flat cables is facing down.

FFC Front Window to MPCA (5HB06-50001)
This section explains the removal and installation processes for this component.
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Removal
The following steps provide the complete procedure for this topic.

1. Turn off the printer and disconnect the power cable.

2. Remove the Top Trim, see Top Trim (5HB06-67004 & 5HB10-67003 & 5HB12-67003, 5HB14-67002 & 
5HB12-67019 & 5HB14-67011) on page 297

3. Remove the Front Cover, see Front Cover (5HB06-67010 & 5HB10-67008, 5HB12-67011 & 5HB14-67008) 
on page 299.

4. Remove the Cutter Door, see Cutter Door (5HB06-67008 & 5HB12-67009) on page 300

5. Remove the Left Cover, see Left Cover (5HB06-67017 & 5HB12-67008) on page 301

6. Remove the Door Sensor PCA - ESD, see Door sensor PCA - ESD (F9A30-60262) on page 408.

7. Unroute the cable and unclip the locator FFC.

8. Unroute the FFC Front Window to MPCA cable through the hooks.
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9. Disconnect the flat cable and remove the cable.

FFC Airprint to MPCA 24in (5HB06-60026) / FFC Airprint to MPCA 36in (5HB10-60008)
This section explains the removal and installation processes for this component.

Removal
The following steps provide the complete procedure for this topic.

1. Turn off the printer and disconnect the power cable.

2. Remove the Top Trim, see Top Trim (5HB06-67004 & 5HB10-67003 & 5HB12-67003, 5HB14-67002 & 
5HB12-67019 & 5HB14-67011) on page 297.

3. Remove the Front Cover, see Front Cover (5HB06-67010 & 5HB10-67008, 5HB12-67011 & 5HB14-67008) 
on page 299.

4. Remove the Cutter Door, see Cutter Door (5HB06-67008 & 5HB12-67009) on page 300.

5. Remove the Left Cover, see Left Cover (5HB06-67017 & 5HB12-67008) on page 301

6. Remove the Multisheet Tray SV, see Multi-Sheet Tray SV (5HB08-67007 & 5HB12-67015) on page 425. 
Note: Only for HP DesignJet T600 & Studio Series.

Remove the Rear Cover. Note: Only for HP DesignJet T200 Series.

7. Remove the Back Cover, see Back Cover (CQ890-67010 & CQ893-67002) on page 308.

8. Remove the Multi-Sheet Tray Sensor Assembly, Multi-Sheet Tray Sensor Assembly (5HB06-67024 & 
5HB08-67010) on page 358.
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9. Disconnect the flat cable and remove the cable.

Cutter with Clutch (CQ890-67108)

Cutter
This section explains the removal and installation processes for this component.

Removal
The following steps provide the complete procedure for this topic.

1. Turn off the printer and disconnect the power cable.

2. Remove the Top Trim, see Top Trim (5HB06-67004 & 5HB10-67003 & 5HB12-67003, 5HB14-67002 & 
5HB12-67019 & 5HB14-67011) on page 297

3. Remove the Front Cover, see Front Cover (5HB06-67010 & 5HB10-67008, 5HB12-67011 & 5HB14-67008) 
on page 299.

4. Remove the Cutter Door, see Cutter Door (5HB06-67008 & 5HB12-67009) on page 300

5. Pull out the left side of the Cutter Extraction Lid.
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6. Slide the Cutter Extraction Lid to the left to detach it from the hole.

7. Remove the Cutter Extraction Lid.

8. Remove the Cutter.

Installation
The following steps provide the complete procedure for this topic.
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1. Mount the Cutter.

2. Make sure that the cutter gears keep below the cutter guide rack.

3. The cutter gears should engage perfectly with the cutter guide.
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4. Move the Cutter to the right.

5. Introduce the Cutter Extraction Lid into the hole.

Cutter Bridge
This section explains the removal and installation processes for this component.

The Cutter Bridge is attached to the front of the Carriage. The arrangement of the cutter bridge to the carriage 
can be seen in the following image:
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Removal
The following steps provide the complete procedure for this topic.

1. Turn off the printer and disconnect the power cable.

2. Remove the Top Trim, see Top Trim (5HB06-67004 & 5HB10-67003 & 5HB12-67003, 5HB14-67002 & 
5HB12-67019 & 5HB14-67011) on page 297

3. Remove the Ink Cartridges and the Printhead Assembly.

4. Open the Front Door.

5. Ensure that the Carriage is in the center of the Platen, where you can easily access it.
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6. Use the tool provided with the Cutter Assembly Kit to lever up the two prongs attaching the Cutter Bridge to 
the right-hand side of the Carriage.

7. Use the tool again to lever up the two prongs attaching the Cutter Bridge to the left-hand side of the 
Carriage.

8. Remove the Cutter Bridge.

Installation
The following steps provide the complete procedure for this topic.
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1. Position the new Cutter Bridge above the Carriage and press down.

2. The Cutter Bridge is designed to fit over features of the Carriage.
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3. Use the tool provided with the Cutter Assembly Kit to press each of the four prongs attaching the Cutter 
Bridge to the Carriage, and make sure that all of them are correctly engaged; otherwise the Cutter may not 
work correctly.

Out Of Paper Sensor without cable (CQ890-67102)
This section explains the removal and installation processes for this component.

Removal
The following steps provide the complete procedure for this topic.

1. Turn off the printer and disconnect the power cable.

2. Remove the Multisheet Tray SV, see Multi-Sheet Tray SV (5HB08-67007 & 5HB12-67015) on page 425. 
Note: Only for HP DesignJet T600 & Studio Series.

Remove the Rear Cover. Note: Only for HP DesignJet T200 Series.

3. Locate the Out-Of-Paper Sensor.
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4. Unclip the Out-Of-Paper Sensor FFC Cover.

5. Slide the Out-Of-Paper Sensor FFC Cover.

6. Lift up (1) the Out-Of-Paper Sensor FFC Cover and slide it to the left (2).
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7. Press the retaining clips of the Out-Of-Paper Sensor Assembly. 

8. Slide out the Out-Of-Paper Sensor Assembly. 

9. Partically unstick the tape.
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10. Turn over the Out-Of-Paper Sensor Assembly to get better access to the connector.

11. Disconnect the Out-Of-Paper Sensor cable. 

12. Remove the Out-Of-Paper Sensor Assembly. 

Installation
The following steps provide the complete procedure for this topic.

1. Please follow the steps of the Removal procedure in the reverse order.
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2. Partially unstick the tape, to install the cable.

3. Route the cable.

4. Connect the FFC cable.
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5. Stick down the tape.

6. Replace the Out-Of-Paper Sensor Assembly.

7. Press to install.
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8. Install the Out-Of-Paper Sensor FFC Cover.

9. Slide in and clip the Out-Of-Paper Sensor FFC Cover.

10. The Out-Of-Paper Sensor is correctly installed.

Multi-Sheet Tray SV (5HB08-67007 & 5HB12-67015)
This section explains the removal and installation processes for this component.

Removal
The following steps provide the complete procedure for this topic.
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1. Turn off the printer and disconnect the Power cable.

2. Unlock the Multi-Sheet Tray Assembly.

3. Pull out the Multi-Sheet Tray Assembly.

Installation
The following steps provide the complete procedure for this topic.

▲ Please follow the steps of the Removal procedure in the reverse order.

Basket Right Cover (5HB12-67014)
This section explains the removal and installation processes for this component.

Removal
The following steps provide the complete procedure for this topic.

1. Turn off the printer and disconnect the Power cable.

2. Remove the Top Trim (5HB06-67004 & 5HB10-67003 & 5HB12-67003, 5HB14-67002 & 5HB12-67019 & 
5HB14-67011) on page 297.

3. Remove the Front Cover (5HB06-67010 & 5HB10-67008, 5HB12-67011 & 5HB14-67008) on page 299.

4. Remove the Right Cover (5HB06-67006 & 5HB12-67006) on page 303.
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5. Remove the Service Station Assembly (CQ890-67045) on page 342.

6. Pull the Basket until it reaches the down position.

7. Remove 2 screws. Please keep the screws to assemble the stand later.

8. Align the Basket lifter part with the stand. First you have to lift the printer.

Removal 427



9. Locate the Basket lifter and align the part with the stand.

10. Remove 2 screws at the back.

11. Remove 1 screw from the front.
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12. Pull the cover toward the back.

13. Pull down the cover and remove.

Installation
The following steps provide the complete procedure for this topic.

▲ Please follow the steps of the Removal procedure in the reverse order.

Basket (5HB12-67012 & 5HB14-67009)
This section explains the removal and installation processes for this component.

Removal
The following steps provide the complete procedure for this topic.

1. Turn off the printer and disconnect the Power cable.

2. Remove the Top Trim (5HB06-67004 & 5HB10-67003 & 5HB12-67003, 5HB14-67002 & 5HB12-67019 & 
5HB14-67011) on page 297.

3. Remove the Front Cover (5HB06-67010 & 5HB10-67008, 5HB12-67011 & 5HB14-67008) on page 299.

4. Remove the Right Cover (5HB06-67006 & 5HB12-67006) on page 303.

5. Remove the Service Station Assembly (CQ890-67045) on page 342.
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6. Remove the Basket Right Cover (5HB12-67014) on page 426.

7. Remove 3 screws.

8. Unclip the telescopic support.

9. Remove the telescopic support.
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10. Once you remove the cover on this side, lift the printer and remove the Basket lifter.

11. Put back 2 screws to fix the printer to the stand. This is very important, because if the printer is not fixed it 
could be dislodged by any movement.

12. Remove the Cutter Door (5HB06-67008 & 5HB12-67009) on page 300.

13. Remove the Left Cover (5HB06-67017 & 5HB12-67008) on page 301.

14. Remove the 5V Power Supply SV (CQ890-67089) on page 332.

15. Remove the Basket Left Cover (5HB12-67013) on page 434.

16. Remove the Front Panel (5HB06-67002) on page 326.

17. Remove 3 screws. Move the cutter to have better access to the screws.
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18. Unclip the telecopic support.

19. Remove the telecopic support.

20. Once you remove the cover on this side, lift the printer and remove the Basket lifter.
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21. Put back 2 screws to fix the printer to the stand. This is very important, because if the printer is not fixed it 
could be dislodged by any movement.

22. Remove 2 screws on the left side.

23. Move the support to unclip and remove the support and the Self Folding Fabric Mechanism Roll from the left 
side.
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24. Remove the Self Folding Fabric Mechanism Roll from the right side.

25. Remove 2 screws.

26. Remove the support.

Installation
The following steps provide the complete procedure for this topic.

▲ Please follow the steps of the Removal procedure in the reverse order.

Basket Left Cover (5HB12-67013)
This section explains the removal and installation processes for this component.
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Removal
The following steps provide the complete procedure for this topic.

1. Turn off the printer and disconnect the Power cable.

2. Remove the Top Trim (5HB06-67004 & 5HB10-67003 & 5HB12-67003, 5HB14-67002 & 5HB12-67019 & 
5HB14-67011) on page 297.

3. Remove the Front Cover (5HB06-67010 & 5HB10-67008, 5HB12-67011 & 5HB14-67008) on page 299.

4. Remove the Cutter Door (5HB06-67008 & 5HB12-67009) on page 300.

5. Remove the Left Cover (5HB06-67017 & 5HB12-67008) on page 301.

6. Remove the 5V Power Supply SV (CQ890-67089) on page 332.

7. Pull the Basket until it reaches the down position.

8. Remove 2 screws. Please keep the screws to assemble the stand later.
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9. Align the Basket lifter part with the stand. First you have to lift the printer.

10. Locate the Basket lifter and align the part with the stand.

11. Remove 2 screws at the back.
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12. Remove 1 screw from the front.

13. Pull the cover toward the back.

14. Pull down the cover and remove.

Installation
The following steps provide the complete procedure for this topic.

▲ Please follow the steps of the Removal procedure in the reverse order.
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Preventive maintenance6

This chapter provides guidance for ensuring that your printer retains optimal performance conditions once usage 
has begun.

Preventive maintenance processes
This section includes instructions for cleaning the carriage line sensor, encoder strip,, and the printer exterior, plus 
prodedures regarding carriage assembly lubrication, moisture accumulation, and considerations on the level of 
printer usage.

Clean the printer
To maintain the printer in good operating condition, keep it free of accumulated dust, ink, and other 
contamination. Cleaning intervals are determined by the printer environment and by the types of printer supplies 
used.

General cleaning
To prevent electric shock, make sure that the printer is switched off and unplugged before any cleaning is 
performed. Do not let any water get inside the printer.

Proper general cleaning should include the following:

1. Blow away dust accumulation with compressed air if available.

2. Clean the outer surface of the printer with a damp sponge or cloth. Use a mild soap and water solution if 
necessary. Do not use abrasive cleaners.

3. Wipe the printer dry with a soft lint-free cloth.

Clean the Carriage Line Sensor
The cleaning actually involves cleaning the clear plastic lens cover, not the sensor itself.

The Carriage Line Sensor should not normally require cleaning during the life of the printer. However, it may 
require cleaning after a bad printhead crash while printing with high ink density. In practice, it is recommended to 
clean the sensor if there are intermittent failures of paper edge detection, printhead alignment, or paper advance 
calibration.

1. Use tap water. Do not use chemicals that could damage the clear plastic of the lens cover.

2. Use a lint-free cloth.
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3. Wipe the lens with the damp cloth, then remove excess water or moisture with a dry area of the same cloth.

Clean the Encoder Strip
The Encoder Strip should not normally require cleaning during the life of the printer.

However, it may require cleaning in the following cases:

● When droplets of ink get into the encoder. This may happen under certain environmental conditions, with 
very heavy use of the printer, high ink concentrations, and system errors affecting the scan axis.

● When there is grease on the Encoder Strip. This may happen if the Encoder Strip is allowed to touch the 
Carriage rail during repair operations or while clearing a paper jam.

Cleaning procedure

1. Switch off the printer and remove the power cable.

2. Move the Carriage Assembly to the capping position and uncap the printhead.
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3. Place some paper over the slider rod in order to protect the lubricant and avoid cross-contamination with 
grease and general-purpose industrial cleaner.

4. Dampen a cloth with a general-purpose industrial cleaner.

5. Clean the encoder strip carefully, not moving the papers underneath and not stretching the strip.
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6. Move the Carriage towards the center of the printer and clean the remaining portion of the strip.

7. Return the Carriage to the capping position and cap it manually.

8. Remove the papers carefully in order not to remove grease from the slider rod.

Carriage Lubrication
The Carriage should not normally require lubrication during the life of the printer. However, lubrication is 
recommended if there are intermittent Carriage jams.

Lubricate the Carriage Assembly
The following steps provide the complete procedure for this topic.
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1. Lubricate the four areas indicated here.

2. Lubricate the areas indicated here, A-D.
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3. Use a syringe to inject grease into the ports. Push the needle against the ports firmly to direct grease into 
the channels.

NOTE: The Encoder Strip must stay free of grease. Wipe off with a dry lint-free cloth if necessary.

4. Move the Carriage 10–20 mm to check the grease on the rod.

Lubricate the Carriage Rod
The following steps provide the complete procedure for this topic.
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1. Apply a large drop of grease to a cotton swab.

2. Apply grease to the front of the rod and smear for a distance of about 50 mm.

3. Apply grease to the rear of the rod and smear for a distance of about 50 mm.

Moisture on the printer
Customers should use the printer in an environment between 20% and 80% relative humidity.
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To recover from moisture condensation, turn the printer off, and wait until the printer is completely dry before 
using it again.

Level of printer usage
Normal printer use means 800,000 m Carriage traveled distance (which corresponds approximately to more than 
15,000 A1 prints on average).

Under normal conditions, it will be approximately more than 5 years before the printer needs a maintenance. 
If the printer is used more than the normal usage conditions, then it will need maintenance service more 
frequently.

Table 6-1 Component usage triggers

Service Part LIFE_VALUE Maintenance Advice

Scan Axis Distance Covered 800,000 meters PMKIT1

Right Spittoon Volume 600 cc PMKIT2

Left Spittoon Volume 51 cc PMKIT2

When these components of the printer exceed this amount, the Front Panel displays the following message:

"Maintenance #1 required"

"Maintenance #2 required”

Once one of the maintenance advised messages is displayed, the relevant preventive maintenance kit must be 
used to replace the most worn parts of the printer. See Removal and installation on page 293 when replacing the 
necessary parts.

Preventive maintenance kits
Preventive maintenance kits are designed to replace high-usage parts before they fail, avoiding printer 
downtime.

Warning message displayed on the front panel
The following is the process that the customer will see when a component has passed a maintenance usage 
threshold and needs replacement.
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1. As the printer is turned on, if a component has passed its maximum-usage threshold a warning will be 
displayed. If the customer presses OK, the message disappears and will not reappear until the printer is 
turned on again.

2. A warning icon will remain over the wrench until the part has been replaced. If the wrench icon is touched, 
before going into the setup menu, the above warning message is shown again.
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3. When the warning threshold is surpassed by a significant amount, reaching a critical threshold, the message 
becomes more assertive and the warnings appear more frequently.

Table 6-2 Warning thresholds

PMK1 (Carriage) 800,000 meters

PMK2 (service station) 90% full of ink: 1 warning

95% full of ink:1 warning per print

100% full of ink: stops printing

Printing and interpreting the Preventive Maintenance Kit status report
The Preventive Maintenance Kit status report shows the status of the high-usage parts and how far they are 
from requiring replacement.

▲ To print the report, go to Setup > Reports > Printer Status Report.
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Preventive Maintenance Kit #1 (Carriage)
The printer will alert the customer of the need to use PMK1 when the carriage has traveled 800,000 meters 
distance.

Table 6-3 PMK1 contents

PMK #1 for 24-in Carriage (5HB06-67013) PMK #1 for 36-in (5HB10-67009)

Part number Description Part number Description

5HB06-67001 Carriage Assembly with Belt and Trailing 
Cable

5HB10-67001 Carriage Assembly with Belt and Trailing 
Cable

5HB06-67003 Carriage Motor 5HB06-67003 Carriage Motor

CQ890-67108 Cutter with clutch CQ890-67108 Cutter with clutch

Preventive Maintenance Kit #2 (Service Station)
The printer will alert the customer of the need to use PMK2 when one or both of the spittoons exceed their life 
value threshold.

Table 6-4 PMK2 content

Part number Description

5HB06-67026 Service Station Assembly SV

General Cleaning Instructions
For general cleaning, a lint-free cloth dampened with distilled water is recommended. Allow to dry, or use a cloth 
to dry the cleaned part completely.

Do not spray fluids directly onto the HP product. Spray the fluid on the cloth used for cleaning.

To remove stubborn dirt or stains, moisten a soft cloth with water and a neutral detergent, or a general-purpose 
industrial cleaner (e.g. Simple Green industrial cleaner). Remove any remaining soap foam with a dry cloth.

For glass surfaces, is recommended to use a soft, lint-free cloth lightly moistened with a non-abrasive glass 
cleaner or with general purpose glass cleaner (e.g. Simple green glass cleaner). Remove any remaining soap 
foam with a lint-free cloth dampened distilled water and dry it with a dry cloth to prevent spotting.

CAUTION: Do not use abrasives, acetone, benzene, sodium hydroxide, or carbon tetrachloride on the glass; 
they can damage it. Do not place or spray liquid directly onto the glass, as the liquid might seep under the glass 
and damage the device.

It is recommended to use a canister of compressed air to remove dust from electronic/electrical parts.

CAUTION: Do not use water-based cleaners for parts with electrical contacts, as it may damage electrical 
circuits.

NOTE: Do not use wax, alcohol, benzene, thinner, ammonia-based cleaners, or other chemical detergents, to 
prevent any damage to the product or the environment.

NOTE: In some locations the use of cleaning products is regulated. Ensure that your cleaner is following 
federal, state, and local regulations.
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All products and company names are registered trademarks of their original owners. The use of any trademark is 
for identification and reference purposes only and does not imply any association between HP and the trademark 
owner or product brand.

450 Chapter 6  Preventive maintenance



Important linksA

The following are links to useful sources of information.

● Manuals:

– http://www.hp.com/go/DesignJetT200/manuals

– http://www.hp.com/go/DesignJetT600/manuals

– http://www.hp.com/go/DesignJetStudio/manuals

● Printer Firmware:

– http://123.hp.com

– http://www.hp.com/go/DesignJetT200/firmware

– http://www.hp.com/go/DesignJetT600/firmware

– http://www.hp.com/go/DesignJetStudio/firmware

● Printer Software:

– http://www.hp.com/go/DesignJetT200/software

– http://www.hp.com/go/DesignJetT600/software

– http://www.hp.com/go/DesignJetStudio/software

● Support:

– http://www.hp.com/go/DesignJetT200/support

– http://www.hp.com/go/DesignJetT600/support

– http://www.hp.com/go/DesignJetStudio/support
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Front panel home screenB

See the section "Front Panel" in the User Guide.

8. Web Services (from above, printer not connected to Internet)
The following options are accessed from the indicated icon on the front panel.

▲ Connection Required. Printer must be connected to the network and Internet for this feature.

▲ OK

▲ Web Services Summary / Email: Not available / ePrint Status: Not connected / ePrint: On / Apps: 
On

▲ Settings / Web Services Settings

● Display Email Address

● Print Info Page

● Printer Update

● Set Web Proxy
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● ePrint (on/off)

● Apps (on/off)

● Remove Web Services

▲ OK (goes to home screen)

5. Bluetooth
The following options are accessed from the indicated icon on the front panel.

▲ Settings

a. Not Connected

i. Wireless (on/off)

ii. Wireless Setup Wizard

● This wizard will help you set up a wireless connection for the printer.

● Continue (button)

– Single sheet / Status: Not ready / The current ready paper source is Multi-Sheet Tray.

– Paper Type (button)

– Load single sheet (button showing help animations )

– Replay (button)

● Wi-Fi Protected Setup

● View Network Summary

– View Wired > IP not applicable / MAC: 101F74700458 / Hostname: HP70036D

– Print Details (button to Printing report (animation of HP logo) Paper source: Multi-Sheet 
Tray / Paper type: Plain paper

– OK

– View Wired (a drop-down menu takes you to the View Wired screen)

View Wireless (a drop-down menu takes you to the Wireless Summary screen)

● Print Wireless Network Test

● Print Network Configuration

● Advanced Setup

– Select I/O timeout : 30 s; 1 min; 2 min; 4.5 min; 5 min; 10 min; 15 min; 20 min; 30 min

– Link Speed: Automatic; 10-Full; 10-Half; 100-Full; 100-Half

– IP Settings (changing the IP address will remove the printer from the network)
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OK (button activated): Automatic (DHCP) (button activated); Manual (Static) (button not 
activated)

– Hostname > Hostname: HP70036D

Change (button without option to select); OK (button with option to click that takes you 
back to the Advanced Setup screen)

● Restore Network Defaults

● Print Details (button not activated)

● OK (goes to home screen)

b. Connected IP:xxx.xxx.x.xx. MAC:101G74700458 Hostname: HPxxxxxx

i. Wireless (on/off)

ii. Wireless Setup Wizard

● Wireless connection has already been set up. Are you sure you want to set it up again?

– Yes (button that allows you to select but nothing happens)

– No (button that allows you to select and then the options below appear)

● Wi-Fi Protected Setup

● View Network Summary

– View Wired (a drop-down menu takes you to the View Wired screen)

– View Wireless (a drop-down menu takes you to the Wireless Summary screen)

● Print Wireless Network Test

● Print Network Configuration

● Advanced Setup

– Select I/O timeout : 30 s; 1 min; 2 min; 4.5 min; 5 min; 10 min; 15 min; 20 min; 30 min

– Link Speed: Automatic; 10-Full; 10-Half; 100-Full; 100-Half

– IP Settings (changing the IP address will remove the printer from the network)

OK (button activated): Automatic (DHCP) (button activated); Manual (Static) (button not 
activated)

– Hostname > Hostname: HP70036D

Change (button without option to select); OK (button with option to click that takes you 
back to the Advanced Setup screen)

● Restore Network Defaults

● Print Details (button not activated)

● OK (goes to home screen)
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6. Estimated ink levels
The following options are accessed from the indicated icon on the front panel.

● More (button that takes you to a drawing of the ink levels of all cartridges)

● Print Report

– Printing Report (message of printing in progress with animation of HP logo)

– Paper source: Multi-Sheet Tray / Paper type: Plain Paper

7. Setup (Wireless off)
The following options are accessed from the indicated icon on the front panel (when Wireless connection is off).

1. Last page

● Last page is not available to reprint (there is a drop-down menu with numbers)

● Reprint (button that takes you back to the Setup menu)

2. Form feed

3. Form feed and cut

4. Connectivity

a. Not Connected

b. Wireless (on/off)

c. Wireless Setup Wizard

This wizard will help you set up a wireless connection for the printer.

i. Press Print Guide for easy wireless setup instruction

ii. Print Guide

● Printing Report

– Paper source: Multi-Sheet Tray

– Paper type: Plain Paper

– Wi-Fi Protected Setup

– Setting up the network through Wi-Fi Protected Setup (WPS) has timed out

– For diagnostic information, press Print Report. For help, press ?

– Print Report

– OK

– Continue

● Searching for wireless routers...
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d. Wi-Fi Protected Setup

i. Two ways to set up using Wi-Fi Protected Setup (WPS):

● Use the WPS button, if available, on your router.

● Enter the PIN generated by the printer in the router’s configuration software.

For help, press ?

ii. Continue

● Wi-Fi Protected Setup

– Push Button

– Wi-Fi Protected Setup

On the router, press and hold the WPS button for 3 seconds to connect to the network.

● Show Me

– Starting animation...

Replay

Done

iii. PIN

e. View Network Summary

● View Wired

– Wired Summary

IP: Not applicable

MAC: 02BAD0AD5AB5

Hostname: HPxxxxxx

– Print Details

– OK

● View Wireless

f. Print Wireless Network Test

g. Print Network Configuration

h. Advanced Setup

i. Restore Network Defaults

5. Image quality maintenance

● Printhead information

● Align printhead
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● Clean printhead

● Replace printhead

● Print diagnostic image

● Paper advance calibration

– Calibrate ready paper

– Reset ready paper calibration

6. Printer preferences

● Screen Brightness (there is a picture of brightness regulation)

– OK

● Language

– English, Français, Deutch, Português, Español, Italiano, Japanese, Korean, Chinese, Taiwanese, etc.

● Country/Region

– USA, Canada, Australia, India, UK, Singapore, New Zealand, South Africa, Hong Kong, Israel, 
Thailand, Saudi Arabia, UAE, Malaysia, Philippines, Ireland, Indonesia, Egypt, Kuwait, Jordan, 
Pakistan, Qatar, Lebanon, Vietnam, Argentina, Austria, Belarus, Belgium, Brazil, Bulgaria, Chile, 
China, Columbia, Costa Rica, Croatia, Czech Republic, Denmark, Ecuador, Estonia, Finland.

● Keyboard: QWERTY (selected) /AZERTY/QWERTZ

● Auto Off: Off (selected) / 2 Hours/ 4 Hours/ 8 Hours/ 12 Hours

● Sleep: After 5 Minutes / After 15 Minutes / After 30 Minutes (selected) / After 60 Minutes / After 120 
Minutes / After 240 Minutes

● Print retrieval : Select drying time / Enable cutter

7. Anonymous usage information

8. Internal prints

● Demo prints

● User information prints

9. Service menu

● Restore factory settings

● Reset all paper calibration

7. Setup (Wireless on)
The following options are accessed from the indicated icon on the front panel (when Wireless connection is on).

1. Last page

● Last page is not available to reprint (there is a drop-down menu with numbers)
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● Reprint (button that takes you back to the Setup menu)

2. Form feed

3. Form feed and cut

4. Connectivity

a. Connected

b. Wireless (on/off)

c. Wireless Setup Wizard

This wizard will help you set up a wireless connection for the printer.

i. Press Print Guide for easy wireless setup instruction

ii. Print Guide

● Printing Report

– Paper source: Multi-Sheet Tray

– Paper type: Plain Paper

– Wi-Fi Protected Setup

– Setting up the network through Wi-Fi Protected Setup (WPS) has timed out

– For diagnostic information, press Print Report. For help, press ?

– Print Report

– OK

– Continue

● Searching for wireless routers...

d. Wi-Fi Protected Setup

i. Two ways to set up using Wi-Fi Protected Setup (WPS):

● Use the WPS button, if available, on your router.

● Enter the PIN generated by the printer in the router’s configuration software.

For help, press ?

ii. Continue

● Wi-Fi Protected Setup

– Push Button

– Wi-Fi Protected Setup

On the router, press and hold the WPS button for 3 seconds to connect to the network.

● Show Me
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– Starting animation...

Replay

Done

iii. PIN

e. View Network Summary

● View Wired

– Wired Summary

IP: Not applicable

MAC: 02BAD0AD5AB5

Hostname: HPxxxxxx

– Print Details

– OK

● View Wireless

f. Print Wireless Network Test

g. Print Network Configuration

h. Advanced Setup

● Select I/O timeout: 30 s / 1 min / 2 min / 5 min / 10 min / 15 min / 20 min / 30 min

● Link Speed: Automatic / 10-Full / 10-Half / 100-Full / 100-Half

● IP Settings (changing the IP address will remove the printer from the network)

– Automatic (DHCP)

– Manual (static)

● Hostname > Hostname: HP70036D

– Change

Changing the hostname affects the existing connection between your computer and this 
printer. You would need to reestablish connection.

OK

– OK

i. Restore Network Defaults

5. Image quality maintenance

● Printhead information

● Align printhead

● Clean printhead
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● Replace printhead

● Print diagnostic image

● Paper advance calibration

– Calibrate ready paper

– Reset ready paper calibration

6. Printer preferences

● Screen Brightness (there is a picture of brightness regulation)

– OK

● Language

– English, Français, Deutch, Português, Español, Italiano, Japanese, Korean, Chinese, Taiwanese, etc.

● Country/Region

– USA, Canada, Australia, India, UK, Singapore, New Zealand, South Africa, Hong Kong, Israel, 
Thailand, Saudi Arabia, UAE, Malaysia, Philippines, Ireland, Indonesia, Egypt, Kuwait, Jordan, 
Pakistan, Qatar, Lebanon, Vietnam, Argentina, Austria, Belarus, Belgium, Brazil, Bulgaria, Chile, 
China, Columbia, Costa Rica, Croatia, Czech Republic, Denmark, Ecuador, Estonia, Finland.

● Keyboard: QWERTY (selected) /AZERTY/QWERTZ

● Auto Off: Off (selected) / 2 Hours/ 4 Hours/ 8 Hours/ 12 Hours

● Sleep: After 5 Minutes / After 15 Minutes / After 30 Minutes (selected) / After 60 Minutes / After 120 
Minutes / After 240 Minutes

● Print retrieval : Select drying time / Enable cutter

7. Anonymous usage information

8. Internal prints

● Demo prints

● User information prints

9. Service menu

● Restore factory settings

● Reset all paper calibration
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Support menu and Service menu treeC

See Support and Service menu trees.

Menu options
See the following table for the complete list of options available.

Table C-1 Information Menu

1.1 Model number

1.2 Serial number

1.3 Region/Language

1.4 Counters

1.5 Firmware version

1.6 Error log

1.7 Printer region

1.8 Pen supply region

1.9 Ink supply serial number (SN)

1.10 Ink supply level of ink (LOI)

1.11 Relocks remaining

1.12 Relock attempts remaining

1.13 Gather/scramble scheme

1.14 Checksum for relock data input

1.15 Wireless region

Reset Menu

2.1 Country/Language reset

2.2 Webserver Password

2.3 OOBE reset

2.4 PMK1 reset*

2.5 PMK2 reset*

2.6 Mark tubes as empty*

2.7 Line feed mfg calibration

2.8 RTC battery expired*

2.9 Power-On Button behavior*
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Systems Configuration Menu

3.1 Set boot mode to user mode

3.2 Set wireless Region*

3.3 Convert unit to OEM-SKU*

3.4 Config SKU
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How to check whether your computer is 
connected to your network

D

There are several different ways of confirming connectivity between your computer and your network.

1. If you are not using a unique network name (SSID), then it is possible that the computer could be connected 
to the wrong network. The following steps can help you to determine whether your computer is connected 
to the correct network.

Windows

a. Click Start, click Control Panel, point to Network Connections, and then click View Network Status and 
Tasks – or – Click Start, select Settings, click Control Panel, double-click Network Connections, click the 
View menu, and then select Details.

Leave the network dialog box open while you continue to the next step.

b. Disconnect the power cord from the wireless router. The connection status of the computer should 
change to Not Connected.

c. Reconnect the power cord to the wireless router. The connection status should change to Connected.

Mac OS X

▲ Click the AirPort icon in the menu bar at the top of the screen. From the menu that appears, you can 
determine if the AirPort is turned on and which wireless network the computer is connected to.

NOTE: For more detailed information about the AirPort connection, click System Preferences in the 
Dock, and then click Network. If the wireless connection is working correctly, a green dot appears next 
to AirPort in the list of connections. For more information, click the Help button in the window.

If you are unable to get the computer connected to your network, contact the person who set up your 
network or the router manufacturer as there may be a hardware issue with the router or computer.

If you are able to access the Internet and are using a computer running Windows, you can also access the 
HP Network Assistant at http://www.hp.com/sbso/wireless/tools-setup.html? jumpid=reg_R1002_USEN 
for help in setting up a network (this website is available in English only).

2. Print the printer's Wireless Configuration page. After the page has been printed, check the Network Status 
and URL. The Network Status is Ready if the printer is actively connected to a network, or Offline if it is not 
(in the latter case, run the Wireless Network Test). The URL is the network address assigned to the printer 
by the router; you need it to connect to the printer's Embedded Web Server.

3. If you have established that the computer and the printer both have active connections to a network, you 
can check whether they are on the same network by trying to access the printer's Embedded Web Server.

4. The printer may be too far away from the WiFi access point or there may be intervening objects that are 
preventing connection. You can try moving the printer closer to the WiFi acess point.

5. Check that the WEP key password entered is the correct one. The pass phrase capitalization, punctuation, 
etc., must all match exactly.
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6. If you cannot access the Embedded Web Server and are sure that both the computer and printer have 
active connections to the same network, the firewall security software could be blocking communication. 
Temporarily turn off any firewall security software running on the computer, and try to access the 
Embedded Web Server again. If you can access it, try using the printer for printing.

If you are able to access the Embedded Web Server and use the printer with the firewall turned off, you 
need to reconfigure your firewall settings to allow the computer and printer to communicate with each 
other over the network.

If you are able to access the Embedded Web Server, but are still unable to use the printer even with the 
firewall turned off, try enabling the firewall software to recognize the printer.

7. Make sure the printer is online and ready.

If you have the HP software installed, you can check the printer’s status from your computer to see if 
the printer is paused or offline, preventing you from using it. To check the printer’s status, complete the 
following steps:

Windows

a. From Start > Settings, and then click Printers or Printers and Faxes. - or - From Start > Control Panel, 
and then double-click Printers.

b. If the printers on the computer are not being displayed in Details view, click the View menu, and then 
click Details.

c. Do one of the following, depending on the printer status:

● If the printer is Offline, right-click the printer, and click Use Printer Online.

● If the printer is Paused, right-click the printer, and click Resume Printing.

d. Try using the printer over the network.

Mac OS X

a. Click System Preferences in the Dock, and then click Print & Fax.

b. Select the printer, and the click Print Queue.

c. If Jobs Stopped appears in the window that appears, click Start Jobs.

8. If you install the HP software a second time, the installer may create a second version of the printer driver in 
the Printers or Printers and Faxes folder (Windows only). If you have difficulties printing or connecting to the 
printer, make sure the correct version of the printer driver is set as the default.

a. From Start > Settings, and then click Printers or Printers and Faxes. - or - From Start > Control Panel, 
and then double-click Printers.

b. Right-click the printer icon and then click Properties, Document Defaults, or Printing Preferences.

c. On the Ports tab, look for a port in the list with a checkmark. The version of the printer driver that is 
connected wirelessly has Standard TCP/IP Port as the Port description, next to the checkmark.

d. Right-click the printer icon for the version of the printer driver that is connected wirelessly, and select 
Set as Default Printer.

9. Try restarting the HP Network Device Support service (Windows only).

a. Delete any print jobs currently in the print queue.
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b. On the desktop, right-click My Computer or Computer, then click Manage.

c. Double-click Services and Applications, then click Services.

d. Scroll down the list of services, right-click HP Network Devices Support, then click Restart.

e. After the service restarts, try using the printer over the network again.

If you still cannot use the printer over the network, or if you have periodic problems in doing so, the firewall 
may be interfering, or there may be a problem with the network configuration or router. Contact the person 
who set up the network or the router manufacturer for help.

If you are able to use the printer over the network, the network setup was successful.

How to check whether your computer is connected to your network 467



468 Appendix D  How to check whether your computer is connected to your network



Wireless troubleshooting report error casesE

The following error alerts fall into two categeries: "Warning" and "Failure".

Error case table
In the first column of the following table, W indicates Warning and F indicates Failure.

W/F # Description Internal conditions and 
parameters

Internal details Troubleshooting

W 0 Ethernet cable 
plugged in

Ethernet cable plugged 
in && ncaPolicy != nHot 
&& powerOnEnabled == 
true && no SSID found

The Ethernet cable is plugged in. The 
printing device cannot connect to a wireless 
network while it is connected via Ethernet. 
To connect wirelessly, unplug the cable from 
the printing device and run these tests 
again.

ATTENTION: Your printer is 
unable to connect to your 
wireless router.

SOLUTION 1: To connect 
wirelessly, disconnect the 
Ethernet network cable from 
your printer.

W 1 Ethernet cable 
plugged in and 
SSID found

Ethernet cable plugged 
in && ncaPolicy != nHot 
&& powerOnEnabled == 
true && SSID found

A wireless network was found that matches 
what you have configured (%s). However, 
the Ethernet cable is plugged in, which 
will prevent you from connecting to it. To 
connect wirelessly, unplug the cable from 
the printer and run these tests again. 
The %s parameter will be the SSID name 
that is displayed on the advanced wireless 
networking webpage.

ATTENTION: Your printer is 
unable to connect to your 
wireless router.

SOLUTION 1: To connect 
wirelessly, disconnect the 
Ethernet network cable from 
your printer.

W 2 Wireless adaptor 
disabled

powerOnEnabled == 
false

The wireless network interface in the 
printing device (%s) is not enabled. You 
cannot connect to a wireless network 
until this is turned on. If you want to 
connect to a wireless network, consult the 
documentation that came with the printer 
on how to enable the wireless interface. The 
first %s parameter will be the name of the 
interface, i.e. “Wifi0”.>>

ATTENTION: The wireless radio 
on your printer is currently 
turned off.

SOLUTION 1: To connect 
wirelessly, disconnect the 
Ethernet network cable from 
your printer. Refer to the 
assembly instructions that 
came with your printer.

F 4 Radio hardware 
not functioning 
properly

powerOnEnabled == 
ncaTrue && 
radioHardwareStatus != 
ncaRSInitialized

The wireless network interface (%s) is not 
functioning properly. The printer cannot 
connect to a wireless network. This may be 
a problem with the printer hardware. As a 
first step, disconnect the power from the 
printer, wait a few seconds, then plug the 
power back in and re-run these tests. If this 
error message persists, the printer will need 
to be serviced. The %s parameter will be the 
name of the interface, i.e. “Wifi0”.

ATTENTION: The wireless radio 
is not functioning. Contact HP 
support. The Wireless PCA 
needs to be repaired.

F 100 Possible MAC 
filtering

Trying to associate && 
mode == infrastructure 
&& SSID matches 
&& completion code !
= AkmFailedPmkInvalid 
all parameters 
consistent

The printer is configured to connect to 
a wireless network (%s). An access point 
(AP) with this SSID has been found and 
its settings are consistent with those 
configured in the printer, but you are not 
connected. Some possible causes and fixes 
are:

ATTENTION: Your printer is 
unable to connect to your 
wireless router. MAC address 
filtering may be enabled on 
your wireless router, which 
can prevent your printer from 
connecting to your wireless 
network during setup.
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The printer may be temporarily experiencing 
a problem. Turning the printer off and then 
back on may correct this problem.

The AP may be temporarily experiencing 
a problem. Turning the AP off and then 
back on may correct this problem. Note 
that turning off the AP will cause other 
connected devices (computers, printers, 
etc.) to lose their network connection until 
the AP is turned back on.

The AP firmware may be out of date. Check 
the manufacturer’s website to see if an 
update is available.

MAC address filtering may be enabled 
on the AP. This can prevent the printer 
from connecting if its MAC address is 
not in the AP's approved list of devices. 
The person who initially set up your 
network may have done this for added 
security. If this is the case you can 
either disable MAC filtering in the AP, or 
add the printing device’s MAC address 
(%02x:%02x:%02x:%02x:%02x:%02x) to 
the approved list in the AP. Refer to the 
documentation that came with the AP 
for more information about MAC address 
filtering.

The first %s parameter will be the SSID 
name that is displayed on the advanced 
wireless networking webpage. The second 
set of %s parameters will be the MAC 
address of the printer.

SOLUTION 1: If MAC address 
filtering is enabled and you 
would like to keep it enabled, 
you must add the MAC address 
of your printer (available in 
this Test Report) to the 
list of permitted devices for 
your wireless router before 
continuing.

F 101 Consistency 
check when only 
one AP found 
with matching 
name while 
trying to 
associate

mode == infrastructure 
&& SSID matches 
exactly one AP && 
not all parameters 
consistent

The settings you entered in the printer 
do not match those of the wireless 
network you are trying to connect to (%s). 
Connection was not made. Ensure that all of 
the wireless settings in the printer match 
those in the access point (AP) for this 
network.

Assuming that the settings in the AP 
are the correct ones, change the wireless 
network settings in the printer. Consult 
the documentation that came with the 
printing device on how to do this. If you 
do need to change the settings in the AP 
then consult the documentation that came 
with the AP on how to do this. Note that 
this will require you to update settings in 
all devices (computers, printers, etc.) that 
connect wirelessly through this AP.

The first %s parameter will be the SSID 
name that is displayed on the advanced 
wireless webpage.

ATTENTION: Your printer 
settings do not match your 
wireless router settings.

SOLUTION 1: Run the Wireless 
Setup Wizard to configure your 
printer.

W 103 AutoIP 
configured

Adaptor assigned an 
AutoIP

W 200 Check that 
configuration has 

currentState != 
ncaASOff && mode 

Your printer is configured to connect to 
a wireless network with a manufacturer's 

ATTENTION: Your wireless 
network is currently using 
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manufacturer 
default SSID for 
access point

== infrastructure && 
SSID matches entry in 
manufacturer default 
list

default SSID name (%s). You should change 
the name to something unique to you in 
order to avoid connecting to the wrong 
network. You will most likely experience 
network problems if you do not correct this 
problem. Even if the network appears to 
be functioning correctly now, it may not 
in the future. Refer to the documentation 
that came with your access point to change 
the SSID name. If you do change the SSID 
name of the wireless network, note that 
this will require you to update settings in 
all devices (computers, printers, etc.) that 
connect to this network. The %s parameter 
will be the SSID name that is displayed on 
the advanced wireless networking webpage.

the manufacturer’s default 
network name (SSID). It 
is recommended that you 
change your network name 
(SSID) to be unique, to avoid 
connecting to other wireless 
networks that may also 
be using the same default 
network name. If you change 
your network name, you will 
need to configure the SSID on 
all wireless devices to match 
your new network SSID.

F 201 SSID not found, 
infrastructure 
mode

Trying to associate && 
mode == infrastructure 
&& configured SSID is 
not found in directed 
scan list

The SSID (%s) that you have entered in 
the printer does not match any of the 
available wireless network access points 
(AP). Connection was not made.

The undirected scan list above shows all of 
the access points that were found nearby 
that are broadcasting their SSID. Your access 
point may not be in this list if broadcasting 
has been disabled. Note that if broadcasting 
is off it won’t affect your ability to connect, 
just the visibility of the AP in the undirected 
scan list. When the SSID is correct and the 
AP is functioning properly, it will show up in 
the directed scan list above.

Some possible causes and fixes for the 
connection problem are:

You may have entered an incorrect SSID 
in the printing device. Refer to the 
documentation that came with the printer 
for information on how to change the SSID.

The AP may be powered off. Make sure 
your AP is powered on and that the SSID 
is correct. Refer to the documentation that 
came with your AP to verify its SSID.

The printer may be too far from your AP or 
there may be intervening objects that are 
preventing connection. You can try moving 
the printer and the AP closer together.

The %s parameter will be the SSID name 
that is displayed on the advanced wireless 
networking webpage.

ATTENTION: Your printer is 
unable to connect to your 
wireless router.

SOLUTION 1: Check that your 
wireless router is powered on.

SOLUTION 2: Check that your 
printer network name (SSID) 
matches your wireless router 
network name (SSID) exactly. 
If they do not match exactly, 
run the Wireless Setup Wizard 
to configure your printer.

F 202 SSID not found, 
ad hoc mode

Trying to associate && 
mode == ad hoc && 
configured SSID is not 
found in directed scan 
list

The printer has created an ad-hoc wireless 
network with SSID %s. However, no other 
wireless devices have been found that are 
using this SSID. Connection was not made. 
This is not a problem if the other devices 
you want to connect to are not powered 
on yet. If they are powered on then some 
possible causes and fixes are:

You may have entered an incorrect SSID 
in the printer. In order to form an ad-hoc 

ATTENTION: Your printer is 
unable to connect to your 
wireless router.

SOLUTION 1: Check that your 
access point is powered on.

SOLUTION 2: Check that your 
printer network name (SSID) 
matches your access point 
network name (SSID) exactly. 
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wireless network, all the devices must 
be using the same SSID. Refer to the 
documentation that came with the printer 
for information on how to change the SSID.

The printer may be too far from any 
other devices in the wireless network or 
there may be intervening objects that 
are preventing connection. You can try 
moving the printer closer to the other 
devices. Note that you cannot connect to 
an access point (AP) using the ad-hoc 
method. Ad-hoc mode allows devices to 
communicate directly without the use of 
an AP. Infrastructure mode allows you to 
connect to a wireless network using an AP. 
Refer to the documentation that came with 
the printer if you want to connect to a 
wireless network with an AP.

The %s parameter will be the SSID name 
that is displayed on the advanced wireless 
networking webpage.

If they do not match exactly, 
run the Wireless Setup Wizard 
to configure your printer.

F 203 SSID found if 
doing case-
insensitive 
search, ad hoc 
and 
infrastructure

Associated or trying 
to associate && 
any mode && non­
exact SSID match 
found in undirected 
scan. Non-exact match 
means case-insensitive 
compare is true and 
case-sensitive compare 
is false.

A wireless network was found (%s) whose 
name closely matches the name you 
have entered (%s) in the printer’s wireless 
settings. You are not connected to this 
network. If this is the network you are trying 
to connect to, you will need to change the 
SSID name you have entered in the printer. 
Refer to the documentation that came with 
the printer for information on how to do 
this. Note that network SSID names must 
be entered exactly as they appear in the 
list above: capitalization, punctuation, etc., 
must all match.

The first %s parameter will be the SSID 
name found during the un-directed scan, 
the second %s parameter will be the SSID 
name that is displayed on the advanced 
wireless networking webpage.

ATTENTION: Your printer is 
unable to connect to your 
wireless router. A network 
name (SSID) was found that 
closely matches your wireless 
network name except for 
upper/lower case.

SOLUTION 1: Run the Wireless 
Setup Wizard to re-enter the 
SSID correctly.

W 400 Signal strength 
when associated

Associated && adaptor 
signal strength < -85 dB

The signal strength of the wireless network 
you are connected to (%s) is %d dBm. This 
is below -85 dBm which may result in poor 
performance or an intermittent connection.

If you are using an access point (AP), bring 
the printing device and AP closer together 
to increase the signal strength. If you are 
connecting to an ad-hoc wireless network, 
bring the printer closer to other devices in 
the wireless network.

In either case there may also be intervening 
objects that are causing the signal strength 
to weaken. Large metal objects such 
as refrigerators, water heaters, or office 
furniture can block wireless signals. Try to 
ensure that such objects are not directly 
between the printer and the AP or other 
devices in the wireless network.

ATTENTION: The wireless 
signal strength between your 
printer and wireless router is 
weak.

SOLUTION 1: Move your printer 
closer to your wireless router 
and avoid obstructions such as 
walls and large metal objects.

SOLUTION 2: After moving 
your printer, run the wireless 
network test to verify the 
signal strength.
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W 500 Check for 
multiple access 
points (or 
wireless 
repeaters) with 
the target SSID

Associated or trying 
to associate && 
infrastructure mode && 
number of directed 
scans > 1

There were %d access points (APs) (or 
wireless repeaters) with your configured 
SSID (%s) found in the area. The printer 
will connect to the one with the strongest 
signal.

If you’ve set up a network with multiple APs, 
this is a normal condition. Note that the APs 
must be connected to the same LAN, usually 
via a wired connection. A special case is a 
wireless repeater, which is an AP but uses a 
wireless connection to connect to a “master” 
AP.

If you have not set up a network with 
multiple APs, it means that someone else 
has a network with the same SSID nearby, 
in which case you could connect to the 
other network instead of your own. You will 
probably experience network problems if 
you do not correct this problem. Even if the 
network appears to be functioning correctly 
now, it may not in the future.

You can solve this problem by creating a 
wireless network with a unique SSID. Refer 
to the documentation that came with your 
access point for information on how to 
change its SSID. When you change the SSID 
name of the wireless network, note that 
this will require you to update settings in 
all devices (computers, printers, etc.) that 
connect to this network.

The %d parameter is an integer value of the 
number of networks found with the name, 
the %s parameter will be the SSID name 
found in the network scan.

ATTENTION: More than one 
wireless router has been found 
that matches your wireless 
network name (SSID). If this is 
not intended, your printer may 
connect to the wrong wireless 
network. To avoid this, change 
your wireless network name 
(SSID) to be unique. If you 
change your network name, 
you will need to configure the 
SSID on all wireless devices to 
match your new network SSID.

F 600 Incorrect WEP 
key

Connected && 
associated && 
encryption mode 
== WEP && 
wepDecryptStatus == 
ncaD11WDSFailed

The printer is connected to a wireless 
network (%s) that requires a WEP key. The 
key you have provided does not match what 
is expected. Although it looks as if a valid 
connection is made, the printer will not 
receive any data. You will need to enter 
a matching WEP key in the printer. Refer 
to the documentation that came with the 
printer for information on how to change 
the WEP key.

The person who initially set up your network 
should be able to provide you with the 
correct WEP key to use. Alternately, if you 
are connecting to an access point (AP), you 
may be able to find the matching WEP key 
from the AP. Consult the documentation 
that came with the AP on how to do this.

The %s parameter will be the SSID name 
found in the network scan.

ATTENTION: The WEP security 
key configured on your printer 
does not match your wireless 
router setting. The WEP key 
index setting on your printer 
has been changed from the 
default setting of “1”. This 
may cause problems when 
connecting to your wireless 
network if your wireless router 
is not using the same WEP key 
index value.

SOLUTION 1: Run the Wireless 
Setup Wizard to re-enter your 
wireless network WEP security 
key.

I 601 Unknown WEP 
decrypt status

Connected && 
associated && 
encryption mode 
== WEP && 

The printer is connected to a wireless 
network (%s) that requires a WEP key. 
However, no data have been sent to the 
printer. Because of this, it is unknown 
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wepDecryptStatus == 
ncaD11WDSUnknown

whether the WEP key entered in the printer 
matches that of the wireless network.

Usually this is a temporary condition. Once 
some data are sent, the printer will be 
able to determine whether the WEP keys 
match. Try running this report again in a few 
seconds.

The %s parameter will be the SSID name 
found in the network scan.

W 602 WEP key index is 
different from 1

Connected && 
associated && 
encryption mode 
== WEP && 
wepDecryptStatus == 
ncaD11WDSUnknown || 
ncaD11WDSFailed && 
wepKeyIndex != 1

The printer is connected to a wireless 
network (%s) that requires a WEP key. Data 
are not being received. You are using a WEP 
key index of %d. A WEP key index of 1 is 
typical.

If the index does not match what the 
wireless network is expecting, it will prevent 
the printer from being able to receive data. 
The person who initially set up your network 
should be able to provide you with the 
correct WEP key index to use. Alternately, 
if you are connecting to an access point 
(AP), you may be able to find the matching 
WEP key index from the AP. Consult the 
documentation that came with the AP on 
how to do this.

If you do need to change the WEP key index 
of the printer, refer to the documentation 
that came with the printer for information 
on how to do this.

The %d parameter will be the index, the %s 
parameter will be the SSID name found in 
the network scan.

ATTENTION: The WEP key 
index setting on your printer 
has been changed from the 
default setting of “1”. This 
may cause problems when 
connecting to your wireless 
network if your wireless router 
is not using the same WEP key 
index value.

SOLUTION 1: Run the Wireless 
Setup Wizard to re-enter your 
wireless network WEP security 
key.

F 604 Non-default WEP 
Authentication

associationState != 
ncaD11ASAssociated 
&& 
communicationMode 
== infrastructure && 
wirelessEncryptionMod
e == WEP && 
wirelessAuthMode != 
OpenThenShared

The printer is configured to connect to 
a WEP wireless network (%s), and the 
printer’s configured authentication method 
(\"%s\") has been changed from its default 
setting (\"Automatic (Open then Shared)\").

This could potentially cause the printer 
to be unable to connect to the wireless 
network. The printer’s default setting should 
always work and avoids any potential 
future problems. Unless you know that 
the printer’s current setting is correct for 
your wireless network, it is recommended 
that this setting be changed back to the 
default. Refer to the documentation that 
came with the printer for information on 
how to configure the WEP authentication 
method.

The first %s parameter will be the SSID 
name found in the network scan , the 
second %s parameter will be the actual 
value of the setting.

ATTENTION: The WEP key 
authentication setting on your 
printer has been configured 
to a non-default setting. This 
may cause problems when 
connecting to your wireless 
network if your wireless router 
is not using the same WEP 
authentication method.

SOLUTION 1: Refer to your 
printer documentation for 
information on configuring 
WEP.

F 605 Non-default WPA 
Encryption

Associated or trying 
to associate && 
communicationMode 

The printer is configured to connect to 
a WPA-PSK wireless network, (%s) and 
the printer’s configured encryption method 

ATTENTION: The WPA 
encryption method on your 
printer has been configured 
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== infrastructure 
&& wirelessAuthMode 
== ncaD11AMWPA_PSK 
&& 
wirelessEncrypMode != 
ncaD11EMAESorTKIP

(\"%s\") has been changed from its default 
setting (\"Automatic (AES or TKIP)\").

This could potentially cause the printer 
to be unable to connect to the wireless 
network. The printer’s default setting should 
always work and avoids any potential 
future problems. Unless you know that 
the printer’s current setting is correct for 
your wireless network, it is recommended 
that this setting be changed back to the 
default. Refer to the documentation that 
came with the printer for information on 
how to configure the WPA-PSK encryption 
method.

The first %s parameter will be the SSID 
name found in the network scan , the 
second %s parameter will be the actual 
value of the setting.

to a non-default setting. This 
may cause problems when 
connecting to your wireless 
network if your wireless router 
is not using the same WPA 
encryption method.

SOLUTION 1: Refer to your 
printer documentation for 
information on configuring 
WPA.

F 606 Non-default WPA 
Authentication

associationState != 
ncaD11ASAssociated 
&& 
communicationMode 
== infrastructure 
&& wirelessAuthMode 
== ncaD11AMWPA_PSK 
&& rsnAuthType != 
ncaD11ATAutoWPA

The printer is configured to connect to a 
WPA-PSK wireless network, (%s) and the 
printer’s configured WPA version (\"%s\") 
has been changed from its default setting 
(\"Automatic (WPA2 or WPA1)\").

This could potentially cause the printer 
to be unable to connect to the wireless 
network. The printer’s default setting should 
always work and avoids any potential 
future problems. Unless you know that 
the printer’s current setting is correct for 
your wireless network, it is recommended 
that this setting be changed back to the 
default. Refer to the documentation that 
came with the printer for information on 
how to configure the WPA-PSK WPA version.

The first %s parameter will be the SSID 
name found in the network scan , the 
second %s parameter will be the actual 
value of the setting.

ATTENTION: The WPA 
authentication method on 
your printer has been 
configured to a non-default 
setting. This may cause 
problems when connecting to 
your wireless network, if your 
wireless router is not using 
the same WPA authentication 
method.

SOLUTION 1: Refer to your 
printer documentation for 
information on configuring 
WPA.

F 609 Non-standard 
WPA mode

Radio connected to an 
802.11n-only AP which 
supports WPA with 
TKIP.

ATTENTION: Your printer is 
unable to connect to your 
wireless router. This may 
be caused by the following 
settings on your wireless 
router: 1) 802.11n devices 
only and 2) WPA-TKIP only 
encryption. WPA-TKIP is no 
longer allowed for newer 
certified wireless 802.11n 
devices because WPA-AES 
provides stronger security.

SOLUTION 1: Change your 
wireless router encryption 
setting to “WPA-AES” or “WPA­
AES or TKIP” (also called 
“mixmode”), then run the 
printer’s Wireless Setup Wizard 
again.
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Updating the cutter designF

Follow this procedure in order to update the old cutter design to the new one.

1. Remove two T-10 screws.

2. Pull out the left side of the Cutter Extraction Lid.

3. Slide the Cutter Extraction Lid to the left to detach it from the hole.
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4. Remove the Cutter Extraction Lid.

5. New Cutter Extraction Lid. (Identify the marked areas, it will match on the printer.)

6. Identify the marked areas in the printer.
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7. Introduce the new Cutter Extraction Lid on the printer.

8. Move the Cutter Extraction Lid to the right in order to insert the area marked with “1” with the same number 
on the printer.

9. Push the blue lever until it “clicks”. Areas marked with number “2”, should match.
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Safety precautionsG

This appendix details general safety guidelines and best practices regarding electrical, fire, and mechanical 
hazards.

General safety guidelines
Before servicing the printer, read the following safety precautions to make sure that you can work on the printer 
safely.

● Before servicing the printer, turn it off, and disconnect electrical power.

● Before removing and replacing parts, see Removal and installation on page 293.

Service personnel are expected to have appropriate technical training and experience necessary to be aware of 
hazards to which they may be exposed in performing a task, and to take appropriate measures to minimize the 
risks to themselves and other people.

Electrical / Fire hazards
Please observe the following best practices at all times.

● Do not set heavy objects on the power cord; and do not bend the cables or force them into contorted 
positions.

● Do not use a damaged power cord.

● Do not handle the power cord with wet hands. Doing so may cause an electric shock hazard.

● Do not allow metal or liquids (except those used in the HP Cleaning Kit) to touch the internal parts of the 
equipment. Doing so may cause fire, electrical shock, or other serious hazards.

Mechanical hazards
Please observe the following best practices at all times.

● Wear safety gloves when installing the assembly, taking caution not to injure yourself on the edges and 
corners.

● Avoid wearing necklaces, bracelets, and other hanging objects.

● If your hair is long, try to secure it so that it will not fall into the equipment.

Electrostatic Discharge (ESD) Precautions
High-voltage electrostatic discharge can cause preventable damage to the printer's circuits.

● Do not wear clothing that is subject to static build-up.

● Do not handle integrated circuits (ICs) in carpeted areas.
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● Do not remove an IC or a Printed-Circuit Assembly (PCA) from its conductive foam pad or conductive 
packaging until you are ready to install it.

● Ground (earth) your body while disassembling and working on the printer.

● After removing a cover from the printer, attach an earthing (ground) lead between the PCA common and 
earth (ground). Touch all tools to earth (ground) to remove static charges before using them on the printer.

● After removing any PCA from the printer, place it on a conductive foam pad or into its conductive packaging 
to prevent ESD damage to any ICs on the PCA.
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FlyersH

Flyers are short procedural guides to assist in the performance of certain removal and installation actions.

CSR
The following flyers provide Customer Self-Repair information.

ARSS
The original ARSS flyer is reproduced here for your reference.
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Cutter with clutch
The original Cutter CSR flyer is reproduced here for your reference.
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Cutter Door (T200, T600, Studio)
The original Cutter Door flyer is reproduced here for your reference.
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Multi-Sheet Tray SV (T200, T600, Studio)
The original Multi-Sheet Tray Extension CSR flyer is reproduced here for your reference.
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Roll Cover (T200, T600 24in, T600 36in)
The original Roll Cover CSR flyer is reproduced here for your reference.
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Out-Of-Paper Sensor without cable
For more information, please reread.

Out-Of-Paper Sensor without cable 489



490 Appendix H  Flyers



Out-Of-Paper Sensor without cable 491



Accessory
The following flyers provide Accessory information.
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Automatic Sheet Feeder (T200)
The original Automatic Sheet Feeder flyer is reproduced here for your reference.

Automatic Sheet Feeder (T200) 493



Stand Assembly Instructions (T200)
The original Stand Assembly Instructions flyer is reproduced here for your reference.
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Roll Cover (T200)
The original Roll Cover accessory flyer is reproduced here for your reference.
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Cutter replacement instructions
The original Cutter flyer is reproduced here for your reference.
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HP DesignJet Studio Stand Assembly Instructions
The original HP DesignJet Studio Stand Assembly Instructions flyer is reproduced here for your reference.
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Service Part
The following flyer provides service part information.

NVM Backup PCA
The original NVM Backup PCA flyer is reproduced here for your reference.
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